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시작하기 1
Molecule Profiler 소프트웨어를 사용하면 Analyst TF 소프트웨어 및 SCIEX OS를 통해 획득한
데이터에서 잠재적 불순물과 대사물을 비롯한 분자 및 분자 유도체를 검색하고 보고할 수 있
습니다.

Molecule Profiler 소프트웨어는 10kDa 미만의 소분자, 펩타이드, 항체 약물 포합체 및 올리고
뉴클레오타이드의 식별을 지원합니다.

화합물 선택 배치 처리 결과 검토 결과 구체화

화합물 라이브러
리

배치 생성 Results 작업 영역
정보

MS/MS 데이터 특
성화

생체 내 변화 세트
생성

처리 매개 변수 설
정

결과 필터 정보 결과 상관 관계 지
정

처리 매개 변수 설
정

배치 옵션 지정 결과 편집 Correlation 작업
영역에서 보고서

생성

또는

배치 가져오기 Add MS/MS 버튼
으로 여러 스펙트

럼 추가

Results 작업 영역
에서 보고서 생성

잠재적 분자와 유도체를 찾는 방법
소프트웨어에는 관심 샘플에서 잠재적 분자를 찾기 위해 사용하는 일련의 피크 찾기 전략 또
는 알고리즘이 있습니다. 자세한 정보는 피크 찾기 전략 정보 섹션을 참조하십시오.

발견된 피크가 예측 분자인 경우 소프트웨어는 전구체 또는 하나 이상의 변환 조합에서 파생
된 특정 이름을 할당합니다. 워크플로에 따라 변환은 선택한 생체 내 변화 세트, 잠재적 분열
대사물, 잠재적 가수분해 분열 또는 항체의 잠재적 시퀀스 단편을 포함할 수 있습니다.
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소분자 데이터 분석의 경우 변환은 선택한 생체 내 변화 세트와 잠재적 분열 대사물을 포함합
니다.

펩타이드 데이터 분석의 경우 변환은 선택한 생체 내 변화 세트와 잠재적 가수분해 분열을 포
함합니다.

ADC(항체 약물 포합체) 데이터 분석의 경우 변환은 선택한 생체 내 변화 세트, 잠재적 분열 대
사물 및 소화된 항체 단백질의 잠재적 시퀀스 단편을 포함합니다.

올리고뉴클레오타이드 분석의 경우 변환은 대사물과 불순물에 모두 적합한 생체 내 변화 세트
의 선택, 잠재적 분열 대사물, 내부 n–1 및 말단 n+1 시퀀스를 포함합니다.

일반 피크 찾기 전략이 사용되고 피크가 예기치 않은 분자인 경우 일반 Loss of 또는 Gain of
이름과 분자 이온의 전하에서 양성화된 부가물이 할당됩니다.

샘플과 함께 대조군 파일을 선택한 경우 소프트웨어는 샘플과 대조군 데이터를 비교합니다.
샘플과 함께 아날로그 파일도 선택한 경우 소프트웨어는 MS 데이터와 아날로그 데이터를 비
교합니다.

사용자는 각 알고리즘을 제어하는 매개 변수를 변경할 수 있습니다. 자세한 정보는 매개 변수
값 선택 섹션을 참조하십시오.

Molecule Profiler 작업 영역 열기
SCIEX OS 소프트웨어 버전 2.1.5 이상이 설치되어 있고 유효한 Molecule Profiler 소프트웨어
라이선스가 활성화되어 있어야 합니다.

1. Start 메뉴에서 소프트웨어를 선택합니다(Start > SCIEX OS > SCIEX OS).

소프트웨어가 Integrated Mode로 구성된 경우 홈 페이지가 열립니다.

소프트웨어가 Mixed Mode로 구성된 경우 Logon 대화 상자가 열립니다. 다음 단계를 진행
합니다.

2. Logon 대화 상자가 열리면 소프트웨어 사용 권한이 있는 사용자의 사용자 이름과 비밀번
호를 입력한 후 OK를 클릭합니다.
홈 페이지가 열립니다.

3. Molecule Profiler 타일을 클릭합니다.

그림 1-1 Molecule Profiler 타일

Molecular Profiler 작업 영역이 열립니다.

시작하기
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Molecule Profiler 창
그림 1-2 Molecule Profiler 창

항목 설명

1 작업 영역 목록

2 Batch 작업 영역. 이 작업 영역을 사용하여 잠재적 대사물을 검색할 수 있
습니다. 자세한 정보는 Batch 작업 영역 정보 섹션을 참조하십시오.

3 Results 작업 영역. 처리 후 이 작업 영역을 사용하여 잠재적 대사물을 볼
수 있습니다. 자세한 정보는 Results 작업 영역 정보 섹션을 참조하십시
오.

4 Correlation 작업 영역. 이 작업 영역을 사용하여 여러 결과 파일의 대사물
을 비교할 수 있습니다. 자세한 정보는 Correlation 작업 영역 정보 섹션을
참조하십시오.

5 워크플로 목록

6 화합물 라이브러리. 화합물 라이브러리를 생성하고 유지 관리합니다. 자
세한 정보는 화합물 라이브러리 섹션을 참조하십시오.

시작하기
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항목 설명

7 생체 내 변화. 공통된 변환 목록을 생성하고 유지 관리합니다. 자세한 정보
는 생체 내 변화 세트 섹션을 참조하십시오.

8 처리 매개 변수. Batch 작업 영역에서 사용할 수 있는 처리 방법을 생성하
고 유지 관리합니다. 자세한 정보는 처리 방법 생성 섹션을 참조하십시오.

9 메뉴 모음. 자세한 정보는 표 1-1에서 확인하십시오.

표 1-1 메뉴 명령

항목 설명

File 메뉴

New • Batch: 새 배치를 생성합니다. 자세한 정보는 배치 생성 섹션을 참조하
십시오.

• Correlation: 새 상관 관계를 생성합니다. 자세한 정보는 상관 관계 준
비 섹션을 참조하십시오.

Open • Batch: 배치를 엽니다.

• Correlation: 상관 관계 파일을 엽니다.

• Results: 결과 파일을 엽니다.

Save Batch 배치를 Batch 작업 영역에 저장합니다.

Save Batch As 배치를 다른 이름으로 Batch 작업 영역에 저장합니다.

Create Report 보고서를 생성합니다. 자세한 정보는 보고서 섹션을 참조하십시오.

Recent reports 최근 보고서를 엽니다.

Edit 메뉴

Edit Name 화합물의 이름과 수식을 편집합니다.

Copy Selected
Table

선택한 테이블을 복사합니다.

Copy Selected
Graph

선택한 그래프를 복사합니다.

Copy Batch
Row

선택한 배치 행을 복사합니다.

Paste Batch
Row

복사한 배치 행을 선택한 위치에 붙여 넣습니다.

Clear Batch
Row

선택한 배치 행의 내용을 삭제합니다.

Delete Selected
Row

Results Table에서 선택한 행을 삭제합니다. 소프트웨어가 결과를 다시 계
산합니다.

시작하기
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표 1-1 메뉴 명령 (계속)

항목 설명

Undo Delete 마지막으로 삭제한 행을 복원합니다. 소프트웨어가 결과를 다시 계산합니
다.

Hide
Unchecked
Rows

선택되지 않은 행을 숨깁니다.

Show Hidden
Rows

선택되지 않은 행을 표시합니다.

Custom
Elements

Custom Elements 대화 상자를 엽니다. 이 대화 상자를 사용하여 아미노
산 및 올리고뉴클레오타이드 잔기를 정의할 수 있습니다. 자세한 정보는
Custom Elements 섹션을 참조하십시오.

Setup 메뉴

Compound
Library

화합물 라이브러리를 엽니다. 자세한 정보는 화합물 라이브러리 섹션을
참조하십시오.

Biotransformati
ons

생체 내 변화 세트 목록을 엽니다. 자세한 정보는 생체 내 변화 세트 섹션
을 참조하십시오.

Processing
Parameters

처리 방법 창을 엽니다. 자세한 정보는 처리 방법 생성 섹션을 참조하십시
오.

Filters • Results: Results 작업 영역에 대한 필터를 설정합니다. 자세한 정보는
결과 필터 정보 섹션을 참조하십시오.

• Correlation: Correlation 작업 영역에 대한 필터를 설정합니다. 자세한
정보는 상관 관계 필터 정보 섹션을 참조하십시오.

• Interpretation: Interpretation 작업 영역에 대한 필터를 설정합니다.

Create New
Folder

폴더를 생성합니다. 자세한 정보는 폴더 생성 섹션을 참조하십시오.

폴더 생성
폴더는 소프트웨어가 관심 샘플에서 잠재적 분자를 찾는 데 필요한 파일과 결과 파일을 저장
합니다.

사용자 지정 폴더를 생성하여 결과를 구성할 수도 있습니다.

1. Setup > Create New Folder를 클릭합니다.
Create New Folder 대화 상자가 열립니다.

2. Name에 폴더 이름을 입력합니다.
Location 필드에는 Data 디렉토리의 설치 위치가 표시됩니다
(C:\ProgramData\SCIEX\Molecule Profiler\Data). 생성된 모든 폴더가 이 디렉
토리에 저장됩니다.

시작하기

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
11/141



3. OK를 클릭합니다.
폴더가 생성되면 Processing Parameters 폴더와 Results 폴더라는 두 개의 하위 폴
더가 자동으로 생성됩니다.

시작하기

Molecule Profiler 소프트웨어
12/141

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A



Custom Elements 2
Custom Elements 대화 상자에는 다음 탭이 포함되어 있습니다.

• AA List 탭은 표준 아미노산 목록에 대한 정보를 포함합니다. 이 정보는 편집하거나 삭제할
수 없습니다. 사용자는 이 목록에 사용자 지정 아미노산을 추가한 후 필요에 따라 추가된 항
목을 수정하거나 삭제할 수 있습니다. 추가된 아미노산은 목록 하단에 자동으로 추가됩니
다. 그러나 열 머리글 중 하나를 클릭하여 목록을 정렬할 수 있습니다.

• AA Modifications 탭은 아미노산 잔기의 펩타이드 말단기와 측기에 적용할 수 있는 다양한
변형에 대한 질량 변화 정보를 포함합니다. 이 정보는 편집하거나 삭제할 수 없습니다. 사용
자는 이 목록에 사용자 지정 아미노산 변형을 추가한 후 필요에 따라 추가된 항목을 수정하
거나 삭제할 수 있습니다. 추가된 아미노산 변형은 목록 하단에 자동으로 추가됩니다. 그러
나 열 머리글 중 하나를 클릭하여 목록을 정렬할 수 있습니다.

• Oligo List 탭은 미리 정의된 올리고뉴클레오타이드 잔기 및 말단기를 포함합니다. 이 정보
는 편집하거나 삭제할 수 없습니다. 사용자는 이 목록에 새 올리고뉴클레오타이드 잔기 및
말단기를 추가한 후 필요에 따라 추가된 항목을 수정하거나 삭제할 수 있습니다. 추가된 잔
기는 목록 하단에 자동으로 추가됩니다. 그러나 열 머리글 중 하나를 클릭하여 목록을 정렬
할 수 있습니다.

사용자 지정 아미노산
사용자 지정 아미노산 생성
1. Edit > Custom Elements를 클릭합니다.

Custom Elements 대화 상자가 열립니다.

2. AA List 탭이 선택되었는지 확인합니다.

3. New를 클릭합니다.
New Custom Amino Acid Residue 대화 상자가 열립니다.

4. 다음 표에 설명된 필드를 완성한 후 OK를 클릭합니다.

표 2-1 New Custom Amino Acid Residue 대화 상자 필드

필드 설명 허용되는 값

Name 아미노산 이름 영숫자

Symbol 아미노산 기호 • 영숫자

• 대문자로 시작해야 함

Residue
Formula

아미노산 수식 주기 원소를 사용한 실험식. 농축 동
위 원소를 수식의 일부로 사용할 수
도 있습니다. 13C를 예로 들 수 있
으며, 여기서 13C는 13-탄소 동위
원소를 나타냅니다.

Custom Elements
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사용자 지정 아미노산은 아미노산 테이블 하단에 추가되며 이름, 기호 및 질량을 표시합
니다.

사용자 지정 아미노산 편집
1. Edit > Custom Elements를 클릭합니다.

Custom Elements 대화 상자가 열립니다.

2. AA List 탭이 선택되었는지 확인합니다.

3. 편집할 아미노산을 선택합니다.

참고: 사용자가 추가한 사용자 지정 아미노산만 편집할 수 있습니다. 소프트웨어와 함께
배포된 아미노산은 편집할 수 없습니다.

4. Edit를 클릭합니다.
Edit Custom Amino Acid Residue 대화 상자가 열립니다.

5. 다음 표에 설명된 필드를 편집합니다.

표 2-2 Edit Custom Amino Acid Residue 대화 상자 필드

필드 설명 허용되는 값

Name 아미노산 이름 영숫자

Symbol 아미노산 기호 • 영숫자

• 대문자로 시작해야 함

Residue
Formula

아미노산 수식 주기 원소를 사용한 실험식

6. OK를 클릭합니다.
선택한 사용자 지정 아미노산의 이름, 기호 및 질량이 아미노산 테이블에서 업데이트됩니
다(해당하는 경우).

사용자 지정 아미노산 삭제
참고: 처리 방법이나 결과에 사용되는 사용자 지정 아미노산을 삭제하면 예기치 않은 동작이
발생할 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. AA List 탭이 선택되었는지 확인합니다.

3. 삭제할 아미노산을 선택합니다.

참고: 사용자가 추가한 사용자 지정 아미노산만 삭제할 수 있습니다. 소프트웨어와 함께
배포된 아미노산은 삭제할 수 없습니다.

4. Delete를 클릭합니다.
사용자 지정 아미노산이 아미노산 테이블에서 제거됩니다.

Custom Elements
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사용자 지정 아미노산 변형
사용자 지정 아미노산 변형 생성
참고: 사용자 지정 아미노산 변형은 표준 아미노산에만 적용할 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. AA Modifications 탭이 선택되었는지 확인합니다.

3. New를 클릭합니다.
New Custom Modification 대화 상자가 열립니다.

4. 다음 표에 설명된 필드를 완성한 후 OK를 클릭합니다.

표 2-3 New Custom Modification 대화 상자 필드

필드 설명 허용되는 값

Name 잔기의 이름 영숫자

Symbol 잔기의 기호 • _로 시작해야 함

• 영숫자

• 대문자로 시작해야 함

Formula Gain 잔기에 의해 획득한 화학식 주기 원소를 사용한 실험식

Formula Lost 잔기에 의해 손실된 화학식 주기 원소를 사용한 실험식

Mod Type 변형 위치 Amino Acid, N-Terminus, C-
Terminus, Protein N-Terminus 및
Protein C-Terminus

Applies to AA 관련 아미노산의 이름 사용자 지정 변형을 적용할 표준 아
미노산의 단일 문자 표현입니다(예:
프롤린의 경우 P). 사용자 지정 변형
을 모든 표준 아미노산에 적용하려
면 이 필드를 비워 두십시오.

사용자 지정 아미노산 변형은 아미노산 변형 테이블 하단에 추가되며 기호, 질량 변화 및
이름을 표시합니다.

사용자 지정 아미노산 변형 편집
1. Edit > Custom Elements를 클릭합니다.

Custom Elements 대화 상자가 열립니다.

2. AA Modifications 탭이 선택되었는지 확인합니다.

3. 편집할 변형을 선택합니다.

Custom Elements
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참고: 사용자가 추가한 변형만 편집할 수 있습니다. 소프트웨어와 함께 배포된 변형은 편
집할 수 없습니다.

4. Edit를 클릭합니다.
Edit Custom Modification 대화 상자가 열립니다.

5. 다음 표에 설명된 해당 필드를 편집합니다.

표 2-4 Edit Custom Modification 대화 상자 필드

필드 설명 허용되는 값

Name 잔기의 이름 영숫자

Symbol 잔기의 기호 • _로 시작해야 함

• 영숫자

• 대문자로 시작해야 함

Formula Gain 잔기에 의해 획득한 화학식 주기 원소를 사용한 실험식

Formula Lost 잔기에 의해 손실된 화학식 주기 원소를 사용한 실험식

Mod Type 변형 위치 Amino Acid, N-Terminus, C-
Terminus, Protein N-Terminus 및
Protein C-Terminus

Applies to AA 관련 아미노산의 이름 사용자 지정 변형을 적용할 표준 아
미노산의 단일 문자 표현입니다(예:
프롤린의 경우 P). 사용자 지정 변형
을 모든 표준 아미노산에 적용하려
면 이 필드를 비워 두십시오.

6. OK를 클릭합니다.
선택한 사용자 지정 변형의 이름, 기호 및 질량 변화가 변형 테이블에서 업데이트됩니다
(해당하는 경우).

사용자 지정 아미노산 변형 삭제
참고: 처리 방법이나 결과에 사용되는 사용자 지정 아미노산 변형을 삭제하면 예기치 않은 동
작이 발생할 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. AA Modifications 탭이 선택되었는지 확인합니다.

3. 삭제할 변형을 선택합니다.

참고: 사용자가 추가한 사용자 지정 변형만 삭제할 수 있습니다. 소프트웨어와 함께 배포
된 변형은 삭제할 수 없습니다.

4. Delete를 클릭합니다.
사용자 지정 변형이 변형 테이블에서 제거됩니다.

Custom Elements
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사용자 지정 올리고뉴클레오타이드 잔기 또는 말단
기
사용자 지정 원소를 사용하여 올리고뉴클레오타이드의 코어 구조에 추가할 수 있는 사용자 지
정 기능 그룹이 포함된 시퀀스를 생성할 수 있습니다. 이러한 변형을 시퀀스에 입력한 후
Molecule Profiler 소프트웨어로 검색하고 식별할 수 있습니다.

올리고뉴클레오타이드는 여러 하위 구조로 나눌 수 있습니다.

그림 2-1 올리고뉴클레오타이드 하위 구조

사용자는 올리고뉴클레오타이드의 코어 하위 구조를 변경하거나 새 코어, 말단 및 인산염 백
본을 정의할 수 있습니다. 수정된 사용자 지정 시퀀스를 생성할 때 다음과 같은 일반화된 구조
를 사용하십시오.

5'-(Terminus Moiety)-(Terminus Linker)-(Terminus Phosphate Core)-(Residue Type)1-…-
(Residue Type)n-(Terminus Phosphate Core)-(Terminus Linker)-(Terminus Moiety)-3'

New Oligo Residue or Terminus 대화 상자의 Type 필드에는 미리 정의된 여러 유형의 잔기 또
는 말단이 포함되어 있습니다. 이러한 미리 정의된 유형은 올리고뉴클레오타이드의 특정 하위
구조에 대한 편집을 제한하여 해당 유형과 관련된 변형 생성을 단순화합니다. 각 유형이 위에
요약된 일반 구조에 어떻게 적합한지 이해하려면 다음 표를 참조하십시오.

표 2-5 유형

유형 범주 편집 가능한 하위 구조

DNA 잔기 유형 염기

DNA* 잔기 유형 염기

RNA 잔기 유형 염기

RNA* 잔기 유형 염기

Custom Elements
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표 2-5 유형 (계속)

유형 범주 편집 가능한 하위 구조

2'-O-Methyl RNA 잔기 유형 염기

2'-O-Methyl RNA* 잔기 유형 염기

Locked(LNA) 잔기 유형 염기

Locked(LNA)* 잔기 유형 염기

Other Residue 잔기 유형 염기

5' 링커

당분 코어

3' 링커

인산염 코어

Phospho Terminus* 말단 성분 말단 성분

Phospho Terminus 말단 성분 말단 성분

Other Terminus 말단 성분

말단 링커

말단 인산염 코어

말단 성분

말단 링커

인산염 코어

* 포스포로티오에이트 백본

화학식을 추가하고 편집할 때 가장 유연한 유형은 "Other Residue"입니다. 이 유형은 서로 다
른 여러 사용자 지정 하위 구조에 맞게 변경할 수 있으므로 사용자가 세밀하게 사용자 지정된
올리고뉴클레오타이드를 정의할 수 있습니다. 마찬가지로 Other Terminus 유형을 사용하면
사용자 지정 5' 또는 3' 말단, 링커 및 코어를 정의할 수 있습니다.

예를 보려면 사용자 지정 올리고뉴클레오타이드의 예 섹션을 참조하십시오.

사용자 지정 올리고뉴클레오타이드 잔기 또는 말단기 생성
팁! 기존 항목을 복사하여 올리고뉴클레오타이드 잔기 또는 말단기를 생성하려면 Oligo List
탭에서 기존 항목을 선택한 후 New From을 클릭합니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. Oligo List 탭이 선택되었는지 확인합니다.
목록에는 미리 정의된 모든 올리고뉴클레오타이드 잔기 및 말단기가 포함되어 있습니다.

3. New를 클릭합니다.
New Oligo Residue or Terminus 대화 상자가 열립니다.

Custom Elements
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4. 대화 상자의 필드를 완성합니다. 예를 보려면 사용자 지정 올리고뉴클레오타이드의 예 섹
션을 참조하십시오.

5. OK를 클릭합니다.
사용자 지정 잔기 또는 말단기가 테이블 하단에 추가됩니다.

사용자 지정 올리고뉴클레오타이드 잔기 또는 말단기 편집
1. Edit > Custom Elements를 클릭합니다.

Custom Elements 대화 상자가 열립니다.

2. Oligo List 탭이 선택되었는지 확인합니다.

3. 편집할 잔기 또는 말단기를 선택합니다.

참고: 사용자가 추가한 잔기 및 말단기만 편집할 수 있습니다. 소프트웨어와 함께 배포된
잔기 및 말단기는 편집할 수 없습니다.

4. Edit를 클릭합니다.
Edit Custom Amino Acid Residue 대화 상자가 열립니다.

5. 잔기 또는 말단기의 속성을 편집합니다.

6. OK를 클릭합니다.

사용자 지정 올리고뉴클레오타이드 잔기 또는 말단기 삭제
참고: 처리 방법이나 결과에 사용되는 사용자 지정 올리고뉴클레오타이드 잔기 또는 말단기를
삭제하면 예기치 않은 동작이 발생할 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. Oligo List 탭이 선택되었는지 확인합니다.

3. 삭제할 잔기 또는 말단기를 선택합니다.

참고: 사용자가 추가한 잔기 및 말단기만 삭제할 수 있습니다. 소프트웨어와 함께 배포된
잔기 및 말단기는 삭제할 수 없습니다.

4. Delete를 클릭합니다.
사용자 지정 잔기 또는 말단기가 테이블에서 제거됩니다.

올리고뉴클레오타이드 잔기 및 말단기 가져오기
올리고뉴클레오타이드 잔기 및 말단기를 텍스트 파일에서 가져올 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. Oligo List 탭이 선택되었는지 확인합니다.
목록에는 미리 정의된 모든 올리고뉴클레오타이드 잔기 및 말단기가 포함되어 있습니다.

3. Import를 클릭합니다.
Import Text File 대화 상자가 열립니다.

Custom Elements
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4. 텍스트 파일을 찾아 선택한 후 Open을 클릭합니다.

올리고뉴클레오타이드 잔기 및 말단기 내보내기
올리고뉴클레오타이드 잔기 및 말단기를 텍스트 파일로 내보낼 수 있습니다.

1. Edit > Custom Elements를 클릭합니다.
Custom Elements 대화 상자가 열립니다.

2. Oligo List 탭이 선택되었는지 확인합니다.
목록에는 미리 정의된 모든 올리고뉴클레오타이드 잔기 및 말단기가 포함되어 있습니다.

3. 내보낼 올리고뉴클레오타이드 잔기 및 말단기를 선택합니다.

팁! 목록의 모든 잔기와 말단기를 선택하려면 Ctrl+A를 누릅니다.

4. Export를 클릭합니다.
Save As 대화 상자가 열립니다.

5. 내보낸 올리고뉴클레오타이드 잔기 및 말단기를 저장할 텍스트 파일의 이름을 입력합니
다.

Custom Elements

Molecule Profiler 소프트웨어
20/141

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A



화합물 라이브러리 3
화합물 라이브러리에는 화학식, 구조 또는 시퀀스, 동위 원소 패턴, 화합물의 MS/MS 스펙트럼
등의 정보가 저장됩니다. 사용자는 각 화합물에 대한 기준 스펙트럼을 지정할 수도 있습니다.
라이브러리의 각 항목은 처리 매개 변수를 생성하는 데 사용할 수 있습니다.

소프트웨어는 기본 화합물 라이브러리와 함께 설치되지만 사용자가 항목을 추가, 편집 및 삭
제하여 라이브러리를 사용자 지정할 수 있습니다.

참고: 각 항목에는 화학식과 하나 이상의 MS/MS 스펙트럼이 있어야 합니다.

화합물 라이브러리 옵션

구조 추가 펩타이드 시퀀스 추가 올리고뉴클레오타이드 시퀀
스 추가

구조 및 시퀀스의 사용 방법
화학 구조와 펩타이드 및 올리고뉴클레오타이드 시퀀스는 잠재적 분열 대사물과 같은 화합물
특정 매개 변수 값을 생성하기 위해 소프트웨어에서 사용됩니다.

참고: 소프트웨어는 구조 또는 시퀀스에서 화학식을 자동으로 생성합니다.

이 소프트웨어는 Markush 또는 다중 구조를 가진 파일을 포함하여 v2000 및 v3000 mol 파일
을 모두 허용합니다.

구조 추가
wiff 및 txt 파일을 사용하여 화합물 라이브러리의 개별 항목에 기준 스펙트럼을 추가할 수 있습
니다.

1. Workflow 패널에서 Compound Library를 클릭합니다.
Compound Library 대화 상자가 열립니다.

2. 다음 중 하나를 수행합니다.

• 새 화합물을 생성합니다.

a. New를 클릭한 후 옵션 목록에서 Structure를 선택합니다.

New Entry 대화 상자가 열립니다.

b. Name에 화합물 이름을 입력한 후 OK를 클릭합니다.

입력한 이름이 Compound Library 대화 상자의 Compound name 필드에 자동으
로 채워집니다.

• Compound name 필드에 제공된 목록에서 화합물을 선택합니다.

화합물 라이브러리
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Compound Library 대화 상자가 선택한 화합물에 해당하는 정보로 업데이트됩니다.

3. Open Structure를 클릭합니다.
Open Structure File 대화 상자가 열립니다.

4. 유효한 mol 파일을 찾아 선택합니다.

5. Open을 클릭합니다.

Compound Library 대화 상자의 다음 필드가 채워집니다.

• Structure

• Chemical formula

• Polarity

• Isotope Pattern

기본적으로 Adduct 필드에는 단일 전하 양성화된 부가물 [M+H]+ 또는 [M-H]–가 채워집
니다. 또한 적절한 정보로 m/z 필드가 업데이트됩니다.

6. 획득의 Polarity를 선택합니다.
선택한 극성에 따라 Compound Details 탭의 Isotope Pattern과 m/z 및 Adduct 값이 업
데이트됩니다.

7. 다음 필드에 적절한 정보를 입력합니다.

• Compound class

• CAS number

• Comments(예: 대사물 등급 정보를 이 필드에 추가할 수 있음)

8. Experimental Data 탭을 엽니다.

9. 다음 중 하나를 수행합니다.

• wiff 파일에서 기준 MS/MS 스펙트럼을 추가하려면 wiff 파일에서 기준 MS/MS 스펙트
럼 추가 섹션을 진행합니다.

• txt 파일에서 기준 MS/MS 스펙트럼을 추가하려면 txt 파일에서 기준 MS/MS 스펙트럼
추가 섹션을 진행합니다.

펩타이드 시퀀스 추가
wiff 및 txt 파일을 사용하여 화합물 라이브러리의 개별 항목에 기준 스펙트럼을 추가할 수 있습
니다.

1. Workflow 패널에서 Compound Library를 클릭합니다.
Compound Library 대화 상자가 열립니다.

2. New를 클릭한 후 옵션 목록에서 Sequence를 선택합니다.
New Entry 대화 상자가 열립니다.

3. Name에 화합물 이름을 입력한 후 OK를 클릭합니다.
입력한 이름이 Compound Library 대화 상자의 Compound name 필드에 자동으로 채워
집니다.

화합물 라이브러리
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4. Sequence 필드에 적절한 펩타이드 시퀀스를 입력합니다.

참고: 시퀀스에 사용자 지정 원소가 포함될 수 있습니다. 자세한 정보는 Custom Elements
섹션을 참조하십시오.

5. Chemical formula 필드를 클릭합니다.

Compound Library 대화 상자의 다음 필드가 채워집니다.

• Chemical formula

• Polarity

• Isotope Pattern

기본적으로 Adduct 필드에는 이중 전하 양성화된 부가물 [M+2H]2+ 또는 [M-2H]2–가 채
워집니다. 또한 적절한 정보로 m/z 필드가 업데이트됩니다.

6. 획득의 Polarity를 선택합니다.
선택한 극성에 따라 Compound Details 탭의 Isotope Pattern과 m/z 및 Adduct 값이 업
데이트됩니다.

7. Experimental Data 탭을 클릭합니다.

8. 다음 중 하나를 수행합니다.

• wiff 파일에서 기준 MS/MS 스펙트럼을 추가하려면 wiff 파일에서 기준 MS/MS 스펙트
럼 추가 섹션을 진행합니다.

• txt 파일에서 기준 MS/MS 스펙트럼을 추가하려면 txt 파일에서 기준 MS/MS 스펙트럼
추가 섹션을 진행합니다.

펩타이드 시퀀스 명명 규칙
표 3-1 펩타이드 시퀀스

특성 입력 규칙 예

다중 체인 / LIGHTCHAIN /

HEAVYCHAIN

아미노산 변형: 측기 [기호] M[Oxi]

아미노산 변형: C-말단 -[기호] Y-[Ami]

아미노산 변형: N-말단 [기호]- [1Me]-Y

연쇄 • 결합된 각 잔기에 [*#]

• 연결된 각 잔기의 번호

S-S 브리지:

MYC[*1]PEPC[*1]TIDE
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표 3-2 연쇄

연쇄 유형 규칙 예

S-S 브리지 브리지의 두 잔기에 [*#] 추가 단일 체인:

MYC[*1]PEPC[*1]TIDE

다중 체인:

LIGHTC[*1]HAIN /

MC[*2]HEAVYC[*1]HAINC[*2
]AD

에스테르/아마이드 브리지 결합 잔기 중 하나에 '[O-1]' 추
가

MYR[*1]PEPD[*1][O-1]TIDE

순환 C-말단에 '[H]' 추가 M[*1]YCPEPCTIDE[*1]-[H]

루프: 첫 번째 또는 마지막 인
덱스의 연결된 잔기와 말단기
는 브리지 결합의 일부가 아님

말단기를 명시적으로 추가 [H]-C[*1]YCPEPCTIDC[*1]-
[OH]

올리고뉴클레오타이드 시퀀스 추가
선택적으로 올리고뉴클레오타이드 화합물 정보를 화합물 라이브러리에 추가할 수 있습니다.
라이브러리의 화합물에는 처리 중에 사용할 MS/MS 스펙트럼이 있습니다.

참고: 화합물이 라이브러리에 없으면 사용자가 수동으로 처리 방법에 추가할 수 있습니다.

시퀀스는 텍스트 형식으로 추가됩니다. 치료용 올리고뉴클레오타이드 변형과 사용자 지정 원
소의 다양한 세트를 캡처하려면 시퀀스 입력 규칙을 준수해야 합니다. 자세한 정보는 올리고
뉴클레오타이드 시퀀스 명명 규칙 섹션을 참조하십시오. 변형 및 사용자 지정 원소에 대한 세
부 목록은 Custom Elements 섹션을 참조하십시오.

1. Workflow 패널에서 Compound Library를 클릭합니다.

2. New > Oligonucleoide Sequence를 클릭합니다.
New Entry 대화 상자가 열립니다.

3. Name에 올리고뉴클레오타이드 시퀀스 이름을 입력한 후 OK를 클릭합니다.

4. Sequence 테이블에 시퀀스를 입력합니다.

참고: 시퀀스에 사용자 지정 원소가 포함될 수 있습니다. 자세한 정보는 Custom Elements
섹션을 참조하십시오.

5. Chemical formula 필드를 클릭하여 화학식을 자동으로 업데이트합니다.

6. (선택 사항) Compound Details 탭의 필드에 정보를 입력합니다.

7. Experimental Data 탭을 클릭합니다.

8. 다음 중 하나를 수행합니다.
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• wiff 파일에서 기준 MS/MS 스펙트럼을 추가하려면 wiff 파일에서 기준 MS/MS 스펙트
럼 추가 섹션을 진행합니다.

• txt 파일에서 기준 MS/MS 스펙트럼을 추가하려면 txt 파일에서 기준 MS/MS 스펙트럼
추가 섹션을 진행합니다.

올리고뉴클레오타이드 시퀀스 명명 규칙
다음과 같이 염기에 대한 고유 단일 문자 식별자를 사용하여 올리고뉴클레오타이드 시퀀스를
지정할 수 있습니다.

• 아데닌(A)

• 사이토신(C)

• 티민(T)

• 구아닌(G)

• 우라실(U)

디옥시리보핵산(DNA, d), 리보핵산(RNA, r)과 같은 올리고뉴클레오타이드 유형은 시퀀스 시
작 부분에 추가된 단일 문자 식별자로 확인할 수 있으며, 혼합 올리고뉴클레오타이드 유형의
경우 염기 사이에 배치될 수 있습니다.

LNA(잠금 핵산)와 같은 합성 뉴클레오타이드가 포함된 올리고뉴클레오타이드의 경우 시퀀스
를 정의할 때 각 잔기에 대해 전체 기호를 사용합니다. 예를 들어 LNA-A의 경우 lA, 2'-
Mehtoxymethyl-A의 경우 moA입니다.

포스포로티오에이트(HPSO, *)와 같은 백본 변형은 각 염기의 끝에 추가됩니다.

탄소-13(/13Cn/)과 같은 중원자는 특정 올리고뉴클레오타이드 잔기 뒤에 추가되며, 여기서 n
은 중원자의 수를 나타냅니다.

참고: 앞의 예에서 "/13Cn/" 표기는 기존 수식에 중원자를 추가합니다. 핵염기의 원자를 중표
지로 대체하지 않습니다. 동위 원소로 표지된 핵염기를 정의하려면 사용자 지정 변형이 필요
합니다.

사용자 정의된 사용자 지정 변형을 식별하려면 슬래시(/)를 첫 번째 및 마지막 문자로 사용합
니다. 사용자 지정 변형을 추가하고 변형 및 관련 명명 규칙에 대한 추가 사용 예를 보려면
Custom Elements 섹션을 참조하십시오.

표 3-3 올리고뉴클레오타이드 규칙

특성 입력 규칙 예

DNA d dACG T

RNA r rACG U

혼합 DNA 및 LNA d, l dACG lT

포스포로티오에이트 백본 * dA*C*G* T*

2'Methoxymethyl (2'MOE) 당
분 변형

mo moAmoCmoG moT
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표 3-3 올리고뉴클레오타이드 규칙 (계속)

특성 입력 규칙 예

탄소-13 /13Cn/ dACG T/13C2/

사용자 지정 잔기 // dACG /Other Residue/

wiff 파일에서 기준 MS/MS 스펙트럼 추가
1. Open wiff File을 클릭합니다.

Select Data 대화 상자가 열립니다.

2. 적절한 위치를 찾아 추가할 화합물에 대한 스펙트럼이 포함된 wiff 파일을 선택한 후 OK
를 클릭합니다.

참고: wiff 파일에는 화합물이 전구체 이온으로 포함되어야 합니다.

표 3-4 기준 스펙트럼 추가

여러 전구체가 포함된 파일 단일 전구체가 포함된 파일

선택한 wiff 파일에 여러 개의 전구체가 있는
경우 사용 가능한 각 전구체에 대한 다음 정
보가 Precursors 테이블에 표시된 Select a
Spectrum 대화 상자가 열립니다.

• m/z

• 시간(분)

• 품질

• 전하

wiff 파일에 전구체가 하나만 포함된 경우
MS/MS Spectrum 창이 스펙트럼으로 업데이
트됩니다.

적용할 필터의 확인란을 선택합니다.

필터 옵션을 하나 또는 둘 다(해당하는 경우)
선택합니다. 지정된 기준을 충족하는 행만 표
시하도록 Precursors 테이블이 업데이트됩
니다.

소프트웨어는 선택된 전구체의 m/z와
Charge 및 실험의 충돌 에너지를 사용하여
Compound Library 대화 상자의 Spectra 필
드에 고유한 정보를 생성합니다. 예를 들어
Prec(m/z), CE(실험의 충돌 에너지),
Charge(전하)가 필드에 표시됩니다.

스펙트럼 제목에는 Compound Information
그룹의 Polarity 및 Compound name과
Spectra 필드의 정보가 차례대로 포함됩니
다.

Spectrum Details에는 선택한 MS/MS 스펙
트럼에 해당하는 기기 유형, 머무름 시간, 전
하 및 충돌 에너지가 포함됩니다. 이 정보는
읽기 전용입니다.
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표 3-4 기준 스펙트럼 추가 (계속)

여러 전구체가 포함된 파일 단일 전구체가 포함된 파일

Precursors 테이블에서 행을 선택합니다.

MS/MS Spectrum 창이 선택한 전구체의 스
펙트럼으로 업데이트됩니다.

팁! 여러 행을 선택하려면 Ctrl+클릭을 사용
합니다. 여러 행을 선택한 경우 첫 번째 선택
된 전구체의 MS/MS Spectrum이 표시됩니
다.

—

Charge state from 확인란을 선택한 경우 제
공된 옵션에서 from 및 to 값을 선택합니다.
from 값은 Precursors 테이블에서 최소 사용
가능 전하 상태와 동일합니다. to 값은
Precursors 테이블에 표시된 최대 사용 가능
전하 상태와 동일합니다.

—

Quality above 확인란을 선택한 경우 제공된
필드에 적절한 값을 입력합니다.

—

OK를 클릭합니다. —

Precursors 테이블에서 선택한 각 행에 대해
소프트웨어는 선택된 전구체의 m/z와
Charge 및 실험의 충돌 에너지를 사용하여
Compound Library 대화 상자의 Spectra 필
드에 고유한 정보를 생성합니다. 예를 들어
Prec(m/z), CE(실험의 충돌 에너지),
Charge(전하)가 필드에 표시됩니다.

Spectra 필드에 표시되는 정보와 MS/MS
Spectrum 필드에 표시되는 스펙트럼은
Precursors 테이블에서 선택한 첫 번째 행에
해당합니다.

스펙트럼 제목에는 Compound Information
그룹의 Polarity 및 Compound name과
Spectra 필드의 정보가 차례대로 포함됩니
다.

Spectrum Details에는 선택한 MS/MS 스펙
트럼에 해당하는 기기 유형, 머무름 시간, 전
하 및 충돌 에너지가 포함됩니다. 이 정보는
읽기 전용입니다.

—

3. (선택 사항) 제공된 목록에서 다른 Spectra를 선택합니다.
MS/MS Spectrum 및 Spectrum Details가 업데이트되어 선택과 관련된 정보가 표시됩니
다.
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4. 스펙트럼을 화합물에 대해 미리 정의된 스펙트럼으로 저장하려면 제공된 목록에서 적절
한 Spectra를 선택한 후 Set as Reference를 클릭합니다.
Spectra 필드에 표시되는 정보에 - Reference가 추가됩니다. 예를 들어 Prec(xx.xx),
CE(xx), Charge(xx) - Reference가 필드에 표시됩니다.

5. Save를 클릭합니다.

6. OK를 클릭합니다.
새 화합물이 라이브러리에 저장되고 Compound Library 대화 상자가 닫힙니다.

txt 파일에서 기준 MS/MS 스펙트럼 추가
1. Open txt File을 클릭합니다.

Open txt File 대화 상자가 열립니다.

2. 적절한 위치를 찾아 MS/MS txt 파일을 선택한 후 OK를 클릭합니다.
Spectrum Details 대화 상자가 열립니다.

3. 선택한 스펙트럼에 대해 적절한 정보를 입력한 후 OK를 클릭합니다.

소프트웨어는 Precursor mass (m/z), Collision energy 및 Charge 필드의 정보를 사용
하여 Compound Library 대화 상자의 Spectra 필드 정보를 생성합니다. 예를 들어
Prec(전구체 질량(m/z)), CE(충돌 에너지), Charge(전하)가 필드에 표시됩니다.

Spectra 필드에 표시되는 정보와 MS/MS Spectrum 필드에 표시되는 스펙트럼은 선택한
txt 파일에 해당합니다.

스펙트럼 제목에는 Compound Information 그룹의 Polarity 및 Compound name과
Spectra 필드의 정보가 차례대로 포함됩니다.

Spectrum Details에는 선택한 MS/MS 스펙트럼에 해당하는 기기 유형, 머무름 시간, 전
하 및 충돌 에너지가 포함됩니다. 이 정보는 읽기 전용입니다.

4. (선택 사항) 제공된 목록에서 다른 Spectra를 선택합니다.
MS/MS Spectrum 및 Spectrum Details가 업데이트되어 선택과 관련된 정보가 표시됩니
다.

5. 스펙트럼을 화합물에 대해 미리 정의된 스펙트럼으로 저장하려면 제공된 목록에서 적절
한 Spectra를 선택한 후 Set as Reference를 클릭합니다.
Spectra 필드에 표시되는 정보에 - Reference가 추가됩니다. 예를 들어 Prec(xx.xx),
CE(xx), Charge(xx) - Reference가 필드에 표시됩니다.

6. Save를 클릭합니다.

7. OK를 클릭합니다.
새 화합물이 라이브러리에 저장되고 Compound Library 대화 상자가 닫힙니다.

Results Table에서 화합물 라이브러리에 정보 추가
참고: 이 기능은 소분자 및 펩타이드 결과 파일에만 사용할 수 있습니다. ADC 및 올리고뉴클
레오타이드 결과 파일에는 이 기능을 사용할 수 없습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.
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2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 행을 선택하고 마우스 오른쪽 버튼을 클릭한 후 Add to
Compound Library를 선택합니다.

참고: 선택한 행에 MS/MS 스펙트럼이 없으면 Add to Compound Library 옵션을 사용할
수 없습니다.

6. OK를 클릭하여 확인 메시지에 응답합니다.

7. Workflow 패널에서 Compound Library를 클릭합니다.
Compound Library 대화 상자가 열립니다. 추가된 대사물이 Compound name 목록에 추
가됩니다.
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생체 내 변화 세트 4
생체 내 변화 세트는 공통된 변환 목록입니다.

생체 내 변화 정보
사용자는 소프트웨어와 함께 설치되는 미리 정의된 생체 내 변화 세트를 사용하여 예측 대사
물을 검색하거나 생체 내 변화 세트를 새로 생성할 수 있습니다. 예를 들어 사용자는 분석 중인
각 화합물에 대해 서로 다른 세트를 생성할 수 있습니다. 설치된 생체 내 변화 세트에는 구조
제안 또는 자동 시퀀스 중에 사용되는 기본 제공 정보가 포함되어 있습니다.

방법별 생체 내 변화 세트는 각 방법 유형의 기본값으로 사용됩니다. 예를 들어 펩타이드 방법
은 생물학적 생체 내 변화 세트를 기본값으로 사용합니다. 이 생체 내 변화 세트에는 펩타이드
에 대한 생체 내 대사 반응과 가장 관련 있는 생체 내 변화가 포함되어 있습니다.

올리고뉴클레오타이드의 경우 미리 정의된 다음 세 가지 변환 세트 중 하나를 선택합니다.

• Oligonucleotide Basic: 염기 또는 백본에만 영향을 주는 변형으로 제한된 간략한 목록을
제공합니다.

• Oligonucleotide Comprehensive: 합성, 대사 및 저장 중에 발생할 수 있는 모든 변환이 포
함된 광범위한 정보를 제공합니다.

• Oligonucleotide Metabolites: 포괄적인 세트에서 변환에만 초점을 맞춘 부분을 포함합니
다.

샘플 출처를 신중하게 고려하여 가장 대표적인 세트를 선택합니다. 사용자는 기본 항목을 사
용하거나 새 항목을 추가하여 사용자 지정 생체 내 변화 세트를 만들 수 있습니다. 자세한 정보
는 생체 내 변화 세트 생성 및 생체 내 변화 세트 편집 섹션을 참조하십시오.

화학식에서 변화를 식별하거나 두 가지 기존 생체 내 변화를 결합하여 사용자 지정 생체 내 변
화를 생성합니다.

사용자 지정 생체 내 변화 또는 기존 세트의 생체 내 변화는 새로 생성되는 생체 내 변화 세트
에 포함될 수 있습니다.

팁! 생물학적 데이터를 평가하는 경우 데이터를 더 빨리 분석할 수 있도록 작은 세트를 생성할
가능성이 높은 생체 내 변화를 선택하십시오.

생체 내 변화 세트 생성
1. Workflow 패널에서 Biotransformations를 클릭합니다.

Biotransformations 대화 상자가 열립니다.

2. New를 클릭합니다.
New Biotransformation Set 대화 상자가 열립니다.

3. Working biotransformation set 필드에 세트의 이름을 입력합니다.

4. New Biotransformation을 클릭합니다.
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Molecule Profiler 소프트웨어
30/141

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A



New Biotransformation 대화 상자가 열립니다.

5. Name 필드에 생체 내 변화의 이름을 입력합니다.

6. (선택 사항) Description 및 Comments 필드에 생체 내 변화와 관련된 적절한 세부 정보
를 입력합니다.

7. 다음 중 하나를 수행합니다.

표 4-1 생체 내 변화 세트 생성

단일 생체 내 변화를 생성하려면 결합된 생체 내 변화를 생성하려면

Single biotransformation을 클릭합니다. Combined biotransformation을 클릭합니
다.

Formula from 필드에서 구조가 손실되는 부
분을 식별합니다.

Biotransformation 1 및 Biotransformation
2 필드에서 각각 생체 내 변화를 선택합니다.

Formula to 필드에 생체 내 변화의 수식을
입력합니다.

—

참고: 사용 가능한 생체 내 변화는 작업 세트에 있습니다.

참고: 소프트웨어는 생체 내 변화로 인한 결과를 자동으로 계산하고 이 값을 Mass shift
필드에 채웁니다.

8. OK를 클릭합니다.
새 생체 내 변화가 작업 중인 생체 내 변화 세트 및 소스 생체 내 변화 세트 테이블에 모두
표시됩니다.

9. OK를 클릭하여 새 생체 내 변화 세트를 저장합니다.
New Biotransformation Set 대화 상자가 닫힙니다.

10. OK를 클릭합니다.
Biotransformations 대화 상자가 닫힙니다.

생체 내 변화 세트 편집
1. Workflow 패널에서 Biotransformations를 클릭합니다.

Biotransformations 대화 상자가 열립니다.

2. 제공된 목록에서 적절한 Set를 선택합니다.

3. Edit를 클릭합니다.
Edit Biotransformation Set 대화 상자가 열리고 Working biotransformation set 필드에
서 선택한 세트의 이름이 표시됩니다.

4. Working biotransformation set 필드에 적절한 세트의 이름을 입력합니다.

5. 작업 중인 생체 내 변화 세트 테이블에서 행을 선택합니다.

6. Edit Biotransformation을 클릭합니다.
Edit Biotransformation 대화 상자가 열립니다.

7. (선택 사항) Name, Description 및 Comments 필드에서 필요한 내용을 변경합니다.
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8. (선택 사항) 다음 중 하나를 수행합니다.

표 4-2 생체 내 변화 세트 편집

단일 생체 내 변화를 생성하려면 결합된 생체 내 변화를 생성하려면

Single biotransformation을 클릭합니다. Combined biotransformation을 클릭합니
다.

Formula from 필드에서 구조가 손실되는 부
분을 식별합니다.

Biotransformation 1 및 Biotransformation
2 필드에서 각각 생체 내 변화를 선택합니다.

Formula to 필드에 생체 내 변화의 수식을
입력합니다.

—

참고: 사용 가능한 생체 내 변화는 작업 세트에 있습니다.

9. OK를 클릭합니다.
업데이트된 생체 내 변화가 작업 중인 생체 내 변화 세트 및 소스 생체 내 변화 세트에 모
두 표시됩니다.

10. OK를 클릭하여 변경 사항을 저장합니다.
Edit Biotransformation Set 대화 상자가 닫힙니다.

11. OK를 클릭합니다.
Biotransformations 대화 상자가 닫힙니다.

생체 내 변화 세트 삭제
1. Workflow 패널에서 Biotransformations를 클릭합니다.

Biotransformations 대화 상자가 열립니다.

2. 제공된 목록에서 적절한 Set를 선택합니다.

3. Delete를 클릭합니다.
확인 메시지가 열립니다.

4. Yes를 클릭합니다.

5. OK를 클릭합니다.
Biotransformations 대화 상자가 닫힙니다.
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처리 방법 생성 5
이 소프트웨어는 소분자, 펩타이드, 올리고뉴클레오타이드 및 ADC라는 네 개의 워크플로를
지원합니다.

관심 샘플에서 잠재적 대사물을 찾기 위해 연구 대상 샘플 파일에 고유한 처리 매개 변수가 포
함된 방법을 생성해야 합니다.

방법 유형 선택

매개 변수 값 선택

일반 처리 매개 변수 설정

화합물별 처리 매개 변수 설정

처리 매개 변수
Molecule Profiler 소프트웨어의 처리 매개 변수에는 wiff 파일을 처리할 수 있는 모든 특성과
값이 포함됩니다. 처리 기능은 대사물을 찾고 특성화하는 데 사용됩니다. 또한 처리 기능은 대
사물에 신뢰도 점수를 할당합니다.

다음 처리 매개 변수 템플릿이 사용됩니다.

• Small molecule

• Peptides

• Oligonucleotides

• ADC

템플릿은 다양한 유형의 분석을 위해 고려되는 화합물 및 워크플로 유형을 나타냅니다.

참고: 화합물 시퀀스를 추가할 때 시퀀스 이름의 형식이 올바른지 확인하십시오. 자세한 정보
는 펩타이드 시퀀스 명명 규칙 또는 올리고뉴클레오타이드 시퀀스 명명 규칙 섹션을 참조하십
시오.

방법 유형 선택
1. Workflow 패널에서 Processing Parameters를 클릭합니다.

처리 매개 변수 작업 영역이 열립니다.
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2. New를 클릭한 후 제공된 목록에서 방법 유형을 선택합니다.

3. 매개 변수 값 선택의 2단계를 진행합니다.

매개 변수 값 선택
1. Workflow 패널에서 Processing Parameters를 클릭합니다.

Processing Parameters 작업 영역이 열립니다.

2. Processing Parameters 작업 영역에 화합물 정보를 입력합니다.

• 소분자 및 ADC 워크플로의 경우 Structure 그룹에서 Open Structure를 클릭하고 대상
mol 파일을 선택한 후 구조를 가져옵니다.

• 펩타이드 및 올리고뉴클레오타이드 워크플로의 경우 Sequence 그룹에 적절한 시퀀스
를 입력합니다.

팁! Select From Library를 클릭하여 화합물 라이브러리에서 구조 또는 시퀀스를 채울 항
목을 선택할 수도 있습니다. 워크플로와 일치하는 항목만 목록에 포함됩니다. 자세한 정
보는 라이브러리에서 화합물 선택 섹션을 참조하십시오.

3. Polarity, Charge state, Adduct 또는 Ion type이 데이터 세트에 적합한지 확인합니다.
일반적으로 올리고뉴클레오타이드는 음극성 또는 음이온 모드에서 획득됩니다. 질량이
10,000Da 이하인 올리고뉴클레오타이드의 권장 전하 범위는 –2 ~ –20입니다. 질량이
10,000Da보다 큰 올리고뉴클레오타이드는 처리하지 않는 것이 좋습니다.

4. 잠재적 대사물을 찾을 때 사용할 피크 찾기 전략을 선택합니다. 자세한 정보는 피크 찾기
전략 정보 섹션을 참조하십시오.

5. 처리 중인 화합물에 독립적인 매개 변수를 구성합니다. 자세한 정보는 일반 처리 매개 변
수 섹션을 참조하십시오.

6. 화합물에 종속된 매개 변수를 구성합니다. 자세한 정보는 화합물별 처리 매개 변수 섹션
을 참조하십시오.

7. Save and Close를 클릭합니다.

8. Save Processing Parameters As 대화 상자의 Folder 필드에서 방법 저장 위치를 선택합
니다.

9. Name 필드에 방법의 이름을 입력한 후 OK를 클릭합니다.
방법이 저장되고 Processing Parameters 작업 영역이 닫힙니다.

라이브러리에서 화합물 선택
1. Workflow 패널에서 Processing Parameters를 클릭합니다.

처리 매개 변수 작업 영역이 열립니다.

2. Select From Library를 클릭합니다.
Select From Library 대화 상자가 열립니다.

3. Compound name 필드의 목록에서 화합물을 선택합니다.
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참고: 소분자 및 ADC 처리 매개 변수의 경우 화합물 라이브러리에서 구조로 식별된 항목
만 목록에 표시됩니다. 펩타이드 및 올리고뉴클레오타이드 처리 매개 변수의 경우 화합물
라이브러리에서 시퀀스로 식별된 항목만 목록에 표시됩니다.

4. OK를 클릭합니다.
처리 매개 변수 작업 영역이 선택한 화합물의 정보로 업데이트됩니다.

5. 기준 MS/MS 스펙트럼을 검토하거나 편집하려면 Compound-Specific Parameters >
Product Ions and Neutral Losses를 클릭합니다.

참고: Reference MS/MS Spectrum 창에 선택한 화합물의 MS/MS 스펙트럼이 채워집니
다.

6. (선택 사항) 여러 기준 스펙트럼을 사용할 수 있는 경우 목록을 탐색하여 다른 스펙트럼을
선택합니다(해당하는 경우).

참고: 다른 기준 스펙트럼을 선택하면 Reference MS/MS Spectrum 창이 새로 고쳐지고
생성 이온 및 중립 손실 테이블에서 정보가 지워집니다.

7. 단편 테이블을 구성하려면 Assign Fragments를 클릭합니다.

8. 매개 변수 값 선택 섹션의 5단계를 진행합니다.

피크 찾기 전략 정보
피크 찾기 전략은 소프트웨어가 관심 샘플에서 잠재적 대사물을 찾기 위해 사용하는 알고리즘
을 말합니다. 사용자는 Peak Finding Strategy 그룹에서 특정 알고리즘을 선택하여 데이터를
처리할 수 있습니다.

알고리즘 설명

TOF MS
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알고리즘 설명

Predicted metabolites • Small molecule: 이 알고리즘을 사용할 경우 소프트웨어는 선
택한 생체 내 변화 세트, 예측 분열 대사물 및 이 둘의 조합을
기반으로 대사물을 검색합니다.

• Peptides: 이 알고리즘을 사용할 경우 소프트웨어는 생체 내
변화 세트, 예측 분해대사물 및 이 둘의 조합을 기반으로 대사
물을 검색합니다.

• Oligonucleotides: 이 알고리즘을 사용할 경우 소프트웨어는
생체 내 변화 세트, 예측 분해대사물(가수분해 분열, 말단 n+1
및 내부 n–1 생성물 포함) 및 이 둘의 조합을 기반으로 대사물
을 검색합니다.

• ADC: 이 알고리즘을 사용할 경우 소프트웨어는 생체 내 변화,
분열, 항체 단편 및 이 셋의 조합을 기반으로 대사물을 검색합
니다.

자세한 정보는 일반 처리 매개 변수 섹션을 참조하십시오. 각 방법
에서 조합을 사용할 때 MS Parameters 탭에서 선택한 Available
Adducts도 포함됩니다.

참고: 올리고뉴클레오타이드 데이터 처리에는 Predicted
metabolites 옵션이 권장됩니다.

Generic peak finding 이 알고리즘을 사용할 경우 소프트웨어는 예기치 않은 대사물을
검색합니다. Apply mass defect filter 또는 Apply charge state
filter를 선택하여 검색을 더 세분화할 수 있습니다.

이 알고리즘을 제어하는 매개 변수는 Chromatographic Data 및
MS Parameters 탭에 있습니다. 자세한 정보는 일반 처리 매개 변
수 섹션을 참조하십시오.

참고: 이 옵션은 Predicted metabolites 옵션과 함께 올리고뉴클
레오타이드 데이터 처리에 권장됩니다.

Apply mass defect
filter

이 필터는 Compound-Specific Parameters에 지정된 Mass
Defect 범위에서 선택한 필터를 나타내는 피크만 검색하도록 제
한합니다. 이 필터를 선택하면 지정된 기준을 충족하는 일반 피크
찾기에 의해 검색된 대사물만 결과에 포함됩니다.

Apply charge state
filter

이 필터는 Compound Information 그룹의 Charge state 탭 내에
있는 전하를 가진 피크만 검색하도록 제한합니다. 이 필터를 선택
하면 지정된 기준을 충족하는 일반 피크 찾기에 의해 검색된 대사
물만 결과에 포함됩니다.

참고: 이 옵션은 올리고뉴클레오타이드 데이터 처리에 권장되지
않습니다.
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알고리즘 설명

Mass defect 이 알고리즘은 소분자 방법에만 적용할 수 있습니다.

이 알고리즘은 부분 질량을 사용하여 데이터를 필터링합니다. 화
합물, 선택한 생체 내 변화 및 잠재적 분열 대사물은 모두 사용자
가 질량 범위 내에서 특정 대사물을 검색할 수 있는 사용 가능한
필터에 영향을 줍니다.

이 알고리즘을 제어하는 매개 변수는 Mass Defect 탭에 있습니다.
자세한 정보는 화합물별 처리 매개 변수 섹션을 참조하십시오.

Isotope pattern 이 알고리즘은 모체 화합물과 동위 원소 패턴이 유사한 대사물을
검색합니다.

팁! 화합물에 방사성 레이블이 지정된 경우 사용자는
Compound-Specific Parameters > Isotope Pattern을 선택하
여 Processing Parameters 대화 상자에서 동위 원소 농축을 정의
할 수 있습니다.

이 알고리즘을 제어하는 매개 변수는 Isotope Pattern 탭에 있습니
다. 자세한 정보는 화합물별 처리 매개 변수 섹션을 참조하십시오.

TOF MSMS

참고: 이 알고리즘은 처리 매개 변수 방법에 기준 MS/MS 스펙트럼이 포함된 경우에만 작동
합니다. 기준 MS/MS 스펙트럼은 화합물 라이브러리의 항목에서 가져오거나 Product Ions
and Neutral Losses 탭에서 수동으로 추가할 수 있습니다. 자세한 정보는 화합물별 처리 매
개 변수 섹션을 참조하십시오.

Find characteristic
product ions

소프트웨어는 이 알고리즘을 사용하여 IDA 데이터와 SWATH 획
득 데이터에서 모체 화합물에 특징적인 생성 이온을 가진 대사물
을 검색합니다.

이 알고리즘을 통해 사용자는 식별된 이온을 모두 또는 제한된 수
만큼 검색할 수 있습니다.

이 알고리즘을 제어하는 매개 변수는 Product Ions and Neutral
Losses 탭에 있습니다. 자세한 정보는 화합물별 처리 매개 변수
섹션을 참조하십시오.

All specified ions 이 옵션을 선택하면 식별된 모든 이온이 검색됩니다. 예를 들어 네
개의 생성 이온이 식별되고 이러한 이온을 모두 포함하는 피크를
검색하면 정확히 일치하는 항목만 잠재적 대사물로 식별됩니다.

At least __ ions 이 옵션을 선택하면 Product Ions and Neutral Losses 탭에서 선
택한 이온만 검색됩니다. 예를 들어 두 개 이상의 이온이 있는 피
크를 검색하는 경우 선택한 이온 중 두 개 이상의 이온이 대사물의
MS/MS 스펙트럼에 있어야 피크를 대사물로 간주할 수 있습니다.
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알고리즘 설명

Find characteristic
neutral losses

소프트웨어는 이 알고리즘을 사용하여 IDA 데이터와 SWATH 획
득 데이터에서 모체 화합물에 대한 중립 손실을 가진 대사물을 검
색합니다. 펩타이드 및 올리고뉴클레오타이드 워크플로에는 이
알고리즘이 적용되지 않습니다.

이 알고리즘을 통해 사용자는 모든 손실 또는 제한된 수의 손실을
검색할 수 있습니다. 예를 들어 네 개의 중립 손실이 식별되고 이
러한 손실을 모두 포함하는 피크를 검색하면 정확히 일치하는 항
목만 잠재적 대사물로 식별됩니다. 두 개 이상의 손실이 있는 피크
를 검색하는 경우 선택한 손실 중 두 개 이상의 손실이 대사물의
MS/MS 스펙트럼에 있어야 피크를 대사물로 간주할 수 있습니다.

이 알고리즘을 제어하는 매개 변수는 Product Ions and Neutral
Losses 탭에 있습니다. 자세한 정보는 화합물별 처리 매개 변수
섹션을 참조하십시오.

All specified losses 이 옵션을 선택하면 모든 대사물이 검색되고 모든 중립 손실이 보
고됩니다.

At least __ losses 이 옵션을 선택하면 Product Ions and Neutral Losses 탭에서 선
택한 손실만 검색됩니다. 예를 들어 네 개의 중립 손실이 식별되고
이러한 손실을 모두 포함하는 피크를 검색하면 정확히 일치하는
항목만 잠재적 대사물로 식별됩니다. 두 개 이상의 손실이 있는 피
크를 검색하는 경우 선택한 손실 중 두 개 이상의 손실이 대사물의
MS/MS 스펙트럼에 있어야 피크를 대사물로 간주할 수 있습니다.

Consider internal
neutral losses

이 알고리즘은 SWATH 획득 데이터에만 해당됩니다.

이 전략은 중립 손실을 두 개 이상 선택한 경우에만 작동합니다.
내부 중립 손실은 두 중립 손실 수식 간의 델타입니다. "Find by
Internal Neutral Loss"를 적용하려면 한 중립 손실 수식이 다른 중
립 손실 수식의 하위 집합이어야 합니다.

Isotope pattern
(SWATH Only)

이 알고리즘은 SWATH 획득 데이터에만 해당됩니다.

Compound-Specific Parameters의 Product Ions and Neutral
Losses 탭에 있는 테이블에서 선택한 동위 원소 단편화 패턴과 일
치하는 패턴을 가진 전구체에 대사물 플래그가 지정됩니다. 사용
자는 Isotope Pattern 열에서 동위 원소 단편화 수식 확인란을 하
나 이상 선택해야 합니다. 피크를 대사물로 간주하려면 실험 동위
원소 단편화 패턴이 MS/MS Parameters 탭에 지정된 Intensity
Tolerance 및 MS/MS m/z 허용 오차 내에서 이론적 동위 원소 단
편화 패턴과 일치해야 합니다.

일반 처리 매개 변수
일반 매개 변수는 처리 중인 화합물에 독립적인 설정입니다. 다음 각 탭은 일반 매개 변수를 관
리합니다.

처리 방법 생성
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Generic Parameters

Small Molecules Peptides Oligonucleotides ADC
Biotransformations 탭 Biotransformations 탭 Biotransformations 탭 Biotransformations 탭

Chromatographic
Data 탭

Chromatographic
Data 탭

Chromatographic
Data 탭

Chromatographic
Data 탭

MS Parameters 탭 MS Parameters 탭 MS Parameters 탭 MS Parameters 탭

MS/MS Parameters
탭

MS/MS Parameters
탭

MS/MS Parameters
탭

MS/MS Parameters
탭

Formula Prediction 탭
(소분자 및 ADC 방법)

Confirmation Scoring
탭

Confirmation Scoring
탭

Formula Prediction 탭
(소분자 및 ADC 방법)

Confirmation Scoring
탭

Confirmation Scoring
탭

Biotransformations 탭
예상되는 생체 내 변화를 포함하는 생체 내 변화 세트를 식별합니다. 소프트웨어에는 미리 정
의된 생체 내 변화 세트가 포함되어 있습니다. 사용자 지정 생체 내 변화 세트를 생성하려면 생
체 내 변화 세트 생성 섹션을 참조하십시오.

매개 변수 설명

Select Set 데이터베이스에서 처리에 사용할 다른 생체 내 변화 세트를 선택합니다.

이 옵션을 선택하면 "The selected biotransformation set
might no longer exist in the biostransformations
database."라는 경고가 표시될 수 있습니다. 이 문제는 선택한 생체 내
변화 세트가 처리 매개 변수 파일에 저장되었기 때문에 발생합니다.
Biotransformations 작업 영역에서 생체 내 변화 세트에 대한 후속 변경 사
항은 처리 매개 변수 파일에 저장되지 않습니다.

저장된 생체 내 변화 세트를 사용하여 재처리하려면 OK를 클릭한 후
Biotransformations 대화 상자에서 Cancel을 클릭합니다. 처리 매개 변수
파일을 새 생체 내 변화 세트로 업데이트하려면 다음을 수행하십시오.

1. OK를 클릭합니다.

2. 생체 내 변화 세트를 선택합니다.

"If you select this new biotransformation set, you
might not be able to re-select the existing set.
Do you want to continue?"라는 메시지가 표시됩니다.

3. OK를 클릭합니다.

처리 방법 생성
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Chromatographic Data 탭

매개 변수 설명

Chromatographic Peak

Retention time
window

잠재적 대사물을 검색하기 위한 머무름 시간 범위를 지정합니다. RT(머무
름 시간) 범위의 크기는 처리 시간에 정비례합니다.

열의 허공체적을 제외하려면 0.00분보다 큰 값을 지정하십시오.

to 값은 from 값보다 커야 합니다.

RT 범위가 넓으면 처리 시간이 크게 늘어날 수 있으므로 모든 워크플로에
대해 RT 범위를 설정하는 것이 좋습니다. 범위는 분석 중인 실험에 따라
크게 달라집니다. 각 실험에 대한 RT 범위를 검토하십시오. 시작 시간은
0.00분보다 약간 크고, 종료 시간은 관심 피크보다 약간 이후이거나 방법
이 기울기의 높은 용리 또는 세척 단계를 시작할 때로 설정하는 것이 좋습
니다.

MS data XIC 폭을 설정하는 방법을 지정합니다.
• XIC width: 추출 이온 크로마토그램의 폭을 처리하도록 지정합니다.

• Automatic: 선택한 데이터를 기반으로 최적의 폭을 자동으로 계산합
니다.

올리고뉴클레오타이드 워크플로에는 Automatic 설정이 권장됩니다.

참고: SWATH 획득 데이터를 처리할 때 이 옵션을 선택하면 XIC width 옵
션이 적용됩니다.

LC peak
separation

용리되는 피크가 얼마나 근접하게 통합되는지 결정합니다. 이 매개 변수
는 유의한 테일링이 있는 크로마토그래픽 피크도 처리합니다.

근접하게 용리되는 피크가 있는 경우 이 매개 변수를 더 낮게 설정합니다.
더 낮은 설정을 지정하면 피크를 하나의 피크로 간주하지 않고 개별적으
로 고려할 수 있습니다.

TOF MS

Minimum peak
width

폭이 이 값보다 작은 크로마토그래픽 피크를 제외합니다.

좁은 피크를 포함하려면 값을 더 낮게 설정합니다.

처리 방법 생성
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매개 변수 설명

Minimum peak
intensity

주어진 TOF MS 강도 수준보다 낮은 크로마토그래픽 피크를 고려 대상에
서 제거합니다.

노이즈가 심한 크로마토그래픽 데이터가 있을 때 사용합니다. 노이즈 수
준 바로 위의 임계값을 설정하면 노이즈 결과일 가능성이 높은 피크를 거
부할 수 있습니다.

Molecule Profiler 소프트웨어 또는 뷰어 소프트웨어(예: SCIEX OS의
Explorer 작업 영역)에서 데이터를 처리하기 전에 피크 폭을 검사하십시
오. 검사한 모든 피크의 일반 평균을 사용하여 최소 피크 폭을 계산합니다.

TOF MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
50cps 설정이 권장됩니다.

Use smoothing 노이즈 내의 강도 변동을 제거하여 노이즈와 피크를 구별합니다.

노이즈가 심한 크로마토그래픽 데이터가 있을 때 선택합니다.

이 옵션은 올리고뉴클레오타이드 워크플로에 권장됩니다.

Sample-control
offset

MS 샘플 및 대조군 크로마토그램을 정렬합니다. 처리하는 동안 소프트웨
어가 모든 대조군을 샘플과 비교하기 전에 이동합니다.

Sample/control
ratio

샘플 피크가 대사물로 간주되려면 대조군과 비교하여 몇 배 더 커야 하는
지 지정합니다.

TOF MS/MS

Minimum peak
intensity

이 매개 변수는 MS/MS 피크 찾기 알고리즘에서 SWATH 획득 데이터를
처리할 때만 사용됩니다. IDA 데이터를 처리할 때는 이 매개 변수가 사용
되지 않습니다.

주어진 TOF MS/MS 강도 수준보다 낮은 크로마토그래픽 피크를 고려 대
상에서 제거합니다.

노이즈가 심한 크로마토그래픽 데이터가 있을 때 사용합니다. 노이즈 수
준 바로 위의 임계값을 설정하면 노이즈 결과일 가능성이 높은 피크를 거
부할 수 있습니다.

Analog data

Wavelength (UV
only)

잠재적 대사물을 확인할 때 사용할 파장을 선택합니다.

Time offset
from MS

MS 및 아날로그 크로마토그래픽 데이터를 정렬합니다. 처리하는 동안 소
프트웨어가 아날로그 데이터를 MS 데이터와 비교하기 전에 이동합니다.

참고: MS 및 아날로그 크로마토그래픽 데이터를 Analog Interpretation 작
업 영역에서 사후 처리하여 정렬할 수도 있습니다. 자세한 정보는 머무름
시간 오프셋 변경 섹션을 참조하십시오.
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매개 변수 설명

LC peak
separation

용리되는 피크가 얼마나 근접하게 통합되는지 결정합니다. 이 매개 변수
는 유의한 테일링이 있는 크로마토그래픽 피크도 처리합니다.

근접하게 용리되는 피크가 있는 경우 이 매개 변수를 더 낮게 설정합니다.
더 낮은 설정을 지정하면 피크를 하나의 피크로 간주하지 않고 개별적으
로 고려할 수 있습니다.

Minimum peak
width

폭이 이 값보다 작은 크로마토그래픽 피크를 제외합니다.

좁은 피크를 포함하려면 값을 더 낮게 설정합니다.

Minimum peak
intensity

주어진 강도 수준보다 낮은 크로마토그래픽 피크를 고려 대상에서 제거합
니다.

노이즈가 심한 크로마토그래픽 데이터가 있을 때 사용합니다. 노이즈 수
준 바로 위의 임계값을 설정하면 노이즈 결과일 가능성이 높은 피크를 거
부할 수 있습니다.

Use smoothing 노이즈 내의 강도 변동을 제거하여 노이즈와 피크를 구별합니다.

노이즈가 심한 크로마토그래픽 데이터가 있을 때 선택합니다.

Sample-control
offset

MS 샘플 및 대조군 크로마토그램을 정렬합니다. 처리하는 동안 소프트웨
어가 모든 대조군을 샘플과 비교하기 전에 이동합니다.

MS Parameters 탭

매개 변수 설명

m/z Tolerance

MS m/z
tolerance

MS 스펙트럼에서 피크를 결정하기 위한 범위를 지정합니다. 이 범위 내의
모든 질량은 하나의 고유 피크로 간주됩니다. 실험식이 할당된 피크가 잠
재적 대사물로 간주되려면 피크의 질량 정확도가 지정된 허용 오차 내에
있어야 합니다.

이 매개 변수는 기기의 교정 상태에 큰 영향을 받습니다. ±3ppm 이내에서
교정된 기기의 경우 TOF MS 또는 IDA 실험이 포함된 올리고뉴클레오타
이드 방법에는 10ppm 값이 권장됩니다.

Minimum MS
peak intensity

MS 피크 강도에 대한 최소 스펙트럼 임계값을 지정합니다. 지정된 스펙트
럼 임계값 미만의 강도를 가진 MS 피크를 고려 대상에서 제거합니다.

스펙트럼의 노이즈 수준에 따라 값을 설정합니다.

Isotope Pattern Tolerances
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매개 변수 설명

MS m/z
tolerance

대사물의 동위 원소 패턴에 적용되는 허용 오차를 지정합니다. 동위 원소
m/z 오프셋 값이 이 허용 오차 내에 있는 피크만 일치 항목으로 간주됩니
다.

TOF MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
10mDa 값이 권장됩니다.

Intensity
tolerance

Compound-Specific Parameters의 Isotope Pattern 탭에 정의된 동위 원소
강도에 대한 상대 허용 오차를 지정합니다. 일치하는 것으로 간주하려면
두 피크의 강도 비율이 이 허용 오차 내의 예상 비율과 같아야 합니다.

TOF MS 실험이 포함된 올리고뉴클레오타이드 방법의 경우 20% 값이 권
장됩니다.

Minimum Score (올리고뉴클레오타이드 방법) 대사물에 대해 관찰된 동위 원소 패턴을 예
상 동위 원소 패턴과 비교할 때 사용할 최소 일치 허용 오차(백분율)를 지
정합니다. 0%의 값으로 시작한 다음, 확인된 가양성 식별을 제거하는 데
필요한 만큼 값을 늘리는 것이 좋습니다.

Limits

Maximum
number of
unexpected
metabolites

잠재적 대사물로 식별될 수 있는 예기치 않은 피크의 최대 수를 선택합니
다.

이 설정은 일반 피크 찾기로 식별할 수 있는 최대 피크 수에 영향을 줍니
다. 일반 피크 찾기는 예측 대사물 피크 찾기와 상호 작용합니다. 예를 들
어 복잡한 샘플에 대해 더 작은 생체 내 변화 세트를 선택하면 예기치 않은
최대 대사물 수가 많아지므로 이 설정을 늘려야 합니다. 일반적으로 공정
불순물 올리고뉴클레오타이드 샘플의 경우 100으로 설정하는 것이 좋습
니다. 더 복잡한 샘플의 경우 이 값을 늘려야 합니다.

Mass range
window (m/z)

잠재적 대사물을 찾기 위한 질량 범위를 제한합니다.

Generic LC/MS Peak Finding

Perform
background
subtraction

배경 감산을 수행할지 여부를 지정합니다. LC/MS 크로마토그램에서 배경
수준이 높은 경우 배경 이온을 제거하려면 이 옵션을 선택합니다.

TOF MS 및 TOF MS/MS 실험이 포함된 올리고뉴클레오타이드 방법의 경
우 이 옵션이 권장되지 않습니다.

Available Adducts(소분자 방법)

Compound Information 그룹에 정의된 전하 범위를 기반으로 지원되는 모든 부가물 목록입
니다.

Use 부가물을 검색에 포함할지 여부를 나타냅니다.
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매개 변수 설명

__ adduct(s)
selected

(읽기 전용) Available Adducts 테이블의 Use 열에서 선택된 부가물의 수
를 나타냅니다.

Advanced Ion Types(ADC, 펩타이드 및 올리고뉴클레오타이드 방법)

Use 이온을 검색에 포함할지 여부를 나타냅니다.

__ adduct(s)
selected

(읽기 전용) Advanced Ion Types 테이블의 Use 열에서 선택한 이온의 수
를 나타냅니다.

MS/MS Parameters 탭

매개 변수 설명

MS/MS Finding

MS/MS m/z
tolerance

MS/MS 스펙트럼에서 피크를 결정하기 위한 범위를 지정합니다. MS/MS
m/z 허용 오차는 해당하는 전구체 피크가 잠재적 대사물로 간주될 수 있
도록 MS/MS 스펙트럼에서 발견된 단편 피크가 Compound-Specific
Parameters의 Product Ions and Neutral Losses 탭에 지정된 선택된 단편
또는 중립 손실 값과 일치해야 하는 허용 오차입니다.

TOF MS/MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
10mDa 값이 권장됩니다.

Minimum
MS/MS peak
intensity

지정된 스펙트럼 임계값 미만의 강도를 가진 MS/MS 피크를 고려 대상에
서 제거합니다.

스펙트럼의 노이즈 수준에 따라 값을 설정합니다.

MS/MS Isotope Finding

MS/MS m/z
tolerance

MS/MS 스펙트럼에서 피크를 결정하기 위한 범위를 지정합니다. MS/MS
스펙트럼의 피크가 일치하는 것으로 간주되려면 두 동위 원소 피크 간의
질량 차이가 이 허용 오차 내의 예상 차이와 같아야 합니다.

MS/MS m/z 허용 오차는 선택한 동위 원소 패턴(SWATH만 해당) 피크 찾
기 전략으로 SWATH 획득 데이터를 처리할 때 사용됩니다.

TOF MS/MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
10mDa 값이 권장됩니다.
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매개 변수 설명

Intensity
tolerance

Compound-Specific Parameters의 Product Ions and Neutral Losses 탭에
있는 선택한 IP 셀에 정의된 선택한 단편 수식의 동위 원소 강도에 대한 상
대 허용 오차를 지정합니다. 일치하는 것으로 간주하려면 두 피크의 강도
비율이 이 허용 오차 내의 예상 비율과 같아야 합니다. 또한 이 매개 변수
는 패턴의 일부로 간주되는 가장 작은 동위 원소를 정의합니다. 예를 들어
강도 허용 오차가 10%이면 질량 패턴에 기여할 수 있는 가장 작은 동위 원
소는 100%로 정의된 피크의 10% 이상이어야 합니다.

Intensity tolerance는 선택한 동위 원소 패턴(SWATH만 해당) 피크 찾기
전략으로 SWATH 획득 데이터를 처리할 때 사용됩니다.

TOF MS/MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
20% 값이 권장됩니다.

Source of Reference MS/MS Spectrum

Control 관심 화합물에 대한 기준 스펙트럼을 선택합니다. 다양한 위치에서 스펙
트럼을 선택할 수 있습니다.

선택한 기준 스펙트럼이 기본적으로 선택됩니다.

자동 구조 또는 시퀀스 생성 기능을 사용할 때 Selected reference
spectrum 옵션을 선택하는 것이 좋습니다.

Sample

Selected
reference
spectrum

MS/MS Spectrum

Use advanced
MS/MS filter

이 필터는 SWATH 획득 데이터에만 사용됩니다. 이 필터에 사용되는 알고
리즘은 MS/MS 스펙트럼의 단편을 SWATH 획득 데이터의 특정 전구체에
할당하는 데 사용되는 PCVG를 포함하며, 슬라이더의 위치
(Comprehensive 또는 Confident)에 따라 전구체에 확실하게 할당할 수
있는 단편만 MS/MS 스펙트럼에 표시됩니다.

Similarity and Fragment Interpretation

MS/MS m/z
tolerance

기준 MS/MS 스펙트럼을 대사물의 MS/MS 스펙트럼과 비교하기 위해 질
량 정확도 허용 오차를 선택합니다. 이 매개 변수는 Interpretation 테이블
에서 단편이 할당될 때도 사용됩니다. 할당된 단편의 질량 정확도는 제공
된 MS/MS m/z 허용 오차 내에 있어야 합니다.

TOF MS/MS 또는 IDA 실험이 포함된 올리고뉴클레오타이드 방법의 경우
10ppm 값이 권장됩니다.

Minimum
signal-to-noise
ratio

기준 MS/MS 스펙트럼을 대사물의 MS/MS 스펙트럼과 비교하기 위해 원
치 않는 노이즈에 대한 신호의 최소 비율을 선택합니다. 이 매개 변수는
Interpretation 테이블에서 단편이 할당될 때도 사용됩니다. 할당된 단편의
신호 대 노이즈 비율은 제공된 최소 신호 대 노이즈 비율을 초과해야 합니
다.

Fragment Interpretation Options(소분자 및 펩타이드 방법)
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매개 변수 설명

Number of
fragment peaks
selected for
assignment

(소분자 방법) 할당을 위해 선택할 MS/MS 단편 수를 지정합니다. 피크는
강도에 따라 선택됩니다(강도가 높을수록 먼저 선택됨).

Break aromatic
rings

(소분자 방법) 방향족 링의 일부를 구성하는 결합을 끊습니다.

Maximum
number of
bonds to break

(소분자 방법) 해석할 MS/MS 단편을 할당할 때 끊어야 할 최대 결합 수를
지정합니다.

Maximum
number of C-C
bonds to break

(소분자 방법) 해석할 MS/MS 단편을 할당할 때 끊어야 할 최대 C-C 결합
수를 지정합니다.

Fragment
Types

(펩타이드 방법) 단편 유형을 식별합니다. 여러 유형을 선택할 수 있습니
다.

Maximum
bonds to break

(펩타이드 방법) 끊어야 할 최대 결합 수를 지정합니다.

Break linkages (펩타이드 방법) 펩타이드 또는 올리고뉴클레오타이드 시퀀스에서 연쇄를
끊습니다.

Formula Prediction 탭(소분자 및 ADC 방법)

매개 변수 설명

Search Constraints

Elements from

Elements to

소프트웨어가 잠재적 대사물에 대한 수식을 제안하는 데 사용할 시작 원
소를 지정합니다.

Isotope Pattern Tolerances

MS m/z
tolerance

소프트웨어가 제안된 수식에 대해 이론적으로 예측된 동위 원소 패턴을
식별한 후 이 매개 변수는 대사물의 동위 원소 패턴과 비교할 때 동위 원소
간의 허용되는 질량 차이를 제한합니다.

Intensity
tolerance

소프트웨어가 제안된 수식에 대해 이론적으로 예측된 동위 원소 패턴을
식별한 후 이 값은 대사물의 동위 원소 패턴과 비교할 때 허용되는 동위 원
소 피크 강도의 차이를 제한합니다.

Ranking

Contribution 결과에 제공할 수식이 MS 스펙트럼을 기반으로 하는지 아니면 MS/MS 스
펙트럼을 기반으로 하는지 지정합니다.

Automatically
weight MS/MS

MS/MS 가중치에 로그 눈금을 적용하려면 선택합니다.

처리 방법 생성
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Rings and Double Bonds

RDB from

RDB to

잠재적 대사물의 제안된 수식에서 링 및 이중 결합 범위를 식별합니다.

제안된 수식의 링 및 이중 결합 수가 지정된 범위에 속하지 않는 경우 해당
수식은 대사물에 대해 고려되지 않습니다.

최소값은 최대값보다 작아야 합니다.

Element Ratios

Oxygen/
phosphorus
count

제안된 수식에 있어야 하는 산소-인 분자의 범위를 지정합니다.

이 매개 변수는 MS 수식과 MS/MS 수식에 모두 적용됩니다.

Oxygen/sulphur
count

제안된 수식에 있어야 하는 산소-황 분자의 범위를 지정합니다.

이 매개 변수는 MS 수식과 MS/MS 수식에 모두 적용됩니다.

Confirmation Scoring 탭
관심 샘플에서 잠재적 대사물이 발견되면 발견된 피크가 대사물일 가능성을 나타내는 확인 점
수가 할당됩니다. 점수는 대사물을 찾는 데 사용되는 알고리즘과 관계가 없으며 다양한 속성
을 기반으로 합니다.

참고: 올리고뉴클레오타이드 방법의 경우 Isotope pattern의 값은 100, 다른 모든 매개 변수
의 값은 0이 권장됩니다.

매개 변수 설명

Mass defect (소분자 방법) 대사물의 질량 결손이 모체 화합물, 잠재적 분열 대사물 또
는 제2상 대사물의 질량 결손과 얼마나 가깝게 일치하는지 나타냅니다.

참고: 이 특성은 ADC, 펩타이드 및 올리고뉴클레오타이드 데이터의 총 확
인 점수 계산에 사용되지 않습니다.

Isotope pattern (소분자 및 ADC 방법) 대사물에 모체 화합물과 비슷한 동위 원소 패턴이
있는지 여부를 나타냅니다. 이 속성의 점수는 0 ~ 100입니다.

(올리고뉴클레오타이드 방법) 대사물에 예상 동위 원소 패턴과 비슷한 동
위 원소 패턴이 있는지 여부를 나타냅니다. 이 매개 변수는 가양성을 필터
링하는 데 매우 유용합니다. 값 100이 권장됩니다.

처리 방법 생성
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매개 변수 설명

MS/MS MS/MS 스펙트럼이 기준 스펙트럼에 얼마나 가까운지 나타냅니다. 이 속
성은 기준 스펙트럼을 사용할 수 있는 경우에만 적용됩니다.

MS/MS 점수는 다음과 같은 두 가지 요소로 구성됩니다.

• 품질: 스펙트럼 피크를 배경 노이즈와 구별하는 능력의 척도입니다.

• 유사성: 소프트웨어는 알려진 생체 내 변화를 기반으로 이동한 생성 이
온을 포함하여 MS/MS 스펙트럼이 기준 스펙트럼에 얼마나 가까운지
계산합니다.

참고: TOF MS 데이터만 처리 중인 경우 이 매개 변수를 0으로 설정합니
다.

Mass accuracy 발견된 m/z 값이 예상 m/z 값에 얼마나 가까운지 나타냅니다. 이 속성은
예측 대사물에만 적용됩니다.

Total
confirmation
score

(읽기 전용) 네 가지 속성 값의 합계입니다.

팁! 점수를 매길 때 특정 속성을 무시하려면 Scoring 테이블에 0을 입력합니다.

화합물별 처리 매개 변수
화합물별 처리 매개 변수는 처리 중인 화합물에 따라 달라지는 설정입니다. 다음 각 탭은 화합
물별 매개 변수를 관리합니다.

Compound-Specific Parameters

Small Molecules Peptides Oligonucleotides ADC
Cleavage Metabolites
탭(소분자 및 ADC 방

법)

Catabolites 탭(펩타이
드 방법)

Catabolites 탭(올리고
뉴클레오타이드 방법)

Cleavage Metabolites
탭(소분자 및 ADC 방

법)

Mass Defect 탭(소분
자 방법)

Isotope Pattern 탭 Isotope Pattern 탭 Isotope Pattern 탭

Isotope Pattern 탭 Product Ions and
Neutral Losses 탭

Product Ions and
Neutral Losses 탭

Product Ions and
Neutral Losses 탭

Product Ions and
Neutral Losses 탭

항체 세부 정보
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Cleavage Metabolites 탭(소분자 및 ADC 방법)
모체 화합물의 잠재적 분열 대사물을 식별합니다. 소프트웨어에서 잠재적 분열 대사물 목록을
생성하려면 방법에 구조가 포함되어 있어야 합니다.

매개 변수 설명

Potential Compound Cleavages

Maximum
bonds to break

끊어야 할 최대 결합 수를 지정합니다.

Break ring
bonds

링의 일부를 구성하는 결합을 끊습니다.

Only break C-N
bonds

C-N 결합만 끊습니다.

Cleavages
selected

Potential Compound Cleavages 테이블에서 선택된 분열 수를 나타냅니
다. 소프트웨어에서 자동으로 생성됩니다.

Catabolites 탭(펩타이드 방법)
모체 화합물의 잠재적 가수분해 분열을 식별합니다. 소프트웨어에서 잠재적 가수분해 분해대
사물 목록을 생성하려면 방법에 펩타이드 시퀀스가 포함되어 있어야 합니다.

매개 변수 설명

Potential Hydrolytic Cleavages

Max. peptide
bonds to break

끊어야 할 최대 펩타이드 결합 수를 지정합니다.

Max. cross-
links to break

끊어야 할 최대 교차 연결 수를 지정합니다.

Min. AA count 분해대사물의 최소 아미노산 수를 지정합니다.

Catabolites
selected

(읽기 전용) Potential Hydrolytic Cleavages 테이블에서 선택된 분해대사
물의 수를 나타냅니다.

Catabolites 탭(올리고뉴클레오타이드 방법)
모체 화합물의 잠재적 가수분해 분열을 식별합니다. 소프트웨어에서 잠재적 가수분해 분해대
사물 목록을 생성하려면 방법에 펩타이드 시퀀스가 포함되어 있어야 합니다.

매개 변수 설명

Potential Hydrolytic Cleavages

Max. bonds to
break

올리고뉴클레오타이드 백본을 따라서만 끊을 수 있는 최대 결합 수를 지
정합니다(H2PO3손실 포함). 핵염기 및 당분 손실에 대한 정보는
Biotransformations 탭 섹션을 참조하십시오.

처리 방법 생성
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매개 변수 설명

Min.
Nucleotides

잠재적 분해대사물 및 가수분해 분열을 생성하는 데 사용되는 최소 뉴클
레오타이드 수를 지정합니다.

Include
terminus n+1
sequences

말단 n+1 불순물을 검색할지 여부를 지정합니다.

Include internal
n-1 sequences

내부 n–1 불순물을 검색할지 여부를 지정합니다.

Catabolites
selected

(읽기 전용) Potential Hydrolytic Cleavages 테이블에서 선택된 분해대사
물의 수를 나타냅니다.

Mass Defect 탭(소분자 방법)
이러한 필터는 복잡한 생물학적 샘플을 분석할 때 배경 간섭을 제거하는 데 도움이 될 수 있습
니다.

매개 변수 설명

Mass Defect Filters

Filters selected 질량 결손 필터 테이블에서 선택된 질량 결손 필터의 수를 나타
냅니다. 소프트웨어에서 자동으로 생성됩니다.

Filters

Parent 기본적으로 선택됩니다.

Glucuronidation 기본적으로 선택됩니다.

Bis-Glucuronidation 기본적으로 선택됩니다.

Glutathione 기본적으로 선택됩니다.

Sulphate 기본적으로 선택됩니다.

Isotope Pattern 탭

매개 변수 설명

Isotope Pattern Isotopes 테이블에 나열된 정보의 그래픽 표현을 보여줍니다.

(올리고뉴클레오타이드 방법) 지정된 전하 상태에서 올리고뉴클레오타이
드에 대한 동위 원소 분포의 그래픽 표현을 보여줍니다. 전하 상태를 변경
하려면 Compound Information에서 다른 Ion type을 선택합니다.

처리 방법 생성
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매개 변수 설명

Isotopic
Enrichment

모체 화합물의 수식에 사용할 원자의 동위 원소 농축을 지정합니다.

참고: ADC 또는 소분자 방법을 위한 동위 원소 요소를 추가하려면 동위
원소가 포함된 mol 파일을 가져옵니다.

참고: 농축 원자가 있는 펩타이드 및 올리고뉴클레오타이드 수식에 대한
동위 원소 농축을 변경하려면 펩타이드 및 올리고뉴클레오타이드 수식의
동위 원소 농축 편집 섹션을 참조하십시오.

Isotopes 해당하는 경우 모체 화합물의 수식 및 동위 원소 농축을 기반으로 가장 강
한 동위 원소를 표시합니다.

Isotope Pattern
Intensity Cufoff
for Metabolite
XICs (%)

(올리고뉴클레오타이드 방법) 피크 면적 계산 중 XIC 추출을 위해 고려되
는 개별 동위 원소에 적용할 컷오프 값(백분율 강도)을 지정합니다. 강도
가 컷오프 미만인 동위 원소는 테이블에 빨간색으로 표시됩니다.

Product Ions and Neutral Losses 탭

매개 변수 설명

Reference
MS/MS
Spectrum

잠재적 대사물의 MS/MS와 일치하도록 생성 이온 및 중립 손실을 선택할
때 사용할 스펙트럼을 식별합니다. 가장 좋은 소스는 관심 샘플과 유사한
조건에서 획득한 샘플의 데이터 파일입니다.

다음 두 위치 중 하나에서 스펙트럼을 선택할 수 있습니다.

• wiff 파일

• 화합물 라이브러리

Filters

m/z From __ to
__

생성 이온 및 중립 손실 테이블을 채울 때 고려할 질량 범위를 정의합니다.
선택한 범위 내의 단편만 생성 이온 및 중립 손실 테이블에 표시됩니다.

Charge state
From __ to __

생성 이온 및 중립 손실 테이블을 채울 때 고려할 전하 상태 범위를 정의합
니다. 선택한 범위 내의 전하를 가진 단편만 생성 이온 및 중립 손실 테이
블에 표시됩니다.

Only show
product ions
above (%)

생성 이온 및 중립 손실 테이블에 포함할 생성 이온의 최소 임계값을 정의
합니다. 주어진 강도보다 낮은 생성 이온을 고려 대상에서 제거합니다.

Mass accuracy
within (mDa)

지정된 값 내의 질량 정확도를 가진 단편만 생성 이온 및 중립 손실 테이블
에 표시됩니다.

처리 방법 생성
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매개 변수 설명

Add product
ions, neutral
losses from
Phase II
metabolites

(소분자 및 ADC 방법) 제2상 대사물의 생성 이온 및 중립 손실을 생성 이
온 및 중립 손실 테이블에 포함합니다.

참고: 필터에 대해 필요한 모든 변경을 수행한 후 Assign Fragments를 클릭하여 생성 이온
및 중립 손실 테이블을 업데이트합니다.

항체 세부 정보

참고: 이러한 화합물별 매개 변수는 ADC 방법에만 적용할 수 있습니다.

매개 변수 설명

Protein
Sequence

항체의 단백질 시퀀스입니다.

Enzyme 단백질을 소화하는 데 사용할 효소입니다.

Break disulfide
bonds

이 확인란을 선택하면 이황화 결합이 끊어집니다.

Site of
conjugation

약물 분자가 포합될 수 있는 항체의 아미노산입니다.

Type of
conjugation

항체에 대한 약물 분자의 포합과 관련된 화학적 성질입니다.

Max. AA count 소화 후 잠재적 단편으로 간주할 최대 아미노산 수입니다.

Selected
fragments

소프트웨어에서 자동으로 생성됩니다. 테이블에서 선택된 단편의 수를 나
타냅니다.

펩타이드 및 올리고뉴클레오타이드 수식의 동위 원
소 농축 편집
선행 조건

사용자 지정 아미노산 변형 여부에 관계없이 사용자 지정 아미노산이 생성되어야 합니다. 자
세한 정보는 사용자 지정 아미노산 생성 및 사용자 지정 아미노산 변형 생성 섹션을 참조하
십시오. 사용자 지정 아미노산 또는 사용자 지정 아미노산 변형은 하나 이상의 농축 동위 원
소를 포함해야 합니다.

1. Workflow 패널에서 Processing Parameters.를 클릭합니다.
처리 매개 변수 작업 영역이 열립니다.

처리 방법 생성

Molecule Profiler 소프트웨어
52/141

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A



2. New > Peptides또는 New > Oligonucleotide를 클릭합니다.

참고: 화합물 라이브러리에서 시퀀스를 채울 항목을 선택할 수도 있습니다.

3. 제공된 필드에 사용자 지정 아미노산 또는 올리고뉴클레오타이드의 Compound name을
입력합니다.

4. 사용자 지정 아미노산 또는 올리고뉴클레오타이드에 대한 Sequence 정보를 입력합니다.
시퀀스는 하나 이상의 농축 동위 원소를 포함해야 합니다.

5. Chemical formula 필드를 클릭합니다.

Chemical formula 필드와 m/z 값이 사용자 지정 아미노산 관련 정보로 채워집니다.

팁! 시퀀스 위에  아이콘이 표시됩니다. 커서로 아이콘을 가리키면 사용된 사용자 지정
아미노산의 Symbol 및 Residue Formula가 표시됩니다.

6. Compound-Specific Parameters > Isotope Pattern을 클릭합니다.
Isotopic Enrichment 테이블에서 사용자 지정 아미노산의 잔기 화학식이 Element 열에 표
시되고 100이 Enrichment % 열에 표시됩니다.

7. 필요에 따라 Enrichment % 값을 수정합니다.

8. Save and Close를 클릭합니다.

처리 방법 생성
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잠재적 분자 검색 6
Batch 작업 영역은 여러 샘플 파일을 동시에 처리하는 데 사용됩니다. 배치 테이블을 수동으로
완성하거나 기존 배치를 가져와 테이블을 채울 수 있습니다.

1. 배치를 수동으로 준비하려면 배치 생성 섹션을 진행합니다.

2. 기존 배치를 열려면 배치 열기 섹션을 진행합니다.

3. 기존 배치를 가져오려면 배치 가져오기 섹션을 진행합니다.

Batch 작업 영역 정보
Batch 작업 영역을 사용하여 처리할 샘플 배치를 생성할 수 있습니다.

그림 6-1 Batch 작업 영역

잠재적 분자 검색
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항목 설명

1 메뉴 모음. 다음 버튼이 포함되어 있습니다.
• Options: 사용자가 배치와 관련된 옵션을 지정할 수 있는 Batch

Processing Options 대화 상자를 엽니다. 자세한 정보는 배치 처리 옵
션 섹션을 참조하십시오.

• New: 배치를 저장하려면 클릭합니다. Sample/Controls 필드에 샘플
이 추가된 후에만 사용할 수 있습니다.

• Open: 사용자가 열려는 기존 배치를 선택할 수 있는 Open Processing
Batch 대화 상자를 엽니다. 자세한 정보는 배치 열기 섹션을 참조하십
시오.

• Import: 사용자가 가져올 Excel 파일을 선택할 수 있는 Batch Importer
대화 상자를 엽니다. 자세한 정보는 배치 가져오기 섹션을 참조하십시
오.

• Save: 현재 열려 있는 배치 파일을 저장합니다. 기존 버전을 자동으로
바꿉니다. 배치 정보가 수정된 후에만 사용할 수 있습니다.

• Save As: 현재 열려 있는 배치 파일을 저장합니다. 사용자는 배치 파일
에 새 이름을 할당할 수 있습니다.

2 Find Metabolites 버튼. 배치 처리를 시작합니다.

3 Sample/Controls 열. Sample 버튼은 사용자가 관심 샘플을 선택할 수 있
는 Select Data 대화 상자를 엽니다. Controls 버튼은 사용자가 해당 대조
샘플을 선택할 수 있는 Select Data 대화 상자를 엽니다. 샘플당 최대 5개
의 대조 샘플을 선택할 수 있습니다.

4 Folder 열. 처리 매개 변수 및 결과가 저장되는 폴더 위치 목록을 제공합
니다.

5 Processing Parameters 열. 관심 샘플을 처리하는 데 사용할 수 있는 처
리 매개 변수 목록을 제공합니다. 선택한 Folder에 저장된 처리 매개 변수
만 선택할 수 있습니다.

6 Apply Options 열. 기본적으로 선택됩니다. 이 열을 선택하면 Batch
Processing Options 대화 상자에서 선택한 모든 Auto Assign 및 Report 옵
션이 배치의 샘플과 대조 샘플에 적용됩니다. 다음 옵션을 사용할 수 있습
니다.

• 선택한 모든 확인란을 선택 취소하려면 Apply Options 확인란의 선택
을 취소합니다.

• 특정 샘플 확인란의 선택을 취소합니다.

• 특정 샘플 확인란을 선택합니다.

자세한 정보는 배치 처리 옵션 섹션을 참조하십시오.

참고: 올리고뉴클레오타이드 워크플로에는 Auto Assign 옵션이 적용되지
않습니다.
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항목 설명

7 Results File 열. 결과 파일의 사용자 지정 이름입니다.

배치 옵션 지정
자세한 정보는 배치 처리 옵션 섹션을 참조하십시오.

1. Workspace 패널에서 Batch를 클릭합니다.
Batch 작업 영역이 열립니다.

2. Options를 클릭합니다.
Batch Processing Options 대화 상자가 열립니다.

3. (소분자, 펩타이드 및 ADC 워크플로) Auto Assign 탭에서 다음을 수행합니다.

• 해당되는 각 옵션의 확인란을 선택합니다.

• 선택한 각 옵션에 적절한 값을 입력합니다.

4. Report 탭에서 다음을 수행합니다.

• 해당되는 각 옵션의 확인란을 선택합니다.

• 선택한 각 옵션에 적절한 값을 입력합니다.

5. OK를 클릭합니다.
배치 옵션이 배치와 함께 저장됩니다.

배치 처리 옵션
옵션 설명

Auto Assign

참고: 자동 할당 옵션은 서로 독립적입니다. 이 옵션은 "or" 조건으로 간주됩니다. 선택한 옵
션 중 하나 이상이 지정된 기준을 충족해야 합니다.

참고: 올리고뉴클레오타이드 샘플에는 자동 할당 옵션이 적용되지 않습니다.

Assign Structures or
Sequences

선택한 옵션의 기준을 충족하는 대사물에 대한 잠재적 구조 또는
시퀀스를 제안합니다. 사용된 데이터 유형 및 처리 매개 변수(즉,
소분자 또는 펩타이드)에 따라 달라집니다.
참고: 여러 옵션을 선택할 수 있습니다.

Metabolites with peak
areas above (%)

XIC 피크 면적이 지정된 값을 초과하는 대사물에 대한 잠재적 구
조 또는 시퀀스를 제안합니다.

Metabolites with analog
peak areas above (%)

아날로그 피크 면적이 지정된 값을 초과하는 대사물에 대한 잠재
적 구조 또는 시퀀스를 제안합니다.
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옵션 설명

Metabolites with MS/MS
quality above

MS/MS 품질이 지정된 값을 초과하는 대사물에 대한 잠재적 구
조 또는 시퀀스를 제안합니다.

올리고뉴클레오타이드 워크플로에는 이 옵션이 적용되지 않습
니다.

Report

참고: 보고서 옵션은 서로 종속적입니다. 이 옵션은 "and" 조건으로 간주됩니다. 선택한 모든
옵션이 지정된 기준을 충족해야 합니다.

Report metabolites with
assigned structures or
sequences

구조 또는 시퀀스가 할당된 대사물에 대해 Potential Metabolites
테이블의 Report 열에 확인 표시를 추가합니다.

Report metabolites with
peak areas above (%)

피크 면적이 지정된 값을 초과하는 대사물에 대해 Potential
Metabolites 테이블의 Report 열에 확인 표시를 추가합니다.

Report metabolites with
analog peak areas
above (%)

아날로그 피크 면적이 지정된 값을 초과하는 대사물에 대해
Potential Metabolites 테이블의 Report 열에 확인 표시를 추가합
니다.

Report metabolites with
scores above (%)

점수가 지정된 값을 초과하는 대사물에 대해 Potential
Metabolites 테이블의 Report 열에 확인 표시를 추가합니다.

배치 생성
참고: 각 행에서 하나의 샘플만 처리할 수 있습니다. 각 샘플에 대해 최대 5개의 대조 샘플을
선택할 수 있습니다. 그러나 대조 샘플은 처리에 필요하지 않습니다.

1. Workspace 패널에서 Batch를 클릭합니다.
Batch 작업 영역이 열립니다.

팁! 이전에 저장한 배치 파일을 검색하려면 Open 옵션을 선택합니다. 자세한 정보는 배치
열기 섹션을 참조하십시오.

2. 다음을 수행하여 MS 샘플을 추가합니다.

a. 배치 테이블의 첫 번째 사용 가능한 행에서 Sample을 클릭합니다.
Select Data 대화 상자가 열립니다.

b. Browse를 클릭한 후 적절한 소스 폴더로 이동합니다.

c. Available 필드에서 관심 샘플이 포함된 wiff 파일 및 주입을 선택한 후 >>을 클릭합니
다.
샘플 정보가 Selected 필드에 표시됩니다.

3. (선택 사항) 다음을 수행하여 아날로그 샘플을 추가합니다.
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팁! 아날로그 데이터를 획득한 경우 Use analog data 확인란을 선택하면 MS 샘플을 추가
할 때 아날로그 데이터가 자동으로 추가됩니다.

a. 배치 테이블의 첫 번째 사용 가능한 행에서 Use analog data를 클릭합니다.

b. Analog Sample 탭을 엽니다.

c. Browse를 클릭한 후 적절한 소스 폴더로 이동합니다.

d. Available 필드에서 아날로그 샘플을 선택한 후 >>을 클릭합니다.
샘플 정보가 Selected 필드에 표시됩니다.

4. OK를 클릭합니다.
배치 테이블에서 선택한 행의 Sample/Controls 필드에 샘플 정보가 채워집니다.

5. (선택 사항) 다음을 수행하여 MS 대조군을 추가합니다.

a. 배치 테이블의 첫 번째 사용 가능한 행에서 Control을 클릭합니다.
Select Data 대화 상자가 열립니다.

b. Browse를 클릭한 후 적절한 소스 폴더로 이동합니다.

c. Available 필드에서 대조군이 포함된 wiff 파일 및 주입을 선택한 후 >>을 클릭합니다.
샘플 정보가 Selected 필드에 표시됩니다.

d. 다음 단계를 계속하여 아날로그 대조군을 추가하거나 OK를 클릭하여 이 대화 상자를
닫습니다.

6. (선택 사항) 다음을 수행하여 아날로그 대조군을 추가합니다.

a. 배치 테이블의 첫 번째 사용 가능한 행에서 Use analog data를 클릭합니다.

b. Analog Sample 탭을 엽니다.

c. Browse를 클릭한 후 적절한 소스 폴더로 이동합니다.

d. Available 필드에서 아날로그 샘플을 선택한 후 >>을 클릭합니다.
샘플 정보가 Selected 필드에 표시됩니다.

e. OK를 클릭합니다.
배치 테이블에서 선택한 행의 Sample/Controls 필드에 샘플 정보가 채워집니다.

7. Folder 열에서 처리 매개 변수와 결과 파일을 저장할 폴더를 선택합니다.

8. Processing Parameters 열에서 처리 매개 변수 파일을 선택합니다.

팁! 처리 매개 변수 파일을 보려면 P를 클릭합니다. 필요에 따라 매개 변수를 변경한 후
Save and Close를 클릭하여 저장합니다.

9. Results File 열에 결과를 저장할 파일의 이름을 입력합니다.

10. 배치의 각 행에 대해 2단계 ~ 9단계를 반복합니다.

참고: 한 배치에서 처리할 수 있는 최대 행 수는 200개입니다.

팁! 배치 생성을 쉽게 하기 위해 행을 복사하여 붙여 넣거나 삭제할 수 있습니다. 자세한
정보는 배치 행 복사 및 붙여넣기 또는 배치 행 지우기 섹션을 참조하십시오.
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배치 행 복사 및 붙여넣기
복사 및 붙여넣기 옵션을 사용하여 배치를 편집할 수 있습니다.

1. 배치 테이블에서 복사할 행을 선택합니다.

2. 마우스 오른쪽 버튼을 클릭한 후 Copy Batch Row를 선택합니다.

3. 붙여 넣은 정보의 대상 행을 선택합니다.

4. 마우스 오른쪽 버튼을 클릭한 후 Paste Batch Row를 선택합니다.

참고: 대상 행의 기존 정보를 덮어씁니다.

배치 행 지우기
배치를 생성할 때 샘플 정보 행을 지울 수 있습니다.

1. 배치 테이블에서 지울 행을 선택합니다.

2. 마우스 오른쪽 버튼을 클릭한 후 Clear Batch Row를 선택합니다.
선택한 행에서 모든 데이터가 제거됩니다.

배치 열기
1. Workspace 패널에서 Batch를 클릭합니다.

Batch 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Processing Batch 대화 상자가 열립니다.

3. 배치 파일을 선택한 후 OK를 클릭합니다.

4. 다음 중 하나를 수행합니다.

• 배치가 완료된 경우 배치 제출 섹션을 진행합니다.

• 배치가 완료되지 않은 경우 배치 생성 섹션을 진행합니다.

배치 가져오기
1. Workspace 패널에서 Batch를 클릭합니다.

2. Import를 클릭합니다.
Batch Importer 대화 상자가 열립니다.

3. Browse를 클릭합니다.
Open excel file 대화 상자가 열립니다.

4. 적절한 Excel 파일을 찾아 선택합니다.

참고: Excel 파일은 소프트웨어와 함께 배포되는 예제 템플릿(BatchImportTemplate.xlsx)
을 사용하여 생성해야 합니다. 설치하는 동안
C:\ProgramData\SCIEX\Molecule Profiler\Batch Import Templates 폴더
에 템플릿이 설치됩니다.
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5. Open을 클릭합니다.
가져온 Excel 파일의 이름이 Target batch file 필드에 입력됩니다. 필요한 경우 이 정보를
수정할 수 있습니다.

6. 다음 중 하나를 수행합니다.

• 선택한 Excel 파일을 Molecule Profiler 소프트웨어 배치로 변환하고 Batch 작업 영역에
서 배치를 열려면 Convert and Open을 클릭한 후 7단계를 진행합니다.

• 선택한 Excel 파일을 나중에 Batch 작업 영역에서 열 수 있는 Molecule Profiler 소프트
웨어 배치로 변환하려면 Convert를 클릭한 후 7단계를 진행합니다.

• 가져오기를 취소하려면 Close를 클릭합니다.

7. 다음 중 하나를 수행합니다.

• Convert and Open 옵션을 선택하고 Excel 파일에서 참조하는 모든 처리 매개 변수(방
법 파일)와 폴더가 올바른 위치에 저장되어 있으면 배치 제출 섹션을 진행합니다.

• Convert 옵션을 선택하고 Excel 파일에서 참조하는 모든 처리 매개 변수(방법 파일)와
폴더가 올바른 위치에 저장되어 있으면 배치 저장 섹션을 진행합니다.

• Convert and Open 옵션 또는 Convert 옵션을 선택하고 확인 대화 상자가 표시되면 8
단계를 진행합니다.

그림 6-2 Confirmation 대화 상자

8. 다음 중 하나를 수행합니다.

• (소분자 워크플로) 필요한 방법 파일을 자동으로 생성하려면 9단계를 진행합니다.

참고: Method Generator는 펩타이드, 올리고뉴클레오타이드 또는 ADC 워크플로와 함
께 사용할 수 없습니다.

• 필요한 방법 파일을 수동으로 생성하려면 No를 클릭한 후 가져오기를 취소합니다. 처
리 방법 생성 섹션을 진행합니다.

9. Yes를 클릭합니다.
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그림 6-3 Method Generator 대화 상자

10. Source data folder 목록에서 적절한 폴더를 선택합니다.

11. Parameters to copy 목록에서 적절한 방법 파일을 선택합니다.

12. Compound structure folder 필드 오른쪽의 폴더 아이콘을 클릭한 후 처리 매개 변수의
전구체 구조가 포함된 폴더를 찾아 선택합니다.

13. 다음 중 하나를 수행합니다.

• 샘플 wiff 파일에 기준 MS/MS가 포함된 경우 Sample을 클릭합니다.

• 대조군 wiff 파일에 기준 MS/MS가 포함된 경우 Control을 클릭합니다.

14. Create를 클릭합니다.
처리 매개 변수와 누락된 폴더가 생성되어 Excel 스프레드시트에 지정된 위치에 저장됩니
다.

15. 다음 중 하나를 수행합니다.

• Convert and Open 옵션을 선택한 경우 배치 제출 섹션을 진행합니다.

• Convert 옵션을 선택한 경우 배치 저장 섹션을 진행합니다.

배치 저장
Batch 작업 영역의 테이블에 추가된 정보를 나중에 사용할 수 있도록 저장할 수 있습니다.

1. 동일한 파일 이름을 사용하여 배치를 저장하려면 Save를 클릭합니다.

2. 다른 파일 이름을 사용하여 배치를 생성하려면 Save As를 클릭합니다.
Save Processing Batch As 대화 상자가 열립니다.

3. 고유한 Name을 입력한 후 OK를 클릭합니다.

배치 제출
배치가 준비되고 배치 옵션이 지정된 후 데이터 처리를 위해 배치가 제출됩니다.

잠재적 분자 검색

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
61/141



참고: 필요한 경우 배치를 제출하기 전에 관심 샘플에 대해 처리 매개 변수를 수정할 수 있습니
다.

1. (선택 사항) 샘플의 처리 매개 변수를 보려면 다음을 수행합니다.

a. 관심 샘플이 포함된 행을 선택한 후 Processing Parameters 필드 오른쪽에 있는 P
를 클릭합니다.
선택한 샘플과 관련된 처리 매개 변수가 표시됩니다.

b. 필요한 내용을 수정한 후 Save and Close를 클릭합니다.
Batch 작업 영역이 표시됩니다.

2. Save As를 클릭합니다.
Save Processing Batch As 대화 상자가 열립니다.

3. 고유한 Name을 입력한 후 OK를 클릭합니다.

4. Find Metabolites를 클릭합니다.
배치 처리가 시작됩니다. 진행률 표시줄에 처리 상태가 표시됩니다. 처리 중에는 매개 변
수를 수정할 수 없도록 P가 비활성화됩니다. 행 처리가 완료되면 Processing
Parameters 필드 오른쪽의 P와 Results File 필드 오른쪽의 R을 사용할 수 있습니다.

5. R을 클릭하여 Results 작업 영역에서 결과 파일을 엽니다.

참고: Batch Processing Options 대화 상자에서 선택한 Auto Assign 및 Report 옵션은 소
프트웨어에 의해 완료됩니다.

6. (선택 사항) 1단계를 완료하여 업데이트된 처리 매개 변수를 저장합니다.

7. Save를 클릭합니다.

팁! 다른 이름으로 배치를 저장하려면 Save As를 클릭합니다.
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결과 보기 7
Results 작업 영역을 사용하여 관심 샘플에서 잠재적 대사물을 검색한 결과를 볼 수 있습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

Results 작업 영역 정보
소프트웨어에서 데이터가 처리된 후 Results 작업 영역을 사용하여 잠재적 대사물 목록을 볼
수 있습니다.

그림 7-1 Results 작업 영역
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항목 설명

1 메뉴 모음. 다음 버튼이 포함되어 있습니다.
• View

• Processing Parameters: 결과에 대한 처리 매개 변수를 표시합니
다.

• Batch Options: 결과에 대한 배치 처리 옵션을 표시합니다.

• Sample Details: 샘플에 대한 세부 정보를 표시합니다.

• Open: 사용자가 적절한 결과 파일을 찾아볼 수 있는 Open Results 대
화 상자를 엽니다.

• Save: 현재 열려 있는 결과 파일을 저장합니다. 기존 버전을 자동으로
바꿉니다.

• Save As: 현재 열려 있는 결과 파일을 저장합니다. 사용자는 대상 폴더
를 선택하고 결과 파일에 새 이름을 할당할 수 있습니다.

2 Potential Metabolites 창. 관심 샘플에서 선택한 알고리즘에 의해 검색된
모든 피크를 나열합니다. 자세한 정보는 피크 찾기 전략 정보 섹션을 참조
하십시오.

잠재적 대사물을 포함하지 않는 행을 삭제하고, 이름과 수식을 변경하고,
MS/MS 스펙트럼을 추가하고, 피크 ID를 할당하여 결과를 편집합니다. 자
세한 정보는 결과 편집 섹션을 참조하십시오.

Potential Metabolites 테이블의 열에 대한 설명은 표 7-1 섹션을 참조하십
시오.

참고: 미리 정의된 필터는 목록에 표시된 잠재적 대사물에 영향을 미칠 수
있습니다. 자세한 정보는 결과 필터 정보에서 확인하십시오.
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항목 설명

3 Details 창. 잠재적 대사물의 점수 매기기 방식에 대한 정보를 제공합니다.
처리 방법의 각 속성에 대해 Scoring 목록에는 개별 대사물의 점수와 모
든 대사물의 총 점수가 표시됩니다. 자세한 정보는 Confirmation Scoring
탭 섹션을 참조하십시오. Mass Defect(올리고뉴클레오타이드의 경우 비
활성화됨), Isotope Pattern, MS/MS, Mass Accuracy 및 Total
confirmation score에 대한 점수가 표시됩니다.

소분자 결과의 경우 사용 가능한 구조가 Structure 목록에 표시됩니다.

ADC 결과의 경우 사용 가능한 구조와 사용 가능한 시퀀스가 모두
Structure 목록에 표시됩니다.

펩타이드 결과의 경우 사용 가능한 시퀀스가 Sequence 목록에 표시됩니
다.

올리고뉴클레오타이드 결과의 경우 Interpretation 보기의 MS/MS 할당에
의해 결정된 선택된 대사물에 대한 올리고뉴클레오타이드 시퀀스가
Sequence 목록에 표시됩니다. 할당되지 않은 경우 이 필드는 비어 있습
니다.
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항목 설명

4 Chromatograms 창. 발견된 잠재적 대사물에 대해 사용자가 다양한 크로
마토그램을 표시할 수 있습니다.

• Metabolites: 현재 발견된 모든 대사물 피크의 합계를 표시합니다. 모
든 주요 크로마토그래픽 피크가 RT 및 피크 ID와 함께 표시됩니다. 선
택한 대사물 피크 및 동일한 머무름 시간에 용리되는 피크는 노란색입
니다.

• XIC: 선택한 대사물에 대한 XIC(추출 이온 크로마토그램)를 표시합니
다. XIC 추출을 위해 선택된 동위 원소는 그래프 상단에 레이블이 지정
되어 있습니다.

• Mass Defect: 선택한 대사물을 식별하는 데 사용되는 질량 결손 크로
마토그램을 표시합니다. 이것은 소분자 데이터에만 해당됩니다.

• Isotope Pattern: 모체 화합물과 일치하는 동위 원소 패턴을 가진 모든
피크의 크로마토그램을 표시합니다.

• Product Ions: Product Ion and Neutral Losses 탭에서 선택한 단편과
일치하는 단편 이온을 가진 모든 피크의 크로마토그램을 표시합니다.

• Neutral Losses: Product Ion and Neutral Losses 탭에서 선택한 중립
손실과 일치하는 중립 손실을 가진 모든 피크의 크로마토그램을 표시
합니다.

• Isotope Pattern(SWATH 획득 데이터): Product Ion and Neutral
Losses 탭에서 선택한 동위 원소 단편화 패턴과 일치하는 패턴을 가진
모든 피크의 크로마토그램을 표시합니다.

• Analog Data: 모든 피크의 아날로그 크로마토그램을 표시합니다. 피크
레이블은 아날로그 피크와 이에 대응하는 MS 피크 둘 다에 대해 일치
하는 피크 ID를 나타냅니다.

참고: Mass Defect, Isotope Pattern, Product Ions, Neutral Losses 및
Isotope Pattern(SWATH 획득 데이터) 크로마토그램은 처리를 위해 이러
한 알고리즘을 선택한 경우에만 사용할 수 있습니다. 또한 처리 방법에 정
의된 대로 아날로그 데이터가 처리된 경우 Analog Data 크로마토그램을
Chromatograms 목록에서 사용할 수 있습니다.

참고: 올리고뉴클레오타이드 워크플로에서는 Metabolites, XIC 및
Analog Data 보기만 사용할 수 있습니다.

참고: Show Controls 확인란을 선택한 경우 XIC와 Analog Data 크로마
토그램(해당하는 경우) 모두 대조군 트레이스를 표시합니다.
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항목 설명

5 MS 창. MS 스펙트럼을 표시합니다. Show 목록의 옵션은 강조 표시할 피
크를 선택합니다.

• Default: 선택한 대사물의 m/z 값을 중심으로 샘플 MS의 일부를 표시
합니다.

• Mass Defect: 처리 방법에서 선택한 질량 결손 필터와 일치하는 모든
m/z 값을 강조 표시합니다. 이것은 소분자 데이터에만 해당됩니다.

• Isotope Pattern: 모체 화합물과 동일한 동위 원소 패턴을 가진 모든
m/z 값을 강조 표시합니다.

올리고뉴클레오타이드 워크플로의 경우 기본적으로 Predicted Isotope
Pattern 및 Charge Series 트레이스가 중첩됩니다. 기본 보기에는 선택
한 대사물에 대한 중심 TOF MS 스펙트럼이 표시됩니다. 단일 동위 원소
피크에는 예상 전하 레이블이 지정되고 파란색 화살표는 해당 위치를 나
타냅니다. m/z 축의 빨간색 화살표는 XIC 추출 및 면적 측정을 위해 선택
된 개별 동위 원소를 나타냅니다. 이론적 동위 원소 엔벨로프는 관측된 데
이터에 대한 적합도 평가를 제공하기 위해 중심 피크를 중첩합니다. 스펙
트럼을 전체 범위로 설정하려면 m/z 축 아래를 두 번 클릭합니다. 선택한
대사물에 대한 추가 전하 상태의 예측 위치를 보려면 마우스 왼쪽 버튼을
클릭하고 m/z 축을 끌어 이동 및 확대/축소합니다.

6 MS/MS 창. 선택한 대사물에 대한 MS/MS 스펙트럼을 표시합니다. 이 데
이터의 소스는 다음 중 하나입니다.

• 샘플 IDA wiff 파일

• 샘플 SWATH 획득 wiff 파일

• 결과 파일에 추가된 전용 MS/MS wiff 파일. 자세한 정보는 Add MS/MS
버튼으로 여러 스펙트럼 추가 섹션을 참조하십시오.

올리고뉴클레오타이드의 경우 처리 매개 변수에서 선택한 기준 MS/MS
스펙트럼과 일치하는 공통 생성 이온 피크는 노란색입니다. 일치하지 않
는 생성 이온 피크는 파란색입니다.

표 7-1 잠재적 대사물 테이블 열

열 설명

Report 이 열을 선택하면 최종 보고서에 대사물이 포함됩니다.

Peak ID 대사물의 피크 ID를 표시합니다. ID는 대사물 질량과 머무름 시간을 기반
으로 합니다. 모든 모체 대사물의 경우 Peak ID가 비어 있습니다.

질량과 머무름 시간은 같지만 전하가 다른 피크에는 -#이 할당됩니다. 예
를 들면 M1-1, M1-2, M1-3 등입니다.
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표 7-1 잠재적 대사물 테이블 열 (계속)

열 설명

Name 대사물 이름을 표시합니다.

ADC 결과의 경우 이름 앞에 Parent라는 단어가 추가됩니다. Parent는
소분자 약물(페이로드)과 링커 구성 요소가 결합되었음을 나타냅니다.

올리고뉴클레오타이드 결과의 경우 Parent와 Ion charge라는 단어로
주 구성 요소 이름을 나타냅니다. 예측된 피크 찾기에 의해 식별된 생체 내
변화 및 분열 생성물은 5' 또는 3' (n-#) 표기법을 가집니다. 일반 피크 찾기
결과는 Gain 또는 Loss가 접두사로 표시됩니다.

Formula 대사물의 중성 화학식을 표시합니다.

Assigned 이 열을 선택하면 Interpretation 작업 영역에 정보가 있음을 나타냅니다.
예를 들어 구조 또는 시퀀스가 있거나 Fragments 테이블이 채워질 수 있
습니다.

Neutral Mass 대사물의 중성 질량을 표시합니다.

m/z 대사물에 대한 단일 동위 원소 질량 대 전하비를 표시합니다.

올리고뉴클레오타이드 결과의 경우 단일 동위 원소가 관찰되지 않으면 소
프트웨어에서 해당 위치를 계산하여 m/z 값에 (n) 플래그를 지정합니다.
여기서 n은 단일 동위 원소와 첫 번째 관찰된 피크 사이의 피크 수를 나타
냅니다.

Charge 대사물의 전하를 표시합니다.

Peak Index 대사물에 대해 표시된 XIC 피크 면적의 동위 원소를 반영합니다.

• Blank cell: 단일 동위 원소

• 1: 단일 동위 원소 피크 이후 첫 번째 동위 원소

• 2: 단일 동위 원소 피크 이후 두 번째 동위 원소 등

XIC 피크 면적이 대사물의 단일 동위 원소와 연관된 경우 열이 테이블에
포함되지 않습니다. 예측 대사물 찾기 전략에 의해 식별된 대사물의 경우
대사물에 대한 추정된 가상 기준 피크 인덱스가 표시됩니다. 다른 피크 찾
기 전략에 의해 식별된 대사물의 경우 실험 동위 원소 피크가 표시됩니다.
일반적으로 실험 동위 원소 피크가 기준 피크입니다. 그러나 IDA 데이터
의 경우 실험 동위 원소 피크는 전구체 이온의 인덱스일 수 있습니다.

ppm 대사물의 질량 정확도(ppm)를 표시합니다.

R.T. (min) 대사물의 머무름 시간을 표시합니다.

Peak Area Peak Index 열에 피크 인덱스가 표시된 동위 원소의 XIC 피크 면적을 표
시합니다.

% Area 테이블의 총 대사물 수를 기반으로 XIC의 면적(%)을 표시합니다.

% Score 대사물의 점수(%)를 표시합니다.
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표 7-1 잠재적 대사물 테이블 열 (계속)

열 설명

Analog - Peak
Area

아날로그 피크의 피크 면적을 표시합니다. 아날로그 데이터가 처리된 경
우에만 사용할 수 있습니다.

Analog - %
Area

아날로그 피크의 면적(%)을 표시합니다. 아날로그 데이터가 처리된 경우
에만 사용할 수 있습니다.

Analog - R.T.
(min)

아날로그 피크의 머무름 시간을 표시합니다. 아날로그 데이터가 처리된
경우에만 사용할 수 있습니다.

필터링된 스펙트럼만 표시
참고: 올리고뉴클레오타이드 워크플로에는 이 기능이 적용되지 않습니다.

Processing Parameters 작업 영역의 Generic Parameters 그룹에 있는 MS/MS Parameters 탭
에서 SWATH 획득 데이터 파일을 처리하기 위해 Use advanced MS/MS filter 매개 변수를 선
택한 경우 고급 필터를 사용하여 필터링된 MS/MS 스펙트럼만 표시하려면 이 확인란을 선택
합니다. 배경 감산 스펙트럼을 표시하려면 이 확인란의 선택을 취소합니다.

참고: Use advanced MS/MS filter 매개 변수를 선택했지만 배경 감산 스펙트럼만 MS/MS 스
펙트럼에 표시되는 경우 다음이 원인일 수 있습니다.

• 필터링된 스펙트럼이 비어 있습니다.

• 강도가 약 10배 이상인 동시 용리 피크의 간섭으로 인해 고급 필터의 효과가 없습니다.

• 전구체 피크에서 5개 미만인 데이터 포인트로 인해 고급 필터의 효과가 없습니다.

결과 필터 정보
필터를 적용하여 Potential Metabolites 테이블에 표시되는 결과를 세분화할 수 있습니다.

팁! 필터 아이콘 을 클릭하여 Results Filters 대화 상자를 엽니다.

표 7-2 필터

필터 선택 표시 결과

Metabolites

Top __ metabolites by
peak area

피크 면적(%)을 기준으로 가장 충분한 지정된 수의 피크만 표시
합니다.

Reported metabolites Report 열에서 선택한 대사물만 표시합니다.
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표 7-2 필터 (계속)

필터 선택 표시 결과

Metabolites by adduct 1차 부가물에 의해 검색된 대사물만 표시합니다. 1차 부가물은
Generic Parameters > MS Parameters 탭의 Advanced Ion
Types 테이블에서 가장 먼저 표시되는 부가물로 정의됩니다. 다
음 옵션을 사용할 수 있습니다.

• Primary

• Most intense

Assigned Metabolites

Metabolites with
structures or
sequences assigned

구조(소분자) 또는 시퀀스(펩타이드 및 올리고뉴클레오타이드)가
할당된 대사물, 즉 Potential Metabolites 테이블의 Assigned 열에
확인 표시가 있는 대사물만 표시합니다.

Retention Time Window

Retention time from __
to __

지정된 범위 내의 피크만 표시합니다.

Peak Area

Peak area from __ % to
__ %

% Area 값이 지정된 백분율 범위 내에 있는 피크만 표시합니다.

Analog peak area from
__ % to __ %

% Analog Area 값이 지정된 백분율 범위 내에 있는 피크만 표시
합니다. 처리를 위한 아날로그 파일이 제공되지 않은 경우 이 필
터는 효과가 없습니다.

Charge

Charge from __ to __ 지정된 범위 내의 전하 값을 가진 대사물만 표시합니다.

Score

Overall score above __
%

총 점수가 지정된 값을 초과하는 피크만 표시합니다. 자세한 정보
는 Confirmation Scoring 탭 섹션을 참조하십시오.

올리고뉴클레오타이드 워크플로의 경우 동위 원소 엔벨로프를 확
인 점수의 단독 매개 변수로 사용하는 것이 좋습니다. 또한 이론
적 동위 원소 겹침 점수가 낮은 대사물을 제거하려면 사용자가
Overall Score를 20%가 넘도록 설정하는 것이 좋습니다.

Mass Accuracy

Accuracy within __
ppm

지정된 범위 내의 질량 정확도를 가진 피크만 표시합니다.

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값만 표시합니다.

Product Ions and Neutral Losses
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표 7-2 필터 (계속)

필터 선택 표시 결과

MS/MS similarity above
__

MS/MS 유사성 점수가 지정된 값을 초과하는 피크만 표시합니다.
기준 스펙트럼이 제공되지 않은 경우 이 필터는 효과가 없습니다.

Minimum number of
common product ions
__

모체 화합물과 공통으로 지정된 수 이상의 생성 이온을 갖는 피크
만 표시합니다. 기준 스펙트럼이 제공되지 않은 경우 이 필터는
효과가 없습니다.

Minimum number of
common neutral losses
__

모체 화합물과 공통으로 지정된 수 이상의 중립 손실을 갖는 피크
만 표시합니다. 기준 스펙트럼이 제공되지 않은 경우 이 필터는
효과가 없습니다.

참고: 테이블에서 행을 삭제하고 추가하면 각 대사물의 % Area 및 % Analog Area가 자동으
로 업데이트되어 피크 면적, 아날로그 피크 면적 및 피크 면적별 상위 대사물 필터가 나머지 행
에 적용되는 방식에 영향을 미칩니다.

결과 편집
Potential Metabolites 테이블의 항목을 편집하거나 삭제하여 결과를 더 세분화할 수 있습니다.

사용자는 다음 작업을 수행할 수 있습니다.

• 행 삭제

• 잠재적 대사물의 이름 및 수식 편집

• 피크 ID 할당

행 삭제
1. Workspace 패널에서 Results를 클릭합니다.

Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 행을 선택합니다.

팁! 여러 행을 선택하려면 Ctrl 키 또는 Shift 키를 클릭하고 누르십시오.

6. Edit > Delete Selected Rows.를 클릭합니다.

팁! 가장 최근 삭제를 되돌리려면 Edit > Undo Delete를 클릭합니다.

7. Save를 클릭합니다.
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잠재적 대사물의 이름 및 수식 편집
자세한 정보는 소프트웨어에서 대사물 이름이 지정되는 방법 섹션을 참조하십시오.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 행을 마우스 오른쪽 버튼으로 클릭하고 Edit Name and
Formula를 선택합니다.
Edit Name and Formula 대화 상자가 열립니다.

6. 다음 중 하나를 수행하여 Name을 변경합니다.

• 해당하는 경우 제공된 옵션 목록에서 이름을 선택합니다.

• 새 이름을 입력합니다.

7. 해당하는 경우 제공된 옵션 목록에서 부가물을 선택합니다.

참고: 부가물이 변경되면 대사물의 Mass accuracy가 자동으로 업데이트됩니다.

8. 다음 중 하나를 수행하여 Formula를 변경합니다.

• 수식을 결정하는 데 사용할 수 있는 정보가 충분하지 않으면 Unknown을 선택합니다.

• 잠재적 대사물에 수식을 수동으로 추가하려면 Use를 선택한 후 제공된 필드에 수식을
입력합니다.

• 소프트웨어에서 잠재적 수식이 예측된 경우 Automatic을 선택하고 목록에서 항목을
선택합니다.

참고: 소프트웨어에서 잠재적 수식이 예측되지 않은 경우 Automatic을 선택할 수 없습
니다.

참고: 새 수식이 추가되면 Mass accuracy 및 RDB 필드의 값이 자동으로 업데이트됩니
다.

9. 선택한 행의 대사물을 모체 화합물로 식별하려면 Assign as Parent를 클릭합니다.

10. OK를 클릭합니다.

11. Save를 클릭합니다.

참고: 펩타이드의 경우 이름 순서는 제안된 이름의 질량 정확도와 필요한 조작 수(예: 끊어
진 결합 수)를 기반으로 합니다. 즉, 질량 정확도가 높고 조작이 적은 펩타이드에 대해 제
안된 이름이 목록 맨 위에 표시됩니다.
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피크별 그룹화
Group by Peaks 버튼을 사용하여 분자의 다중 전하 상태와 같이 중성 질량이 동일한 피크를
그룹화하면 식별된 모든 전하 상태에 대해 Peak Area, %Area 등이 집계된 식별된 분자의 요
약 테이블이 표시됩니다. 피크는 중성 질량 및 머무름 시간 허용 오차를 기준으로 그룹화됩니
다.

참고: 그룹 기능은 올리고뉴클레오타이드 워크플로에만 적용할 수 있습니다.

피크 ID 할당
1. Workspace 패널에서 Results를 클릭합니다.

Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 현재 피크 ID를 검토합니다.

6. 행 삭제 및 대사물 이름 바꾸기를 포함하여 테이블을 변경합니다.

7. Assign ID를 클릭합니다.

동일한 중성 화학식 및 머무름 시간과 관련된 행이 함께 그룹화됩니다. 한 행에 기본 피크
ID가 할당되고 그룹의 나머지 행에 기본 피크 ID보다 한 수준 낮은 순차적 ID가 할당됩니
다. 예를 들어 할당된 기본 피크 ID가 M2이면 나머지 각 행에는 M2로 시작하는 순차적 ID
가 할당됩니다. 예를 들면 M2-1, M2-2 등입니다.

1차 이외의 부가물이 있는 피크에는 기본이 아닌 피크 ID가 할당됩니다. 1차 이외의 부가
물은 Advanced Ion Types 테이블에서 선택되었지만 Ion type 목록에 표시되지 않은 부가
물입니다. 기본 피크 ID만 Ion type 목록에 표시됩니다.

MS/MS 스펙트럼
대사물에 대해 MS/MS 스펙트럼을 추가, 제거 또는 대체할 수 있습니다. MS/MS 스펙트럼은
Explorer 작업 영역에서 단일 중심 MS/MS 스펙트럼을 복사한 후 Results 작업 영역에 붙여 넣
어 수동으로 추가하거나, Results 작업 영역의 Add MS/MS 버튼을 사용하여 자동으로 추가할
수 있습니다.

붙여넣기로 스펙트럼 추가

참고: 이것은 베타 기능입니다.

참고: 이 기능은 TOF-MS/MS 및 IDA 데이터의 올리고뉴클레오타이드 워크플로에서만 사용할
수 있습니다. IDA Explorer에서 MS/MS 스펙트럼 붙여넣기는 현재 지원되지 않습니다. 데이터
파일을 Molecule Profiler에 붙여 넣으려면 먼저 Explorer 작업 영역에서 파일을 표준 TIC로 열
고 중심에 배치해야 합니다.
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참고: 결과 파일이 저장될 때까지 결과 파일의 기존 MS/MS 스펙트럼을 덮어쓰지 않습니다. 결
과 파일에 저장된 대로 선택한 대사물의 원래 스펙트럼으로 되돌리려면 결과 파일을 저장하기
전에 Remove MS/MS를 클릭하십시오.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택한 후 OK를 클릭합니다.
Results 보기가 표시됩니다.

4. Potential Metabolites 테이블에서 행을 선택합니다.

5. SCIEX OS 홈 페이지에서 Explorer 작업 영역을 엽니다.

6. File > Open Sample을 선택합니다.
Select Sample 대화 상자가 열립니다.

7. 샘플이 포함된 데이터 파일을 찾아 +를 클릭하여 확장하고 열려는 샘플을 선택한 후 OK
를 클릭합니다.
데이터 파일은 TOF-MS/MS 데이터나 IDA 데이터가 포함된 wiff 또는 wiff2 데이터 파일이
어야 합니다.

8. 데이터 파일에 IDA 데이터가 포함된 경우 Open IDA Sample 대화 상자에서 As a
standard TIC를 선택한 후 OK를 클릭합니다.

9. MS 및 MS/MS 스펙트럼을 엽니다.

팁! 스펙트럼을 열려면 선택 창을 설정하거나 TIC 창에서 머무름 시간을 두 번 클릭합니
다.

10. MS/MS 스펙트럼의 헤더를 마우스 오른쪽 버튼으로 클릭한 후 Remove All Traces
Except Active를 선택합니다.

11. Process > Centroid Spectrum을 선택합니다.
Centroid 대화 상자가 열립니다.

12. Intensity, Height, Area 또는 Intensity sum above 50%에서 중심화할지 선택합니다.

13. Edit > Copy를 선택합니다.

14. Molecule Profiler 작업 영역으로 이동합니다.

15. Paste MS/MS를 클릭합니다.
MS/MS 스펙트럼이 추가됩니다.

16. Save를 클릭합니다.

Add MS/MS 버튼으로 여러 스펙트럼 추가

참고: 결과 파일이 저장될 때까지 결과 파일의 기존 MS/MS 스펙트럼을 덮어쓰지 않습니다. 결
과 파일에 저장된 대로 선택한 대사물의 원래 스펙트럼으로 되돌리려면 결과 파일을 저장하기
전에 Remove MS/MS를 클릭하십시오.

결과 보기
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1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택한 후 OK를 클릭합니다.
Results 보기가 표시됩니다.

4. Potential Metabolites 테이블에서 행을 선택합니다.

5. Add MS/MS를 클릭합니다.
Add MS/MS 대화 상자가 열립니다.

6. Select MS/MS를 클릭합니다.
Select Data 대화 상자가 열립니다.

7. 적절한 Source 폴더를 찾아 선택합니다.

8. OK를 클릭합니다.

9. Select Data 대화 상자의 Available 창에서 MS/MS 스펙트럼이 포함된 wiff 파일 및 주입을

선택한 후 아이콘( )을 클릭하여 파일을 Selected 창으로 이동합니다.

팁! 최대 10개의 주입을 선택할 수 있습니다.

10. 필요한 모든 파일이 Add MS/MS 대화 상자에 표시되면 OK를 클릭합니다.
소프트웨어가 각 대사물에 대해 일치하는 스펙트럼을 찾으려고 합니다.

11. 각 대사물의 점수를 검토합니다.
MS/MS 스펙트럼이 변경된 경우 % Score가 다시 계산될 수 있습니다.

12. Save를 클릭합니다.
단일 MS/MS 스펙트럼 내에서 특정 단편 유형을 편집하려면 올리고뉴클레오타이드 워크
플로 섹션을 참조하십시오.

스펙트럼 제거
1. Workspace 패널에서 Results를 클릭합니다.

Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 행을 선택합니다.

6. MS/MS 창에서 Remove MS/MS를 클릭합니다.

참고: 잠재적 대사물에 대한 IDA 스펙트럼이 있는 경우 MS/MS 창에 표시됩니다.

7. Save를 클릭합니다.
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MS/MS 스펙트럼 파일 제거
1. Workspace 패널에서 Results를 클릭합니다.

Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Add MS/MS를 클릭합니다.

6. MS/MS Samples 필드에서 적절한 wiff 파일을 선택합니다.

7. Remove를 클릭한 후 OK를 클릭합니다.
wiff 파일의 모든 전용 MS/MS 스펙트럼이 결과에서 제거됩니다.

8. Save를 클릭합니다.

결과 보기
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MS/MS 데이터 특성화 8
관심 샘플에서 피크를 식별한 후 단편 해석을 사용하면 각 잠재적 대사물의 구조를 식별하는
데 도움이 됩니다.

Interpretation 보기 정보
Results 작업 영역의 Interpretation 보기에는 결과 파일의 각 대사물에 대한 잠재적 구조를 설
명하는 데 필요한 데이터와 도구가 표시됩니다.

Interpretation 보기

소분자 Interpretation
보기

펩타이드
Interpretation 보기

올리고뉴클레오타이
드 Interpretation 보기

ADC Interpretation 보
기

소분자 Interpretation 보기
그림 8-1 소분자 Interpretation 보기

항목 인터페이스 구성
요소

설명

1 MS/MS 창 선택한 대사물의 MS/MS 스펙트럼을 표시합니다. 가능
한 경우 기준 MS/MS 스펙트럼의 미러 이미지도 표시
됩니다. 별표는 할당을 위해 선택된 피크를 식별합니
다. 이 스펙트럼의 소스는 샘플 IDA wiff 파일, 샘플
SWATH 획득 wiff 파일 또는 결과 파일에 추가된 전용
MS/MS wiff 파일입니다. 버튼에 의해 제공되는 기능에
대한 설명은 표 8-1에서 확인하십시오.
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항목 인터페이스 구성
요소

설명

2 Fragments 테이
블

m/z 값, 제안된 구조 수 및 점수를 포함하여 선택한 대
사물에 대해 할당된 모든 단편을 나열합니다. 특정 m/z
값에 다른 수식이 할당될 수 있는 경우 각 수식에 대한
행이 테이블에 포함됩니다. 기본적으로 수식과 m/z 값
의 각 조합에 대해 최고 점수를 포함하는 행의 Use 확
인란이 선택되어 있습니다.

팁! Use 확인란이 선택되지 않은 행을 숨길 수 있습니
다. 모든 행을 표시하려면 테이블을 마우스 오른쪽 버
튼으로 클릭한 후 Show Hidden Rows를 클릭합니다.

아이콘에 의해 제공되는 기능에 대한 설명은 표 8-3에
서 확인하십시오.

2a Structure Details
테이블

끊어진 결합 수, 델타 H 값 및 점수를 포함하여 선택한
단편을 생성할 수 있는 구조 부분을 나열합니다. 이 테
이블에서 행을 선택하면 구조의 관련 부분이 강조 표시
됩니다.

기본적으로 점수가 가장 높은 단편 구조의 Use 확인란
이 선택되어 있습니다.

2b Contained
Neutral Losses
테이블

두 단편 질량의 중립 손실을 포함합니다.

3 Structure charts
창

다음과 같은 두 개의 탭이 포함되어 있습니다.

• Parent Structure 탭은 선택한 대사물의 모체 구조를
포함합니다.

• Structure Candidates 탭은 제안된 구조의 전체 목록
을 보여주는 테이블이 포함된 대화식 히스토그램입
니다. 구조 목록은 점수에 따라 내림차순으로 정렬
됩니다. 이 테이블에서 행을 선택하면 Structure 창
에 표시된 구조가 변경됩니다(항목 2). 특정 구조를
결과에 포함하려면 해당 구조에 대한 Apply to
Results 확인란을 선택합니다. 자세한 정보는
Structure Candidates 탭 정보 섹션을 참조하십시오.

4 Structure 창 사용자가 잠재적 대사물에 대한 후보 구조를 로드할 수
있으며, 구조를 편집할 수 있도록 기본 그리기 도구를
제공합니다. 버튼에 의해 제공되는 기능에 대한 설명은
표 8-2에서 확인하십시오.
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표 8-1 MS/MS 창 버튼

버튼 설명

Deisotope MS/MS 창에서 모든 동위 원소를 숨깁니다. 다시 클릭하면 동위 원소
가 표시됩니다.

Prepare 사용자가 선택한 대사물을 해석하는 데 필요한 세부 정보(수식, 활성
피크, MS/MS 스펙트럼 재교정)를 편집할 수 있는 Interpret Data 대화
상자를 엽니다.

Options 사용자가 MS/MS 단편을 할당할 수 있는 Options 대화 상자를 엽니
다. 자세한 정보는 옵션 설정 섹션의 표 8-15에서 확인하십시오.

Generate 선택한 대사물에 대해 자동으로 생성된 잠재적 후보로 Structure
Candidate 탭을 채웁니다. 자세한 정보는 Structure Candidates 탭 정
보 섹션을 참조하십시오.

Apply 해석 변경 내용을 선택한 피크에 적용합니다.

Remove 선택한 피크에서 할당된 단편 및 대사물 구조를 제거합니다.

표 8-2 Structure 창 버튼

버튼 설명

Load • Load Parent: 선택한 대사물의 모체 구조를 엽니다.

• Load Structure: 선택한 피크의 구조 파일을 엽니다.

Delete Structure 창에서 표시된 구조를 제거합니다.

Save As 사용자가 표시된 구조를 다른 파일 이름으로 저장할 수 있습니다.

Assign 잠재적 구조에 대한 단편과 중립 손실을 계산한 후 MS/MS 스펙트럼
에 이온을 할당합니다.

표 8-3 Fragments 테이블 아이콘

아이콘 설명

선택한 단편의 레이블을 추가합니다.

MS/MS 스펙트럼에서 모든 레이블을 삭제합니다.

Interpretation Filters 대화 상자를 엽니다. 자세한 정보는 소분자에 대
한 해석 필터 정보 섹션을 참조하십시오.
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펩타이드 Interpretation 보기
그림 8-2 펩타이드 Interpretation 보기

항목 인터페이스 구성
요소

설명

1 MS/MS 창 선택한 대사물의 MS/MS 스펙트럼을 표시합니다. 가능
한 경우 기준 MS/MS 스펙트럼의 미러 이미지도 표시
됩니다. 이 스펙트럼의 소스는 샘플 IDA wiff 파일, 샘플
SWATH 획득 wiff 파일 또는 결과 파일에 추가된 전용
MS/MS wiff 파일입니다. 버튼에 의해 제공되는 기능에
대한 설명은 표 8-4에서 확인하십시오.

2 Sequence 창 사용자가 시퀀스를 입력할 수 있습니다. 버튼에 의해
제공되는 기능에 대한 설명은 표 8-5에서 확인하십시
오.

3 Fragments 테이
블

선택한 잠재적 대사물에 대해 제안된 수식 목록을 포함
합니다. 목록에는 m/z 값, 시퀀스, 단편 이온 유형(예: y
또는 b), 전하, 오차 및 강도가 포함됩니다. 아이콘에 의
해 제공되는 기능에 대한 설명은 표 8-6에서 확인하십
시오.

MS/MS 데이터 특성화
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항목 인터페이스 구성
요소

설명

4 Sequence charts
창

다음과 같은 두 개의 탭이 포함되어 있습니다.

• Parent Sequence 탭은 모체 약물의 시퀀스를 포함
합니다.

• Sequence Candidates 탭은 소프트웨어에서 제안하
는 시퀀스 목록을 보여주는 테이블이 포함된 대화식
히스토그램입니다. 할당된 백분율 피크 면적을 기반
으로 하는 점수가 제안된 각 시퀀스에 할당됩니다.
특정 시퀀스를 결과에 적용하려면 해당 시퀀스에 대
한 Apply to Results 확인란을 선택합니다. 적용된
시퀀스는 결과 파일을 닫았다가 다시 열면 기본 시
퀀스로 표시됩니다. 자세한 정보는 Sequence
Candidates 탭 정보 섹션을 참조하십시오.

표 8-4 MS/MS 창 버튼

버튼 설명

Deisotope MS/MS 스펙트럼에서 모든 동위 원소를 제거합니다.

Options Options 대화 상자를 엽니다. 자세한 정보는 옵션 설정 섹션의 표
8-16에서 확인하십시오.

Generate 선택한 대사물에 대해 자동으로 생성된 잠재적 후보로 Structure
Candidate 탭을 채웁니다. 자세한 정보는 Structure Candidates 탭 정
보 섹션을 참조하십시오.

Apply 해석 변경 내용을 선택한 피크에 적용합니다.

Remove 선택한 피크에서 할당된 단편 및 대사물 구조를 제거합니다.

표 8-5 Sequence 창 버튼

버튼 설명

Enter Sequence 사용자가 Sequence 창에 새 시퀀스를 입력할 수 있습니다. 자세한 정
보는 펩타이드 시퀀스 명명 규칙 섹션을 참조하십시오.

Load Parent 선택한 대사물의 모체 시퀀스를 엽니다.

Delete Sequence 창에서 표시된 시퀀스를 제거합니다.

Assign 잠재적 구조에 대한 단편과 중립 손실을 계산한 후 MS/MS 스펙트럼
에 이온을 할당합니다.
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표 8-6 Fragments 테이블 아이콘

아이콘 설명

모든 피크의 레이블을 추가합니다.

선택한 단편의 레이블을 추가합니다.

MS/MS 스펙트럼에서 모든 레이블을 삭제합니다.

Interpretation Filters 대화 상자를 엽니다. 자세한 정보는 펩타이드에
대한 해석 필터 정보 섹션을 참조하십시오.

올리고뉴클레오타이드 Interpretation 보기
그림 8-3 올리고뉴클레오타이드 Interpretation 보기

항목 인터페이스 구성
요소

설명

1 MS/MS 창 선택한 대사물의 MS/MS 스펙트럼을 표시합니다. 가능
한 경우 기준 MS/MS 스펙트럼의 미러 이미지도 표시
됩니다. 이 스펙트럼의 소스는 샘플 IDA wiff 파일, 샘플
SWATH 획득 wiff 파일 또는 결과 파일에 추가된 전용
MS/MS wiff 파일입니다. 버튼에 의해 제공되는 기능에
대한 설명은 표 8-7에서 확인하십시오.

2 Fragments 테이
블

선택한 잠재적 대사물에 대해 제안된 수식 목록을 포함
합니다. 목록에는 m/z 값, 시퀀스, 단편 이온 유형(예: y
또는 b), 전하, 오차 및 강도가 포함됩니다. 아이콘에 의
해 제공되는 기능에 대한 설명은 표 8-6에서 확인하십
시오.

3 Sequence charts
창

모체 약물의 시퀀스를 포함합니다.
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항목 인터페이스 구성
요소

설명

4 Sequence 창 사용자가 시퀀스를 입력할 수 있습니다. 버튼에 의해
제공되는 기능에 대한 설명은 표 8-5에서 확인하십시
오.

표 8-7 MS/MS 창 버튼

버튼 설명

Deisotope MS/MS 스펙트럼에서 모든 동위 원소를 제거합니다.

Options Options 대화 상자를 엽니다. 자세한 정보는 옵션 설정 섹션의 표
8-18에서 확인하십시오.

Apply 해석 변경 내용을 선택한 피크에 적용합니다.

Remove 선택한 피크에서 할당된 단편 및 대사물 구조를 제거합니다.

표 8-8 Sequence 창 버튼

버튼 설명

Load Parent 선택한 대사물의 모체 시퀀스를 엽니다.

Delete Sequence 창에서 표시된 시퀀스를 제거합니다.

Assign 잠재적 구조에 대한 단편과 중립 손실을 계산한 후 MS/MS 스펙트럼
에 이온을 할당합니다.

표 8-9 Fragments 테이블 아이콘

아이콘 설명

모든 피크의 레이블을 추가합니다.

선택한 단편의 레이블을 추가합니다.

MS/MS 스펙트럼에서 모든 레이블을 삭제합니다.

Interpretation Filters 대화 상자를 엽니다. 자세한 정보는 올리고뉴클
레오타이드에 대한 해석 필터 정보 섹션을 참조하십시오.
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ADC Interpretation 보기
그림 8-4 ADC Interpretation 보기

항목 인터페이스 구성
요소

설명

1 MS/MS 창 선택한 대사물의 MS/MS 스펙트럼을 표시합니다. 가능
한 경우 기준 MS/MS 스펙트럼의 미러 이미지도 표시
됩니다. 이 스펙트럼의 소스는 샘플 IDA wiff 파일, 샘플
SWATH 획득 wiff 파일 또는 결과 파일에 추가된 전용
MS/MS wiff 파일입니다. 버튼에 의해 제공되는 기능에
대한 설명은 표 8-10에서 확인하십시오.

2 Fragments 테이
블

다음 탭이 포함되어 있습니다.

• Structure 탭: m/z 값, 제안된 구조 수 및 점수를 포함
하여 선택한 대사물에 대해 할당된 모든 단편을 나
열합니다. 특정 m/z 값에 다른 수식이 할당될 수 있
는 경우 각 수식에 대한 행이 테이블에 포함됩니다.
기본적으로 수식과 m/z 값의 각 조합에 대해 최고
점수를 포함하는 행의 Use 확인란이 선택되어 있습
니다.

• Sequence 탭: 선택한 잠재적 대사물에 대해 제안된
모든 수식을 나열합니다. 목록에는 m/z 값, 시퀀스,
단편 이온 유형(예: y 또는 b), 전하, 오차 및 강도가
포함됩니다.

아이콘에 의해 제공되는 기능에 대한 설명은 표 8-13에
서 확인하십시오.
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항목 인터페이스 구성
요소

설명

3 Sequence 창 페이로드 또는 링커 성분(moiety)에 결합되는 시퀀스
부분을 표시합니다. 페이로드 또는 링커 성분에 결합되
는 잔기를 나타내려면 잔기를 선택하고 마우스 오른쪽
버튼을 클릭한 후 Mark Residue to Conjugate를 선택
합니다.

4 Structure 창 사용자가 잠재적 대사물에 대한 후보 구조를 로드할 수
있으며, 구조를 편집할 수 있도록 기본 그리기 도구를
제공합니다. 버튼에 의해 제공되는 기능에 대한 설명은
표 8-11에서 확인하십시오.

표 8-10 MS/MS 창 버튼

버튼 설명

Deisotope MS/MS 스펙트럼에서 모든 동위 원소를 제거합니다.

Options Options 대화 상자를 엽니다. 자세한 정보는 옵션 설정 섹션의 표
8-21에서 확인하십시오.

Apply 해석 변경 내용을 선택한 피크에 적용합니다.

Remove 선택한 피크에서 할당된 단편 및 대사물 구조를 제거합니다.

표 8-11 Structure 창 버튼

버튼 설명

Load • Load Parent Structure: 선택한 대사물의 모체 구조를 엽니다.

• Load Sequence: 선택한 대사물의 시퀀스를 엽니다.

Delete Structure 창의 로드된 구조, Sequence 창의 로드된 시퀀스 정보,
Fragments 테이블의 할당된 구조 및 시퀀스 정보를 각각 제거합니다.

Save Structure As 사용자가 다른 파일 이름으로 구조를 저장할 수 있습니다.

Assign 잠재적 구조에 대한 단편과 중립 손실을 계산한 후 MS/MS 스펙트럼
에 이온을 할당합니다.

표 8-12 Fragments 테이블 버튼

버튼 설명

Structure m/z 값, 제안된 구조 수 및 점수를 포함하여 선택한 대사물에 대해 할
당된 모든 단편을 나열합니다. 특정 m/z 값에 다른 수식이 할당될 수
있는 경우 각 수식에 대한 행이 테이블에 포함됩니다. 기본적으로 수
식과 m/z 값의 각 조합에 대해 최고 점수를 포함하는 행의 Use 확인
란이 선택되어 있습니다.
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표 8-12 Fragments 테이블 버튼 (계속)

버튼 설명

Sequence 선택한 잠재적 대사물에 대해 제안된 모든 수식을 나열합니다. 목록
에는 m/z 값, 시퀀스, 단편 이온 유형(예: y 또는 b), 전하, 오차 및 강
도가 포함됩니다.

표 8-13 Fragments 테이블 아이콘

아이콘 설명

모든 피크의 레이블을 추가합니다.

선택한 단편의 레이블을 추가합니다.

MS/MS 스펙트럼에서 모든 레이블을 삭제합니다.

Interpretation Filters 대화 상자를 엽니다. 자세한 정보는 ADC에 대한
해석 필터 정보 섹션을 참조하십시오.

수동 해석
수동 해석

소분자 워크플로 펩타이드 워크플로 올리고뉴클레오타이
드 워크플로

ADC 워크플로

소분자 워크플로
구조 로드

구조 편집

구조 할당 준비 잠재적 대사물의 이름 및 수식 편집

MS/MS 스펙트럼 재교정

MS/MS 스펙트럼의 동위 원소 제거

활성 피크 선택

할당할 단편 피크 선택

옵션 설정

단편 구조 할당 제안된 수식 및 구조 할당

각 단편에 대한 수식 구조 선택

Markush 구조 연결
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피크 레이블 정보 MS/MS 스펙트럼에 피크 레이블 추가

소분자에 대한 해석 필터 정보

구조 로드
대사물의 구조 설명을 시작하기 전에 소프트웨어가 잠재적 단편 구조를 결정하는 데 사용할
수 있도록 구조 파일을 로드합니다.

참고: 구조가 로드되지 않아도 잠재적 수식을 단편에 할당할 수 있습니다.

1. Workspace 패널에서 Results를 클릭합니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 결과 파일을 찾아 선택합니다.

4. OK를 클릭합니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. Potential Metabolites 테이블에서 행을 선택합니다.

7. Structure 창에서 Load를 클릭한 후 Load Structure 옵션을 선택합니다.
Open Structure File 대화 상자가 열립니다.

8. 구조 파일을 찾아 선택합니다.

참고: 소프트웨어는 sdf 또는 mol 형식의 구조 파일을 허용합니다.

9. 사소한 변경이 필요한 경우 구조를 편집합니다. 자세한 정보는 구조 편집 섹션을 참조하
십시오.

구조 편집
특정 대사물에 대한 구조를 로드한 후 편집 도구를 사용하여 사소한 변경을 수행할 수 있습니
다.

팁! 편집 도구를 사용하여 대사 변환을 위한 다른 부착 위치와 같이 구조를 약간 변경합니다.
편집 도구는 새 구조를 생성하거나 기존 구조를 크게 변경하는 데 사용하면 안 됩니다.

표 8-14 구조 편집

수행할 작업 방법

구조에 원자 추가 팔레트의 특정 기호를 새 위치로 끕니다. 추가된 원자
는 가장 가까운 기존 원자와 단일 결합을 형성합니다.
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표 8-14 구조 편집 (계속)

수행할 작업 방법

팔레트에 새 원자 생성 빈 사각형을 클릭하고 Specify Symbol 대화 상자에 기
호를 입력한 후 OK를 클릭합니다.

팁! 다른 원자를 생성하려면 추가된 사각형을 클릭하고
새 기호를 입력하십시오.

구조의 일부 강조 표시 필요한 원자와 결합 주위를 원 모양으로 끕니다.

하나 이상의 원자 이동 구조의 강조 표시된 부분을 새 위치로 끕니다. 해당 부
분이 다른 한 원자에 결합되어 있으면 결합이 새 위치
로 이동합니다. 해당 부분이 둘 이상의 원자에 결합되
어 있으면 부분은 이동하지만 기존 결합은 그대로 유지
됩니다.

기존 구조에 구조 삽입 구조를 마우스 오른쪽 버튼으로 클릭하고 다음 중 하나
를 클릭합니다.

• Insert .mol File 다른 구조를 추가합니다.

• Insert Conjugate 특정 포합 구조를 추가합니다.

하나 이상의 원자 삭제 구조의 강조 표시된 부분을 마우스 오른쪽 버튼으로 클
릭한 후 Remove Selected Atoms를 클릭합니다.

결합 생성 결합되지 않은 두 원자를 선택한 후 선택 항목을 마우
스 오른쪽 버튼으로 클릭하고 New Bond를 클릭한 후
결합 유형을 선택합니다.

결합 편집 결합을 마우스 오른쪽 버튼으로 클릭하고 Set Bond
Type을 클릭한 후 결합 유형을 선택합니다.

결합 삭제 결합을 마우스 오른쪽 버튼으로 클릭한 후 Remove
Bond를 클릭합니다.

기존 원자의 전하 상태 변경 원자를 마우스 오른쪽 버튼으로 클릭하고 Atom
Charge State를 클릭한 후 상태를 선택합니다.

팁! 편집한 구조를 별도의 파일로 저장하려면 Save As를 클릭합니다.

팁! 구조는 mol 또는 sdf 파일로 저장할 수 있습니다. Save As 대화 상자에 적절한 확장자를 입
력합니다.

구조 할당 준비
다음은 사용자가 구조 할당을 준비할 때 완료할 수 있는 네 가지 작업입니다.

• 잠재적 대사물의 이름 또는 수식 편집

• MS/MS 스펙트럼 재교정
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• MS/MS 스펙트럼에서 특정 피크 선택

• 해석할 단편 피크 선택

참고: 이러한 작업이 필요하지 않은 경우 사용자는 이 절차를 무시하고 즉시 단편 구조를 할당
할 수 있습니다.

잠재적 대사물의 이름 및 수식 편집

자세한 정보는 소프트웨어에서 대사물 이름이 지정되는 방법 섹션을 참조하십시오.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Potential Metabolites 테이블에서 행을 마우스 오른쪽 버튼으로 클릭하고 Edit Name and
Formula를 선택합니다.
Edit Name and Formula 대화 상자가 열립니다.

6. 다음 중 하나를 수행하여 Name을 변경합니다.

• 해당하는 경우 제공된 옵션 목록에서 이름을 선택합니다.

• 새 이름을 입력합니다.

7. 해당하는 경우 제공된 옵션 목록에서 부가물을 선택합니다.

참고: 부가물이 변경되면 대사물의 Mass accuracy가 자동으로 업데이트됩니다.

8. 다음 중 하나를 수행하여 Formula를 변경합니다.

• 수식을 결정하는 데 사용할 수 있는 정보가 충분하지 않으면 Unknown을 선택합니다.

• 잠재적 대사물에 수식을 수동으로 추가하려면 Use를 선택한 후 제공된 필드에 수식을
입력합니다.

• 소프트웨어에서 잠재적 수식이 예측된 경우 Automatic을 선택하고 목록에서 항목을
선택합니다.

참고: 소프트웨어에서 잠재적 수식이 예측되지 않은 경우 Automatic을 선택할 수 없습
니다.

참고: 새 수식이 추가되면 Mass accuracy 및 RDB 필드의 값이 자동으로 업데이트됩니
다.

9. 선택한 행의 대사물을 모체 화합물로 식별하려면 Assign as Parent를 클릭합니다.

10. OK를 클릭합니다.

11. Save를 클릭합니다.
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참고: 펩타이드의 경우 이름 순서는 제안된 이름의 질량 정확도와 필요한 조작 수(예: 끊어
진 결합 수)를 기반으로 합니다. 즉, 질량 정확도가 높고 조작이 적은 펩타이드에 대해 제
안된 이름이 목록 맨 위에 표시됩니다.

MS/MS 스펙트럼 재교정

1. Interpretation 보기에서 Prepare를 클릭합니다.
Interpret Data 대화 상자가 열립니다.

2. MS/MS Details 탭을 클릭합니다.

3. 교정 포인트로 사용할 단편을 선택합니다.

4. 선택한 단편을 마우스 오른쪽 버튼으로 클릭한 후 Set calibration points를 클릭합니다.
단편 원의 색이 파란색으로 바뀝니다.

5. 3 및 4단계를 반복하여 추가 교정 포인트를 선택합니다.

6. 설정된 교정 포인트를 제거하려면 해당 교정 포인트를 선택하고 마우스 오른쪽 버튼을 클
릭한 후 Clear calibration points를 선택합니다.
단편 원의 색이 녹색으로 돌아갑니다.

7. 단편의 세부 정보를 보려면 교정 포인트를 선택하고 마우스 오른쪽 버튼을 클릭한 후
Composition details를 선택합니다.
Fragment 대화 상자가 열리고 m/z 값, 질량 오차(ppm 및 mDa 단위), 제안된 수식이 짝수
전자를 가리키는지 여부 및 제안된 수식의 RDB 값(링 및 이중 결합)이 표시됩니다.

8. 교정 포인트를 단편의 구성 또는 잠재적 교정 포인트로 선택하려면 교정 포인트를 선택하
고 마우스 오른쪽 버튼을 클릭한 후 Select composition을 선택합니다.

9. MS/MS 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 후 Recalibrate를 클릭합니다.

참고: 재교정된 스펙트럼을 취소하려면 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 후
Revert Calibration을 클릭합니다.

MS/MS 스펙트럼의 동위 원소 제거

Interpretation 보기에서 Deisotope를 클릭하면 모든 동위 원소가 MS/MS 스펙트럼에서 제거됩
니다. 이렇게 하면 단일 동위 원소 피크의 빠른 보기가 제공되므로 SWATH 획득 데이터를 볼
때 유용합니다.

참고: 이 옵션의 선택 여부에 관계없이 단일 동위 원소만 Results Table에 표시됩니다.

활성 피크 선택

활성 피크는 MS/MS 스펙트럼에서 단편 해석에 사용할 수 있는 유일한 피크입니다.

1. Interpretation 보기에서 Prepare를 클릭합니다.
Interpret Data 대화 상자가 열립니다.

2. MS/MS 스펙트럼을 검토합니다.
파란색 화살표는 현재 활성 피크를 나타냅니다.

3. 피크를 선택하려면 사각형을 피크 쪽으로 끕니다.

4. 선택한 피크를 두 번 클릭합니다.
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선택한 피크 아래에 파란색 화살표가 표시됩니다.

5. 단일 피크를 제거하려면 파란색 화살표를 Interpret Data 대화 상자의 테두리 아래로 끕니
다.
선택한 피크 아래에서 파란색 화살표가 제거됩니다.

팁! 모든 활성 피크를 지우려면 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 후 Clear All
Markers를 클릭합니다.

6. 모든 활성 피크를 선택한 후 Find를 클릭합니다.

7. MS 및 MS/MS 스펙트럼과 가장 일치하는 수식이 있는 행을 선택합니다.

8. Select를 클릭합니다.

할당할 단편 피크 선택

여러 피크가 활성으로 식별될 수 있지만 사용자는 강도가 가장 높은 피크만 사용하도록 선택
할 수 있습니다.

1. Interpretation 보기에서 Options를 클릭합니다.
Options 대화 상자가 열립니다.

2. Number of fragment peaks selected for assignment 필드에 적절한 수를 입력합니다.

3. OK를 클릭합니다.
MS/MS 스펙트럼의 별표는 할당을 위해 선택된 피크를 식별합니다.

옵션 설정
1. Interpretation 보기에서 Options를 클릭합니다.

Options 대화 상자가 열립니다.

2. 표 8-15에 설명된 단편화 및 레이블 지정 매개 변수를 수정합니다.

표 8-15 Options 대화 상자

옵션 설명

Number of fragment
peaks selected for
assignment

이 필드를 사용하여 할당할 단편 피크의 수를 지정합니다. 이 수는
Prepare 대화 상자에서 선택한 총 피크 수의 부분 집합일 수 있습니
다. 총 피크 수의 부분 집합인 경우 강도 순으로 피크가 선택됩니다.

Minimum signal-to-
noise ratio

이 필드를 사용하여 단편 피크를 할당하는 데 사용되는 임계값을 지
정합니다. 이 임계값보다 낮은 피크는 할당되지 않습니다. 노이즈는
MS/MS 스펙트럼에서 강도가 가장 작은 피크로 정의됩니다.

MS/MS m/z
tolerance (ppm or
mDa)

단편 피크에 수식 및 잠재적 구조를 할당하려면 질량 정확도가 지정
된 MS/MS m/z 허용 오차 내에 있어야 합니다.

Fragmentation Settings

Break aromatic
rings

방향족 링을 끊으려면 이 확인란을 선택합니다.
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표 8-15 Options 대화 상자 (계속)

옵션 설명

Maximum number
of bonds to break

이 필드를 사용하여 끊어야 할 최대 결합 수를 지정합니다. 다음 옵
션을 사용할 수 있습니다.

• 1

• 2

• 3

• 4

Maximum number
of C-C bonds to
break

이 필드를 사용하여 끊어야 할 최대 C-C 결합 수를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• 0

• 1

• 2

• 3

• 4

Label Settings

Label peaks with 이 필드를 사용하여 피크 레이블에 표시할 정보를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• Ion

• Ion with ppm Error

• Ion with mDa Error

Apply options to all
potential
metabolites

할당되지 않은 모든 대사물에 현재 옵션을 적용하려면 이 확인란을
선택합니다.

단편 구조 할당
소프트웨어는 MS/MS 스펙트럼의 단편 피크를 후보 구조의 잠재적 부분에 연결하여 구조를
할당합니다. 그러면 사용자가 각 단편의 m/z 값과 가장 일치하는 수식 및 구조를 선택할 수 있
습니다. 할당이 수행되면 할당을 위해 선택된 피크를 식별하는 별표가 확인 표시로 바뀌어 할
당이 완료되었음을 나타내거나 x로 바뀌어 할당할 수 없음을 나타냅니다.

참고: 단편화 규칙은 소프트웨어에 포함되어 있으며 편집할 수 없습니다.

제안된 수식 및 구조 할당

단편 구조를 할당하려면 각 대사물에 MS/MS 스펙트럼이 있어야 합니다. 스펙트럼을 추가하
려면 Add MS/MS 버튼으로 여러 스펙트럼 추가 섹션을 참조하십시오.
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1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. 후보 구조를 로드하고 편집합니다. 자세한 정보는 구조 로드 및 구조 편집 섹션을 참조하
십시오.

7. 필요한 경우 구조 할당을 준비합니다. 자세한 정보는 구조 할당 준비 섹션을 참조하십시
오.

8. Interpretation 보기의 Structure 창에서 Assign을 클릭합니다.
식별된 단편을 보여주는 Fragments 테이블, 잠재적 구조를 보여주는 Structure Details 테
이블, 포함된 중립 손실을 보여주는 Contained Neutral Losses 테이블 등 세 개의 테이블
이 MS/MS 창 아래에 표시됩니다.

참고: 구조가 로드되지 않으면 잠재적 수식만 단편에 할당됩니다.

각 단편에 대한 수식 구조 선택

1. 해당하는 경우 Interpretation 보기에서 Fragments, Structure Details 및 Contained
Neutral Losses 테이블을 각각 마우스 오른쪽 버튼으로 클릭한 후 Show Hidden Rows를
클릭합니다.

참고: Fragments 테이블에서 m/z 값의 최고 점수를 포함하는 행의 Use 확인란이 선택되
어 있습니다. Structure Details 테이블도 최고 점수 행의 Use 확인란이 선택되어 있습니
다. Contained Neutral Losses 테이블에서는 모든 행의 Use 확인란이 선택되어 있습니다.

2. Fragments 테이블에서 Use 확인란을 선택하여 각 m/z 값에 대한 가장 정확한 수식이 포
함된 행을 식별합니다.

팁! Fragments 테이블에서 각 단편에 대해 여러 개의 잠재적 수식을 선택하려면 둘 이상
의 행에서 Use 확인란을 선택합니다.

3. Structure Details 테이블에서 Use 확인란을 선택하여 선택한 수식과 가장 정확하게 일치
하는 구조 부분을 식별합니다.

4. Contained Neutral Losses 테이블에서 Use 확인란을 선택하여 포함된 중립 손실을 가장
정확하게 반영하는 행을 식별합니다.

팁! Structure Details 및 Contained Neutral Losses 테이블에서는 특정 단편에 대해 둘 이
상의 행에서 Use 확인란을 선택합니다.

5. Apply를 클릭합니다.
선택한 대사물에 대한 해석 데이터가 저장됩니다.

6. 모든 변경이 완료되면 Save를 클릭합니다.
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팁! 특정 대사물에 대한 모든 해석 데이터를 삭제하려면 Remove를 클릭합니다.

Structure Candidates 탭 정보
자동 구조 생성을 사용하면 선택한 대사물에 대해 Options 대화 상자에 설정된 조건을 충족하
는 구조 목록이 Structure charts 창의 Structure Candidates 탭에 채워집니다. 자세한 정보는
배치 처리 옵션 섹션을 참조하십시오. 소프트웨어는 다음 유형의 대사물에 대한 구조를 생성
합니다.

• 하나 또는 두 개의 분열이 있는 대사물

• 단일 생체 내 변화 대사물

• 하나의 분열 및 단일 생체 내 변화가 있는 대사물

복합적 대사의 경우 사용자는 사용자 지정 대사물 구조를 제공하거나 편집하고 이러한 구조
제안을 평가할 수 있습니다.

구조 목록(히스토그램이라고 함)에는 다음 정보 열이 포함됩니다.

열 설명

Rank 구조의 위치 또는 순위를 나타냅니다.

Relative
Evidence

순위 지정 또는 점수 매기기는 모체 구조의 MS/MS 스펙트럼과 대사물의
MS/MS 스펙트럼 간 비교를 기반으로 합니다. 그런 다음 대사물 단편과 모
체의 단편을 비교하여 이동된 단편과 이동되지 않은 단편을 식별합니다.
단편 강도 및 제안의 고유성과 같은 다른 특성도 전체 순위 전략에서 고려
됩니다. 최종 순위는 특정 원자 인덱스에서 생체 내 변화 또는 분열이 일어
날 확률을 나타냅니다.

사용자는 이 열을 사용하여 구조 간에 전환할 수도 있습니다. 자세한 정보
는 구조 간 전환 섹션을 참조하십시오.

Apply to
Results

선택된 확인란은 해당 구조가 결과 파일에 저장됨을 나타냅니다.

총 후보 수는 히스토그램 테이블 위, Apply to Results 열 바로 위에 표시됩니다.

자동 생성된 구조를 편집할 수 없습니다. 사용자는 구조를 로드하고, 필요한 변형을 수행한 후
Apply to Results 확인란을 선택하여 결과 파일에 구조를 포함할 수 있습니다. 자세한 정보는
구조 로드 섹션의 7, 8단계 및 구조 편집 섹션을 참조하십시오.

구조 간 전환

히스토그램에서 파란색 막대를 클릭합니다.
해당하는 구조가 Structure 창에 표시됩니다.

빈 창 선택

히스토그램에서 첫 번째 줄을 클릭합니다.
히스토그램의 첫 번째 줄에는 No structure라는 단어가 포함되어 있습니다. Structure 창이
새로 고쳐지고 No structure 문구가 표시됩니다.
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구조 추가

참고: 자동 생성된 구조 목록에는 하나의 구조만 추가할 수 있습니다. 구조가 더 추가되면 이전
에 사용자가 추가한 구조를 덮어씁니다.

1. Structure 창에서 Load를 클릭한 후 Load Structure 옵션을 선택합니다.
Open Structure File 대화 상자가 열립니다.

2. mol 또는 sdf 파일을 찾아 선택합니다.

3. Open을 클릭합니다.

선택한 구조가 Structure 창에 표시되고 첫 번째 자동 생성된 구조 바로 위의 히스토그램
테이블에 행이 추가됩니다. 로드된 구조 행의 파란색 음영은 자동 생성된 구조가 포함된
행의 파란색과 약간 다릅니다. 순위는 0으로 설정됩니다.

사용자가 추가한 구조를 편집할 수 있습니다. 구조에 대한 변경 사항은 사용자가
Structure 창에서 나갈 때 메모리에 저장됩니다.

표시할 구조 선택

1. 히스토그램에서 파란색 막대를 클릭합니다.
해당하는 구조가 Structure 창에 표시됩니다. 기본적으로 히스토그램의 첫 번째 구조에만
Fragments 테이블이 할당됩니다.

2. 다른 구조에 대해 Fragments 테이블을 할당하려면 히스토그램에서 파란색 막대를 클릭한
후 Assign을 클릭합니다.

구조 삭제

1. 히스토그램에서 파란색 막대를 클릭합니다.
해당하는 구조가 Structure 창에 표시됩니다.

2. Structure 창에서 Delete를 클릭합니다.
구조가 Structure 창에서 제거되고 선택한 파란색 행이 히스토그램에서 제거되며
Fragments 테이블이 제거됩니다. 히스토그램의 다음 행 시퀀스가 Structure 창에 표시됩
니다.

Markush 구조 연결
단편 구조를 할당한 후 Markush 구조를 사용하여 화학적 변형을 위한 대략적인 위치를 표시할
수 있습니다.

참고: Markush 구조를 포함하는 대사물에는 단편 구조를 할당할 수 없습니다.

1. 구조의 일부를 강조 표시합니다.

2. 구조의 위 또는 아래를 마우스 오른쪽 버튼으로 클릭한 후 Attach Markush를 클릭합니
다.

3. Single Bond 또는 Double Bond를 선택합니다.

4. Select Symbol 대화 상자에서 필요한 기호 또는 수식을 입력합니다.

5. OK를 클릭합니다.
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Markush 구조는 구조의 선택된 부분에 연결하는 파선으로 표시됩니다.

참고: Markush 구조가 연결된 경우 해석 데이터를 할당한 후 구조를 변경할 수 있습니다.
Markush 구조가 제거되면 변경으로 인해 대사물에 대한 모든 해석 데이터가 삭제됩니다.

피크 레이블 정보
다음을 사용하여 피크에 레이블을 지정할 수 있습니다.

• 이온식 또는 이온 유형(펩타이드용)

• 이온식 또는 이온 유형(펩타이드용)과 ppm 오차

• 이온식 또는 이온 유형(펩타이드용)과 mDa 오차

MS/MS 스펙트럼에 피크 레이블 추가

1. Interpretation 보기에서 Options를 클릭합니다.
Options 대화 상자가 열립니다.

2. Label peaks with 필드에서 레이블 유형을 선택합니다.

3. OK를 클릭합니다.

4. Fragments 테이블에서 레이블을 지정할 피크가 포함된 행을 선택합니다.

5. 을 클릭합니다.

팁! MS/MS 스펙트럼에서 모든 레이블을 제거하려면 을 클릭합니다.

소분자에 대한 해석 필터 정보
필터를 적용하여 Fragments 테이블에 표시되는 데이터를 세분화할 수 있습니다.

Interpretation Filters 대화 상자에 액세스하려면 Fragments 테이블에서  아이콘을 클릭합
니다.

필터 설명

Rings and Double Bonds

RDB • Integer value (even-electron): 링과 이중 결합에 대해 정수
값을 가진 단편만 표시합니다.

• Non-integer value (odd-electron): 링과 이중 결합에 대해
정수가 아닌 값을 가진 단편만 표시합니다.

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값을 가진 단편만 표시합니다.

Mass Accuracy

MS/MS 데이터 특성화
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필터 설명

Accuracy within 지정된 범위 내의 질량 정확도를 가진 단편만 표시합니다.
참고: 질량 정확도 측정 단위가 mDa인지 또는 ppm인지는
Options 대화 상자의 선택에 따라 달라집니다.

Intensity

Intensity above __ cps 강도 값이 지정된 값을 초과하는 단편만 표시합니다.

Score

Score above 점수가 지정된 값을 초과하는 단편만 표시합니다.

Structures

Fragments with
assigned structures

구조와 연결된 단편만 표시합니다.

펩타이드 워크플로
시퀀스 로드

시퀀스 편집

옵션 설정

단편 시퀀스 할당

피크 레이블 정보 MS/MS 스펙트럼에 피크 레이블 추가

펩타이드에 대한 해석 필터 정보

시퀀스 로드
1. Workspace 패널에서 Results를 클릭합니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 결과 파일을 찾아 선택합니다.

4. OK를 클릭합니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. Potential Metabolites 테이블에서 행을 선택합니다.

7. 다음 중 하나를 수행합니다.

• Sequence 창이 비어 있으면 Load Parent를 클릭합니다.

• Sequence 창에 시퀀스가 이미 있고 새 시퀀스를 추가해야 하는 경우 Enter Sequence
를 클릭하여 창을 지운 후 Load Parent를 클릭합니다.

모체 시퀀스가 Sequence 창에 표시됩니다. 창 위에 AA Index: [ ], Mono. Mass: [ ], m/z:
[ ], Composition: [ ] 레이블이 추가됩니다.
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소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
97/141



• AA Index: (아미노산 인덱스) 아미노산 인덱스는 모체 시퀀스에서 시퀀스의 첫 번째
및 마지막 잔기 위치를 나타냅니다. 분해대사물 시퀀스가 모체 시퀀스에 포함되지 않
은 경우 AA Index가 표시되지 않습니다.

• Mono. Mass: 중성 성분의 단일 동위 원소 질량입니다.

• m/z: 질량 대 전하 값입니다. 전하는 괄호 안에 표시됩니다.

• Composition: 시퀀스의 비전하 원소 구성입니다.

8. 변경이 필요한 경우 시퀀스를 편집합니다. 자세한 정보는 시퀀스 편집 섹션을 참조하십시
오.

시퀀스 편집
특정 대사물에 대한 시퀀스가 생성되거나 로드된 후 편집할 수 있습니다.

1. 변경이 필요한 시퀀스를 클릭합니다.

2. 필요한 내용을 변경합니다. 자세한 정보는 펩타이드 시퀀스 명명 규칙 섹션을 참조하십시
오.

옵션 설정
1. Interpretation 보기에서 Options를 클릭합니다.

Options 대화 상자가 열립니다.

2. 단편화 및 레이블 지정 매개 변수를 수정합니다. 자세한 정보는 표 8-16에서 확인하십시
오.

표 8-16 Options 대화 상자

옵션 설명

Minimum signal-to-
noise ratio

이 필드를 사용하여 단편 피크를 할당하는 데 사용되는 임계값을 지
정합니다. 이 임계값보다 낮은 피크는 할당되지 않습니다. 노이즈는
MS/MS 스펙트럼에서 강도가 가장 작은 피크로 정의됩니다.

MS/MS m/z
tolerance (ppm or
mDa)

이 필드를 사용하여 MS/MS m/z 허용 오차를 지정합니다. 단편 피크
에 이온 유형 및 시퀀스를 할당하려면 질량 정확도가 지정된 MS/MS
m/z 허용 오차 내에 있어야 합니다.

Fragmentation Settings

Fragment Types 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니다.
다음 옵션을 사용할 수 있습니다.

• a

• b

• y
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표 8-16 Options 대화 상자 (계속)

옵션 설명

Maximum number
of bonds to break

이 필드를 사용하여 끊어야 할 최대 결합 수를 지정합니다. 다음 옵
션을 사용할 수 있습니다.

• 1

• 2

• 3

팁! 더 복잡한 펩타이드의 경우 끊어야 할 최대 결합 수를 3으로 선택
하면 필요한 처리 시간이 늘어납니다.

Break linkages 펩타이드 시퀀스에 연쇄가 있는 경우 이 확인란을 선택하면 개별 아
미노산 간의 연결을 끊을 수 있습니다.

Label Settings

Label peaks with 이 필드를 사용하여 피크 레이블에 표시할 정보를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

할당되지 않은 모든 대사물에 현재 옵션을 적용하려면 이 확인란을
선택합니다.

단편 시퀀스 할당

참고: 단편화 규칙은 소프트웨어에 포함되어 있으며 편집할 수 없습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. 시퀀스를 로드합니다. 자세한 정보는 시퀀스 로드 섹션을 참조하십시오.

7. Sequence 창에서 Assign을 클릭합니다.
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선택한 옵션을 사용하여 로드된 시퀀스에 대한 해석 결과가 Fragments 테이블에 채워집
니다. 자세한 정보는 옵션 설정 섹션을 참조하십시오. Fragments 테이블에서 일치하는 이
온을 식별하는 녹색 세로선이 MS/MS 창에 추가됩니다. 테이블 위의 레이블이 업데이트
되어 다음을 나타냅니다.

• Assigned: x of y peaks. 할당된 피크 수를 나타냅니다.

• MSMS Peak Area Assigned: x%. 할당된 MS/MS 피크 면적의 백분율을 나타냅니다.

• Sequence Coverage: x of y consecutive amino acids. 시퀀스에 포함되는 연속 아
미노산의 수를 나타냅니다.

Sequence Candidates 탭 정보
자동 시퀀스 생성을 사용하면 선택한 분해대사물 또는 대사물에 대해 Options 대화 상자에 설
정된 조건을 충족하는 시퀀스 목록이 Sequence charts 창의 Sequence Candidates 탭에 채워
집니다. 자세한 정보는 배치 처리 옵션 섹션을 참조하십시오. 소프트웨어는 다음 유형의 대사
물 또는 분해대사물에 대한 시퀀스를 생성합니다.

• n 분열: 분열에 대한 최대 네 개의 변형

• 모체: n이 임의의 수의 분열을 나타내는 경우

시퀀스 목록(히스토그램이라고 함)에는 다음 정보 열이 포함됩니다.

열 설명

Rank 지정된 대사물에 대해 검색된 모든 이성체 시퀀스의 상대 순위를 나타냅
니다. 이 순위는 할당된 MS/MS 피크 면적을 기준으로 합니다.

View sequence
fragments

백분율 값은 제안된 시퀀스의 점수를 나타냅니다.

사용자는 이 열을 사용하여 시퀀스 간에 전환할 수도 있습니다. 자세한 정
보는 시퀀스 간 전환 섹션을 참조하십시오.

AA Index 시퀀스의 아미노산 시작과 끝을 나타냅니다.

Apply to
Results

선택된 확인란은 해당 시퀀스가 결과 파일에 저장됨을 나타냅니다.

총 후보 수는 히스토그램 테이블 위, Apply to Results 열 바로 위에 표시됩니다.

자동 생성된 시퀀스를 편집할 수 없습니다. 사용자는 시퀀스를 로드하고, 필요한 변형을 수행
한 후 Apply to Results 확인란을 선택하여 결과 파일에 시퀀스를 포함할 수 있습니다. 자세한
정보는 시퀀스 로드 섹션의 7단계 및 시퀀스 편집 섹션을 참조하십시오.

피크 레이블 정보
다음을 사용하여 피크에 레이블을 지정할 수 있습니다.

• 이온식 또는 이온 유형(펩타이드용)

• 이온식 또는 이온 유형(펩타이드용)과 ppm 오차

• 이온식 또는 이온 유형(펩타이드용)과 mDa 오차
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• 이온식 또는 이온 유형(펩타이드용)과 전하

MS/MS 스펙트럼에 피크 레이블 추가

1. Interpretation 보기에서 Options를 클릭합니다.
Options 대화 상자가 열립니다.

2. Label peaks with 필드에서 레이블 유형을 선택합니다.

3. OK를 클릭합니다.

4. 다음 중 하나를 수행합니다.

표 8-17 피크 레이블 추가

한 피크에 레이블 지정 모든 피크에 레이블 지정

Fragments 테이블에서 레이블을 지정할 피
크가 포함된 행을 선택합니다.

을 클릭합니다.

을 클릭합니다. —

팁! MS/MS 스펙트럼에서 모든 레이블을 제거하려면 을 클릭합니다.

펩타이드에 대한 해석 필터 정보
필터를 적용하여 Fragments 테이블에 표시되는 데이터를 세분화할 수 있습니다.

Interpretation Filters 대화 상자에 액세스하려면 Fragments 테이블에서  아이콘을 클릭합
니다.

필터 설명

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값을 가진 단편만 표시합니다.

Charge Range

Charge from __ to __ 선택한 범위 내의 전하를 가진 단편만 표시합니다. 다음 옵션을
사용할 수 있습니다.

• From range: 1 ~ 10(포함)

• To range: 1 ~ 10(포함)

참고: To range 값은 From range 값보다 크거나 같아야 합니다.

Ion Type
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필터 설명

Fragment type 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니
다. 다음 옵션을 사용할 수 있습니다.

• a

• b

• y

Mass Accuracy

Accuracy within 지정된 범위 내의 질량 정확도를 가진 단편만 표시합니다.
참고: 질량 정확도 측정 단위가 mDa인지 또는 ppm인지는
Options 대화 상자의 선택에 따라 달라집니다.

Intensity

Intensity above __ cps 강도 값이 지정된 값을 초과하는 단편만 표시합니다.

올리고뉴클레오타이드 워크플로
시퀀스 로드

시퀀스 편집

옵션 설정

단편 시퀀스 할당

피크 레이블 정보 MS/MS 스펙트럼에 피크 레이블 추가

올리고뉴클레오타이드에 대한 해석 필터
정보

시퀀스 로드
1. Workspace 패널에서 Results를 클릭합니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 결과 파일을 찾아 선택합니다.

4. OK를 클릭합니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. Potential Metabolites 테이블에서 행을 선택합니다.

7. Sequence 창이 비어 있으면 다음 중 하나를 수행합니다.

• Load Parent를 클릭합니다.

• 창에 시퀀스를 입력하거나 붙여 넣습니다.

MS/MS 데이터 특성화
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창 위에 Mono. Mass: [ ], m/z: [ ], Composition: [ ] 레이블이 추가됩니다.

• Mono. Mass: 중성 성분의 단일 동위 원소 질량입니다.

• m/z: 질량 대 전하 값입니다. 전하는 괄호 안에 표시됩니다.

• Composition: 시퀀스의 비전하 원소 구성입니다.

8. 변경이 필요한 경우 시퀀스를 편집합니다. 자세한 정보는 시퀀스 편집 섹션을 참조하십시
오.

시퀀스 편집
특정 대사물에 대한 시퀀스가 생성되거나 로드된 후 편집할 수 있습니다.

1. 변경이 필요한 시퀀스를 클릭합니다.

2. 필요한 내용을 변경합니다. 자세한 정보는 올리고뉴클레오타이드 시퀀스 명명 규칙 섹션
을 참조하십시오.

옵션 설정
1. Interpretation 보기에서 Options를 클릭합니다.

Options 대화 상자가 열립니다.

2. 단편화 및 레이블 지정 매개 변수를 수정합니다. 자세한 정보는 표 8-18에서 확인하십시
오.

표 8-18 Options 대화 상자

옵션 설명

Minimum signal-to-
noise ratio

이 필드를 사용하여 단편 피크를 할당하는 데 사용되는 임계값을 지
정합니다. 이 임계값보다 낮은 피크는 할당되지 않습니다. 노이즈는
MS/MS 스펙트럼에서 강도가 가장 작은 피크로 정의됩니다.

MS/MS m/z
tolerance (ppm or
mDa)

이 필드를 사용하여 MS/MS m/z 허용 오차를 지정합니다. 단편 피크
에 이온 유형 및 시퀀스를 할당하려면 질량 정확도가 지정된 MS/MS
m/z 허용 오차 내에 있어야 합니다.

Fragmentation Settings

MS/MS 데이터 특성화
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표 8-18 Options 대화 상자 (계속)

옵션 설명

Fragment Types 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니다.
다음 옵션을 사용할 수 있습니다.

• a

• b

• c

• d

• y

• Other

• wb-H20

• x

• y

자세한 정보는 사용자 지정 올리고뉴클레오타이드의 예 섹션을 참조
하십시오.

Maximum number
of bonds to break

이 필드를 사용하여 끊어야 할 최대 결합 수를 지정합니다. 다음 옵
션을 사용할 수 있습니다.

• 1

• 2

값 2가 권장됩니다.

팁! 더 복잡한 올리고뉴클레오타이드의 경우 끊어야 할 최대 결합 수
를 3으로 선택하면 필요한 처리 시간이 늘어납니다.

Maximum water and
Base losses

단편화 중에 발생할 수 있는 최대 수분 손실을 지정합니다. 값 1이 권
장됩니다.

Label Settings

Label peaks with 이 필드를 사용하여 피크 레이블에 표시할 정보를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

MS/MS 데이터 특성화
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표 8-18 Options 대화 상자 (계속)

옵션 설명

Apply options to all
potential
metabolites

할당되지 않은 모든 대사물에 현재 옵션을 적용하려면 이 확인란을
선택합니다.

단편 시퀀스 할당

참고: 단편화 규칙은 소프트웨어에 포함되어 있으며 편집할 수 없습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. 시퀀스를 로드합니다. 자세한 정보는 시퀀스 로드 섹션을 참조하십시오.

7. Sequence 창에서 Assign을 클릭합니다.
선택한 옵션을 사용하여 로드된 시퀀스에 대한 해석 결과가 Fragments 테이블에 채워집
니다. 자세한 정보는 옵션 설정 섹션을 참조하십시오. Fragments 테이블에서 일치하는 이
온을 식별하는 녹청색 세로선이 MS/MS 창에 추가됩니다. 테이블 위의 레이블이 업데이
트되어 다음을 나타냅니다.

• Assigned: x of y peaks. 할당된 피크 수를 나타냅니다.

• MSMS Peak Area Assigned: x%. 할당된 MS/MS 피크 면적의 백분율을 나타냅니다.

• Sequence Coverage: x of y consecutive nucleotides. 시퀀스에 포함되는 연속 뉴
클레오타이드의 수를 나타냅니다.

피크 레이블 정보
다음을 사용하여 피크에 레이블을 지정할 수 있습니다.

• 이온식 또는 이온 유형(올리고뉴클레오타이드)

• 이온식 또는 이온 유형(올리고뉴클레오타이드)과 ppm 오차

• 이온식 또는 이온 유형(올리고뉴클레오타이드)과 mDa 오차

• 이온식 또는 이온 유형(올리고뉴클레오타이드)과 전하

MS/MS 스펙트럼에 피크 레이블 추가

1. Interpretation 보기에서 Options를 클릭합니다.
Options 대화 상자가 열립니다.

MS/MS 데이터 특성화
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2. Label peaks with 필드에서 레이블 유형을 선택합니다.

3. OK를 클릭합니다.

4. 다음 중 하나를 수행합니다.

표 8-19 피크 레이블 추가

한 피크에 레이블 지정 모든 피크에 레이블 지정

Fragments 테이블에서 레이블을 지정할 피
크가 포함된 행을 선택합니다.

을 클릭합니다.

을 클릭합니다. —

팁! MS/MS 스펙트럼에서 모든 레이블을 제거하려면 을 클릭합니다.

올리고뉴클레오타이드에 대한 해석 필터 정보
필터를 적용하여 Fragments 테이블에 표시되는 데이터를 세분화할 수 있습니다.

Interpretation Filters 대화 상자에 액세스하려면 Fragments 테이블에서  아이콘을 클릭합
니다.

필터 설명

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값을 가진 단편만 표시합니다.

Charge Range

Charge from __ to __ 선택한 값을 초과하는 전하를 가진 단편만 표시합니다. 유효한
값은 1에서 10까지입니다.

Ion Type

MS/MS 데이터 특성화
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필터 설명

Fragment type 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니
다. 다음 옵션을 사용할 수 있습니다.

• a

• b

• c

• d

• w

• wb-H20

• x

• y

• Other

• Base loss

• Water loss

• Internals

Mass Accuracy

Accuracy within 지정된 범위 내의 질량 정확도를 가진 단편만 표시합니다.
참고: 질량 정확도 측정 단위가 mDa인지 또는 ppm인지는
Options 대화 상자의 선택에 따라 달라집니다.

Intensity

Intensity above __ cps 강도 값이 지정된 값을 초과하는 단편만 표시합니다.

ADC 워크플로
구조 로드

구조 편집

시퀀스 로드

시퀀스 편집

옵션 설정

구조와 시퀀스 둘 다에 대해 단편 이온 할
당

피크 레이블 정보 MS/MS 스펙트럼에 피크 레이블 추가

ADC에 대한 해석 필터 정보

MS/MS 데이터 특성화

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
107/141



구조 로드
대사물의 구조 설명을 시작하기 전에 구조를 로드하면 소프트웨어가 잠재적 단편 구조를 결정
할 수 있습니다.

참고: 구조가 로드되지 않아도 잠재적 수식을 단편에 할당할 수 있습니다.

1. Workspace 패널에서 Results를 클릭합니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 결과 파일을 찾아 선택합니다.

4. OK를 클릭합니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. Potential Metabolites 테이블에서 행을 선택합니다.

7. Structure 창에서 Load를 클릭한 후 Load Parent Structure 옵션을 선택합니다.
선택한 대사물의 모체 구조로 창이 채워집니다. 표시된 부착 위치(포함된 처리 매개 변수
파일에서 볼 수 있음) 또는 원자가 자주색으로 표시됩니다.

8. 사소한 변경이 필요한 경우 구조를 편집합니다. 자세한 정보는 구조 편집 섹션을 참조하
십시오.

구조 편집
특정 대사물에 대한 구조를 로드한 후 편집 도구를 사용하여 사소한 변경을 수행할 수 있습니
다.

팁! 편집 도구를 사용하여 대사 변환을 위한 다른 부착 위치와 같이 구조를 약간 변경합니다.
편집 도구는 새 구조를 생성하거나 기존 구조를 크게 변경하는 데 사용하면 안 됩니다.

표 8-20 구조 편집

수행할 작업 방법

구조에 원자 추가 팔레트의 특정 기호를 새 위치로 끕니다. 추가된 원자
는 가장 가까운 기존 원자와 단일 결합을 형성합니다.

팔레트에 새 원자 생성 빈 사각형을 클릭하고 Specify Symbol 대화 상자에 기
호를 입력한 후 OK를 클릭합니다.

팁! 다른 원자를 생성하려면 추가된 사각형을 클릭하고
새 기호를 입력하십시오.

구조의 일부 강조 표시 필요한 원자와 결합 주위를 원 모양으로 끕니다.

하나 이상의 원자 이동 구조의 강조 표시된 부분을 새 위치로 끕니다. 해당 부
분이 다른 한 원자에 결합되어 있으면 결합이 새 위치
로 이동합니다. 해당 부분이 둘 이상의 원자에 결합되
어 있으면 부분은 이동하지만 기존 결합은 그대로 유지
됩니다.
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표 8-20 구조 편집 (계속)

수행할 작업 방법

기존 구조에 구조 삽입 구조를 마우스 오른쪽 버튼으로 클릭하고 다음 중 하나
를 클릭합니다.

• Insert .mol File 다른 구조를 추가합니다.

• Insert Conjugate 특정 포합 구조를 추가합니다.

하나 이상의 원자 삭제 구조의 강조 표시된 부분을 마우스 오른쪽 버튼으로 클
릭한 후 Remove Selected Atoms를 클릭합니다.

결합 생성 결합되지 않은 두 원자를 선택한 후 선택 항목을 마우
스 오른쪽 버튼으로 클릭하고 New Bond를 클릭한 후
결합 유형을 선택합니다.

결합 편집 결합을 마우스 오른쪽 버튼으로 클릭하고 Set Bond
Type을 클릭한 후 결합 유형을 선택합니다.

결합 삭제 결합을 마우스 오른쪽 버튼으로 클릭한 후 Remove
Bond를 클릭합니다.

기존 원자의 전하 상태 변경 원자를 마우스 오른쪽 버튼으로 클릭하고 Atom
Charge State를 클릭한 후 상태를 선택합니다.

팁! 편집한 구조를 별도의 파일로 저장하려면 Save As를 클릭합니다.

팁! 구조는 mol 또는 sdf 파일로 저장할 수 있습니다. Save As 대화 상자에 적절한 확장자를 입
력합니다.

시퀀스 로드
1. Workspace 패널에서 Results를 클릭합니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 펩타이드 결과 파일을 찾아 선택합니다.

4. OK를 클릭합니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. Potential Metabolites 테이블에서 행을 선택합니다.

7. Structure 창에서 Load를 클릭한 후 Load Sequence 옵션을 선택합니다.
선택한 대사물의 모체 시퀀스로 Sequence 창이 채워집니다.

8. 포합할 잔기를 선택하고 마우스 오른쪽 버튼을 클릭한 후 Mark Residue to Conjugate를
선택합니다.
선택한 잔기가 자주색으로 표시됩니다.

MS/MS 데이터 특성화
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9. 변경이 필요한 경우 시퀀스를 편집합니다. 자세한 정보는 시퀀스 편집 섹션을 참조하십시
오.

시퀀스 편집
특정 대사물에 대한 시퀀스가 생성되거나 로드된 후 편집할 수 있습니다.

1. 변경이 필요한 시퀀스를 클릭합니다.

2. 필요한 내용을 변경합니다. 자세한 정보는 펩타이드 시퀀스 명명 규칙 섹션을 참조하십시
오.

옵션 설정
1. Interpretation 보기에서 Options를 클릭합니다.

Options 대화 상자가 열립니다.

2. 표 8-21에 설명된 단편화 및 레이블 지정 매개 변수를 수정합니다.

표 8-21 Options 대화 상자

옵션 설명

Number of fragment
peaks selected for
structure
assignment

이 필드를 사용하여 ADC의 구조 부분에 할당할 단편 피크 수를 지정
합니다. 총 피크 수의 부분 집합인 경우 강도 순으로 피크가 선택됩
니다.

Minimum signal-to-
noise ratio

이 필드를 사용하여 단편 피크를 할당하는 데 사용되는 임계값을 지
정합니다. 이 임계값보다 낮은 피크는 할당되지 않습니다.

MS/MS m/z
tolerance (ppm or
mDa)

이 필드를 사용하여 MS/MS m/z 허용 오차를 지정합니다(ppm 또는
mDa 단위). 단편 피크에 수식 및 잠재적 구조를 할당하려면 질량 정
확도가 지정된 MS/MS m/z 허용 오차 내에 있어야 합니다.

Structure Fragmentation Settings

Break aromatic
rings

방향족 링을 끊으려면 이 확인란을 선택합니다.

Maximum number
of bonds to break

이 필드를 사용하여 끊어야 할 최대 결합 수를 지정합니다. 다음 옵
션을 사용할 수 있습니다.

• 1

• 2

• 3

• 4
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표 8-21 Options 대화 상자 (계속)

옵션 설명

Maximum number
of C-C bonds to
break

이 필드를 사용하여 끊어야 할 최대 C-C 결합 수를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• 0

• 1

• 2

• 3

• 4

Sequence Fragmentation Settings

Fragment Types 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니다.
다음 옵션을 사용할 수 있습니다.

• a

• b

• y

Maximum number
of bonds to break

이 필드를 사용하여 끊어야 할 최대 결합 수를 지정합니다. 다음 옵
션을 사용할 수 있습니다.

• 1

• 2

• 3

참고: 더 복잡한 펩타이드의 경우 끊어야 할 최대 결합 수를 3으로 선
택하면 필요한 처리 시간이 늘어납니다.

Break linkages 펩타이드 시퀀스에 연쇄가 있는 경우 이 확인란을 선택하면 개별 아
미노산 간의 연결을 끊을 수 있습니다.

Label Settings

Label peaks with 이 필드를 사용하여 피크 레이블에 표시할 정보를 지정합니다. 다음
옵션을 사용할 수 있습니다.

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge
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표 8-21 Options 대화 상자 (계속)

옵션 설명

Apply options to all
potential
metabolites

할당되지 않은 모든 대사물에 현재 옵션을 적용하려면 이 확인란을
선택합니다.

구조와 시퀀스 둘 다에 대해 단편 이온 할당

참고: 단편화 규칙은 소프트웨어에 포함되어 있으며 편집할 수 없습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Show 필드에서 Interpretation을 선택합니다.

6. 구조와 시퀀스를 로드합니다. 자세한 정보는 구조 로드 및 시퀀스 로드 섹션을 참조하십
시오.

참고: 구조 또는 시퀀스 중 하나만 로드해야 합니다. 이 절차는 둘 다 로드된 상태를 가정
하고 작성되었습니다.

7. Structure 창에서 Assign을 클릭합니다.

TOF MS/MS 스펙트럼 아래의 Structure 보기와 Sequence 보기가 모두 채워지고 기본적
으로 Structure 보기가 표시됩니다.

참고: 모체 구조만 로드된 경우 Fragments 테이블의 Structures 보기가 표시됩니다. 모체
시퀀스만 로드된 경우에는 Fragments 테이블의 Sequences 보기가 표시됩니다.

Structure 보기에서 Fragments 테이블은 식별된 단편으로 채워지고 Structure Details 테
이블은 잠재적 구조로 채워지며 Contained Neutral Losses 테이블은 포함된 중립 손실로
채워집니다. 결과는 선택한 옵션을 기반으로 합니다. 자세한 정보는 옵션 설정 섹션을 참
조하십시오. Fragments 테이블에서 일치하는 이온을 식별하는 연한 파란색 세로선이
MS/MS 창에 추가됩니다.

참고: 구조에 해석 결과가 없으면 No structures assigned가 Fragments 테이블에
표시됩니다.

Fragments 테이블 위의 레이블은 다음을 나타냅니다.

• Assigned: a of b peaks (Structure: x, Sequence: y). 여기서 a는 x와 y의 합이고 할당
된 피크 수를 나타냅니다. b는 총 피크 수를 나타내며 x는 Structures 보기의 행 수, y는
Sequences 보기의 행 수를 각각 나타냅니다.
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• MSMS Peak Area Assigned: w%. 여기서 w는 스펙트럼 데이터에서 할당된 피크의
백분율 면적을 나타냅니다.

Fragments 테이블에는 Use as Conjugate 열이 포함되어 있습니다. 이 열에는 테이블의
각 행에 대한 확인 표시가 있습니다. 확인란을 선택할 수 있으면 단편에 대해 제안된 구조
에 부착 위치가 있습니다. 확인란을 선택할 수 없으면 부착 위치가 없습니다. 확인란을 선
택한 경우 단편이 시퀀스와의 포합에 사용됩니다. 확인란을 선택하지 않은 경우 단편이
사용되지 않습니다. 기본적으로 정확도 및 존재비에 따라 부착 위치가 포함된 최대 세 개
의 단편이 선택됩니다. 테이블의 첫 번째 행은 기본적으로 선택됩니다.

8. Structures 보기가 선택되었는지 확인합니다.

9. 해당하는 경우 Fragments, Structure Details 및 Contained Neutral Losses 테이블을 각각
마우스 오른쪽 버튼으로 클릭한 후 Show Hidden Rows를 클릭합니다.

참고: Fragments 테이블에서 m/z 값의 최고 점수를 포함하는 행의 Use 확인란이 선택되
어 있습니다. Structure Details 테이블도 최고 점수 행의 Use 확인란이 선택되어 있습니
다. Contained Neutral Losses 테이블에서는 모든 행의 Use 확인란이 선택되어 있습니다.

10. Fragments 테이블에서 Use 확인란을 선택하여 각 m/z 값에 대한 가장 정확한 수식이 포
함된 행을 식별합니다.

팁! 각 단편에 대해 여러 개의 잠재적 수식을 선택하려면 둘 이상의 행에서 Use 확인란을
선택합니다.

할당된 m/z 값이 굵은 기울임꼴로 표시됩니다.

11. Structure Details 테이블에서 Use 확인란을 선택하여 선택한 수식과 가장 정확하게 일치
하는 구조 부분을 식별합니다.

12. Contained Neutral Losses 테이블에서 Use 확인란을 선택하여 포함된 중립 손실을 가장
정확하게 반영하는 행을 식별합니다.

팁! Structure Details 및 Contained Neutral Losses 테이블에서는 특정 단편에 대해 둘 이
상의 행에서 Use 확인란을 선택합니다.

13. Sequences 보기를 선택합니다.

Sequence 보기에서 Fragments 테이블에는 선택한 옵션(옵션 설정 섹션 참조), Structures
보기에서 선택한 포합체, Compound-Specific Parameters의 Product Ions and Neutral
Losses 탭에서 선택한 항목(Product Ions and Neutral Losses 탭 섹션 참조) 및 시퀀스에
따라 해석 결과가 채워집니다. Fragments 테이블에서 일치하는 이온을 식별하는 녹색 세
로선이 MS/MS 창에 추가됩니다.

참고: 시퀀스에 해석 결과가 없으면 No sequences assigned가 Fragments 테이블에
표시됩니다.

테이블 위의 레이블은 다음을 나타냅니다.

• Assigned: a of b peaks (Structure: x, Sequence: y). 여기서 a는 x와 y의 합이고 할당된
피크 수를 나타냅니다. b는 총 피크 수를 나타내며 x는 StructuresStructures 탭의 행
수, y는 Sequences 탭의 행 수를 각각 나타냅니다.
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• MSMS Peak Area Assigned: w%. 여기서 w는 스펙트럼 데이터에서 할당된 피크의
백분율 면적을 나타냅니다.

14. 해당하는 경우 Fragments 테이블을 마우스 오른쪽 버튼으로 클릭한 후 Show Hidden
Rows를 클릭합니다.

참고: Fragments 테이블에서 m/z 값의 최고 점수를 포함하는 행의 Use 확인란이 선택되
어 있습니다.

15. Fragments 테이블에서 Use 확인란을 선택하여 각 m/z 값에 대한 가장 정확한 수식이 포
함된 행을 식별합니다.

팁! 각 단편에 대해 여러 개의 잠재적 수식을 선택하려면 둘 이상의 행에서 Use 확인란을
선택합니다.

할당된 m/z 값이 굵은 기울임꼴로 표시됩니다.

16. 모든 변경이 완료되면 Apply를 클릭합니다.
선택한 대사물에 대한 해석 데이터가 저장됩니다.

17. Save를 클릭합니다.

팁! 특정 대사물에 대한 모든 해석 데이터를 삭제하려면 Remove를 클릭합니다.

피크 레이블 정보
다음을 사용하여 피크에 레이블을 지정할 수 있습니다.

• 이온식 또는 이온 유형(펩타이드용)

• 이온식 또는 이온 유형(펩타이드용)과 ppm 오차

• 이온식 또는 이온 유형(펩타이드용)과 mDa 오차

• 이온식 또는 이온 유형(펩타이드용)과 전하

MS/MS 스펙트럼에 피크 레이블 추가

1. Interpretation 보기에서 Options를 클릭합니다.
Options 대화 상자가 열립니다.

2. Label peaks with 필드에서 레이블 유형을 선택합니다.

3. OK를 클릭합니다.

4. 다음 중 하나를 수행합니다.

표 8-22 피크 레이블 추가

한 피크에 레이블 지정 모든 피크에 레이블 지정

Fragments 테이블에서 레이블을 지정할 피
크가 포함된 행을 선택합니다.

을 클릭합니다.

을 클릭합니다. —
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팁! MS/MS 스펙트럼에서 모든 레이블을 제거하려면 을 클릭합니다.

ADC에 대한 해석 필터 정보
필터를 적용하여 Fragments 테이블에 표시되는 데이터를 세분화할 수 있습니다.

Interpretation Filters 대화 상자에 액세스하려면 Fragments 테이블에서  아이콘을 클릭합
니다.

필터 설명

Rings and Double Bonds

RDB • Integer value (even-electron): 링과 이중 결합에 대해 정수
값을 가진 단편만 표시합니다.

• Non-integer value (odd-electron): 링과 이중 결합에 대해
정수가 아닌 값을 가진 단편만 표시합니다.

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값을 가진 단편만 표시합니다.

Charge Range

Charge from __ to __ 선택한 범위 내의 전하를 가진 단편만 표시합니다. 다음 옵션을
사용할 수 있습니다.

• From range: 1 ~ 10(포함)

• To range: 1 ~ 10(포함)

참고: To range 값은 From range 값보다 크거나 같아야 합니다.

Ion Type

Fragment type 적절한 단편 유형을 선택합니다. 여러 유형을 선택할 수 있습니
다. 다음 옵션을 사용할 수 있습니다.

• a

• b

• y

Mass Accuracy

Accuracy within 지정된 범위 내의 질량 정확도를 가진 단편만 표시합니다.
참고: 질량 정확도 측정 단위가 mDa인지 또는 ppm인지는
Options 대화 상자의 선택에 따라 달라집니다.

Intensity

Intensity above __ cps 강도 값이 지정된 값을 초과하는 단편만 표시합니다.

MS/MS 데이터 특성화

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
115/141



필터 설명

Score

Score above 점수가 지정된 값을 초과하는 단편만 표시합니다.

Structures

Fragments with
assigned structures

구조와 연결된 단편만 표시합니다.

자동 해석
자동 해석

소분자 워크플로 펩타이드 워크플로

소분자 워크플로
다음과 같은 방법으로 구조 자동 생성을 시작할 수 있습니다.

• Batch 작업 영역에서 Apply Options 확인란을 선택하여 Batch Processing Options 대화
상자에서 선택한 모든 Auto Assign 옵션을 배치의 샘플 및 대조 샘플에 적용합니다. 최소한
Assign Structures or Sequences 옵션을 선택해야 합니다. 자세한 정보는 배치 처리 옵션
섹션을 참조하십시오.

• Results 작업 영역의 Interpretation 보기에서 MS/MS 창의 Generate를 클릭합니다.

펩타이드 워크플로
다음과 같은 방법으로 시퀀스 자동 생성을 시작할 수 있습니다.

• Batch 작업 영역에서 Options 확인란을 선택하여 Batch Processing Options 대화 상자에
서 선택한 모든 Auto Assign 옵션을 배치의 샘플 및 대조 샘플에 적용합니다. 최소한
Assign Structures or Sequences 옵션을 선택해야 합니다. 자세한 정보는 배치 처리 옵션
섹션을 참조하십시오.

• Results 작업 영역의 Interpretation 보기에서 MS/MS 창의 Generate를 클릭합니다.

시퀀스 간 전환
히스토그램에서 파란색 막대를 클릭합니다.
해당 시퀀스가 Sequence 창에 표시되고 Fragments 테이블이 선택한 시퀀스 관련 정보로 업
데이트됩니다. Sequence 창 위의 레이블이 업데이트되어 시퀀스 번호와 할당된 순위를 나타
냅니다. 예를 들면 Sequence x of y, rank = z가 표시됩니다.

빈 창 선택
히스토그램에서 첫 번째 줄을 클릭합니다.
히스토그램의 첫 번째 줄에는 No sequence라는 단어가 포함되어 있습니다. Sequence 창이
지워지고 Fragments 테이블이 새로 고쳐져 No sequences assigned가 표시됩니다.

MS/MS 데이터 특성화

Molecule Profiler 소프트웨어
116/141

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A



시퀀스 추가

참고: 자동 생성된 시퀀스 목록에는 하나의 시퀀스만 추가할 수 있습니다. 시퀀스가 더 추가되
면 이전에 사용자가 추가한 시퀀스를 덮어씁니다.

1. Sequence 창에서 Enter Sequence를 클릭합니다.
Sequence 창이 지워지고 Fragments 테이블이 새로 고쳐져 No sequence assigned가
표시됩니다.

2. Load Parent를 클릭합니다.
Sequence 창과 Sequence charts 창의 Parent Sequence 탭에 모체 시퀀스가 표시됩니
다.

3. Tab 키를 눌러 모체 시퀀스의 유효성을 검사합니다.

시퀀스에 밑줄이 추가되어 유효함을 나타냅니다. Sequence Candidates 탭에 새 히스토
그램이 생성되어 첫 번째 자동 생성된 시퀀스 바로 위의 행에 사용자가 추가한 시퀀스를
보여줍니다. 사용자가 추가한 시퀀스의 순위는 0입니다. 파란색 막대가 테이블의 전체 폭
에 걸쳐 있습니다. 그러나 백분율은 막대에 표시되지 않습니다. 로드된 시퀀스 행의 파란
색 음영은 자동 생성된 시퀀스가 포함된 행의 파란색과 약간 다릅니다. 제안된 시퀀스 수
는 1개씩 증가합니다.

사용자가 추가한 시퀀스를 편집할 수 있습니다. 시퀀스에 대한 변경 사항은 사용자가
Sequence 창에서 나갈 때 메모리에 저장됩니다.

표시할 시퀀스 선택
히스토그램에서 파란색 막대를 클릭합니다.
해당하는 시퀀스가 Sequence 창에 표시됩니다. Fragments 테이블은 선택한 시퀀스와 관련된
정보로 업데이트됩니다. Sequence 창 위의 레이블이 업데이트되어 시퀀스 번호와 할당된 순
위를 나타냅니다. 예를 들면 Sequence x of y, rank = z가 표시됩니다.

시퀀스 삭제
1. 히스토그램에서 파란색 막대를 클릭합니다.

해당하는 시퀀스가 Sequence 창에 표시됩니다.

2. Sequence 창에서 Delete를 클릭합니다.
시퀀스가 Sequence 창에서 제거되고 행이 히스토그램에서 제거됩니다. 히스토그램의 다
음 행 시퀀스가 Sequence 창에 표시되고 Fragments 테이블이 선택한 시퀀스 관련 정보
로 업데이트됩니다.
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결과 상관 관계 지정 9
여러 관심 샘플에서 잠재적 대사물이 발견되면 각 샘플의 결과를 비교할 수 있습니다. 이를 통
해 사용자는 여러 결과 파일에서 생성된 잠재적 대사물 간의 차이와 유사성을 확인할 수 있습
니다. 서로 다른 결과 파일의 대사물은 Correlate Results 대화 상자에 설정된 질량 대 전하비
및 머무름 시간 허용 오차가 일치하면 동일한 것으로 간주됩니다.

올리고뉴클레오타이드 워크플로의 경우 소프트웨어는 Correlation 작업 영역의 단일 항목에서
중성 질량이 동일하고 머무름 시간 허용 오차 내에 있는 다중 전하 대사물을 그룹화할 수 있습
니다. 이 기능을 그룹화라고 합니다. 이 기능을 활성화하려면 결과 상관 관계를 지정할 때
Group results by analyte를 선택합니다. 이 기능이 활성화되면 다중 전하 종이 병합되어 결
과 파일 간의 비교를 쉽게 할 수 있습니다.

참고: 결과 파일의 상관 관계를 지정하기 전에 그룹 기능을 활성화하십시오.

상관 관계 준비
1. File > New > Correlation을 클릭합니다.

Correlate Results 대화 상자가 열립니다.

2. Add Results를 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

참고: 선택한 파일에 서로 다른 여러 화합물이 포함될 수 있습니다. 아날로그 데이터는 상
관 관계에 필요하지 않습니다.

4. X-axis title 및 X-axis units 필드를 완성합니다.
이렇게 하면 Correlation 작업 영역에서 그래프의 X축에 대한 레이블이 할당됩니다.

5. X축 레이블에 해당하는 필드에서 각 결과 파일 옆에 고유한 값을 입력합니다. 예를 들어 4
단계에서 할당한 레이블이 Time인 경우 Time 필드에 각 결과 파일의 시간을 입력합니다.

6. 적절한 경우 Include RRF in % area determination을 선택합니다.

참고: Include RRF in % area determination과 Group results by analyte를 동시에 선
택하지 마십시오.

이 옵션을 선택하면 MS 면적에 상대적 감응 인자를 곱합니다. 변경된 면적은 Correlations
Details 창의 선형 그래프, 막대 그래프 및 테이블 보기에 표시됩니다. Potential
Metabolites 테이블에는 변경 사항이 표시되지 않습니다.

7. (올리고뉴클레오타이드 워크플로) 필요한 경우 Group results by analyte를 선택하여 중
성 질량을 기준으로 피크를 그룹화합니다.

8. 상관 관계를 사용자 지정합니다. 자세한 정보는 상관 관계 사용자 지정 섹션을 참조하십
시오.

9. Correlation file name 필드에 파일 이름을 입력합니다.
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참고: 파일 이름에 공백을 포함하지 마십시오.

10. 상관 관계 파일을 저장할 특정 위치를 선택하려면 Browse를 클릭한 후 적절한 폴더를 선
택합니다.

11. OK를 클릭합니다.
소프트웨어는 선택한 파일에서 발견된 대사물을 비교하고 Correlation 작업 영역에 결과
를 표시합니다.

팁! 다른 설정을 사용하여 동일한 상관 관계를 처리할 수 있습니다. Correlation 작업 영역
에서 Correlate Results를 클릭합니다.

상관 관계 사용자 지정
상관 관계를 지정할 파일을 선택한 후 Correlation Results 대화 상자에서 매개 변수 값을 편집
하여 결과를 개선할 수 있습니다.

피크 정렬 개선
선택한 파일의 상관 관계를 향상시키기 위해 개별 결과 파일의 머무름 시간을 바꿀 수 있습니
다.

1. 결과 상관 관계를 지정하기 전에 다음을 수행합니다.

a. Results 작업 영역에서 각 해당 결과 파일을 엽니다.

b. 모든 파일에 표시된 특정 대사물의 머무름 시간을 검토합니다.

2. 결과 파일에 표시된 변화에 따라 Correlate Results 대화 상자에서 특정 파일 옆의 R.T.
Shift (min) 필드에 값을 입력합니다.

참고: R.T. Shift (min) 필드에는 –2.00분 ~ 2.00분의 값이 허용됩니다.

피크 병합 정의
특정 허용 오차를 사용하면 값이 유사한 피크를 동일한 피크로 간주할 수 있습니다.

1. Results 작업 영역에서 각 결과 파일을 엽니다.

2. 모든 파일에 표시된 특정 대사물의 머무름 시간 및 질량 허용 오차를 식별합니다.

3. Correlate Results 대화 상자의 Tolerances 그룹에서 Retention time 필드에 값을 입력합
니다.

참고: Retention time 필드에는 0.01분에서 0.25분 사이의 값이 허용됩니다.

4. MS m/z 필드에 값을 입력한 후 ppm 또는 mDa를 측정 단위로 선택합니다.

참고: 올리고뉴클레오타이드 워크플로에서 Group results by analyte 옵션을 선택한 경
우 ppm만 사용할 수 있습니다.

참고: MS m/z 필드에는 0.1에서 250.0 사이의 값이 허용됩니다.
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Correlation 작업 영역 정보
Correlation 작업 영역에는 선택한 결과 파일에서 검색된 잠재적 대사물의 비교가 표시됩니다.

그림 9-1 Correlation 작업 영역

항목 설명

1 메뉴 모음. 메뉴 모음에는 다음 버튼이 포함되어 있습니다.
• Correlate Results: Correlate Results 대화 상자를 엽니다. 자세한 정
보는 상관 관계 준비 섹션을 참조하십시오.

• Open: 사용자가 적절한 상관 관계 파일을 찾아볼 수 있는 Open
Correlation 대화 상자를 엽니다.

• Save: 현재 열려 있는 상관 관계 파일을 저장합니다. 기존 버전을 자동
으로 바꿉니다.

• Save As : 현재 열려 있는 상관 관계 파일을 저장합니다. 선택적으로
대상 폴더를 선택하고 상관 관계 파일에 새 이름을 할당합니다.
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항목 설명

2 Potential Metabolites 창. 설정된 허용 오차를 기반으로 상관된 모든 피크
를 나열합니다. 각 행에는 결과 파일에서 상관 관계가 있는 잠재적 대사물,
MS Area 및 Analog Area(해당하는 경우)가 나열됩니다. 빈 MS Area 셀
은 특정 결과 파일에서 대사물이 검색되지 않았음을 나타냅니다. 빈
Analog Area 셀은 결과 파일에서 대사물이 검색되지 않았거나 아날로그
반응이 0임을 나타냅니다.

이 창에는 다음 버튼이 포함되어 있습니다.

• Select values to filter peaks from the results. ( ): 사용자가 결과
에서 기준에 맞지 않는 정보를 필터링할 값을 설정할 수 있는
Correlation Filters 대화 상자를 엽니다. 자세한 정보는 상관 관계 필터
정보 섹션을 참조하십시오.

• Assign ID: 머무름 시간과 m/z 값을 기반으로 Potential Metabolites 테
이블의 각 피크에 고유 식별자를 할당합니다.

3 Correlation Details 창. 사용자가 상관 관계가 있는 대사물을 비교할 수 있
습니다. 자세한 정보는 상관된 대사물 비교 섹션을 참조하십시오. 여러 대
사물과 결과 파일을 선택할 수 있습니다. MS 및 아날로그 데이터를 다음
과 같은 형식으로 표시할 수 있습니다.

• Linear Graph 또는 Bar Graph: 검색된 각 결과 파일에서 각 대사물의
강도를 비교합니다.

• Table: 각 대사물이 검색된 결과 파일을 식별합니다. 사용자는 테이블
에 발생, 피크 ID 또는 피크 면적을 표시하도록 선택할 수도 있습니다.

참고: 상관 관계를 준비할 때 상대적 감응 인자를 적용한 경우 선형 그래
프와 막대 그래프에 정량적 MS 데이터가 표시됩니다.

4 Chromatograms 창: 선택한 대사물에 대한 XIC(추출 이온 크로마토그램)
또는 아날로그 크로마토그램을 표시합니다. 크로마토그램에는 대사물을
포함하는 하나 또는 모든 결과 파일의 데이터가 포함될 수 있습니다.

5 MS 창: 선택한 대사물을 포함하는 하나 또는 모든 결과 파일에서 관심 샘
플의 MS 스펙트럼을 표시합니다.

6 MS/MS 창: 대사물을 포함하는 하나 또는 모든 결과 파일에서 선택한 대사
물의 MS/MS 스펙트럼을 표시합니다.

참고: 상관 관계 결과가 그룹화되면 크로마토그래픽, MS 및 MS/MS 스펙트럼이 표시되지 않
습니다.

상관된 대사물의 이름 편집
1. Workspace 패널에서 Correlation을 클릭합니다.

Correlation 작업 영역이 열립니다.
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2. Open을 클릭합니다.
Open Correlation 대화 상자가 열립니다.

3. 적절한 상관 관계 파일을 찾아 선택합니다.

4. Potential Metabolites 테이블에서 행을 선택합니다.

5. Edit > Edit Name을 클릭합니다.
Edit Name 대화 상자가 열립니다.

6. 새 대사물 이름을 입력합니다.

7. OK를 클릭합니다.
대사물 이름이 새 값으로 변경됩니다.

상관된 대사물 비교
사용자는 여러 결과 파일에 포함된 대사물의 상관 관계를 지정한 후 선택한 특정 대사물을 더
자세히 비교할 수 있습니다.

1. Workspace 패널에서 Correlation을 클릭합니다.
Correlation 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Correlation 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. Potential Metabolites 테이블에서 비교할 잠재적 대사물 옆의 Plot 확인란을 선택합니다.
대사물이 Correlation Details 창에 표시됩니다.

5. 특정 대사물의 상대적 감응 인자를 변경하려면 RRF 필드에 값을 입력합니다.

선형 그래프와 막대 그래프에서 MS 면적 및 아날로그 면적(해당하는 경우)에 RRF 값을
곱합니다.

참고: 이 필드는 상관 관계를 준비할 때 상대적 감응 인자를 사용한 경우에만 표시됩니다.

6. Correlation Details 창에 아날로그 데이터를 표시하려면 Analog data를 클릭합니다.

7. 선택한 대사물이 포함된 파일을 식별하려면 Correlation Details 창에서 Table을 선택합니
다.

8. 정규화된 데이터를 표시하려면 을 클릭합니다.

팁! 정규화된 데이터는 선형 그래프, 막대 그래프, XIC, 아날로그 크로마토그램, MS 스펙
트럼 및 MS/MS 스펙트럼에 표시할 수 있습니다.

9. 상관된 파일에서 머무름 시간과 m/z 값을 기반으로 잠재적 대사물의 피크 ID를 다시 할당
하려면 Assign ID를 클릭합니다.
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상관 관계 필터 정보
필터를 적용하여 Correlation 테이블에 표시되는 데이터를 더 세분화할 수 있습니다.  아이
콘을 클릭하여 Correlation Filters 대화 상자에 액세스하거나, Setup > Filters > Correlation을
클릭합니다.

필터 설명

Mass Range

m/z from __ to __ 지정된 범위 내의 m/z 값을 가진 피크만 표시합니다.

Retention Time

R.T. from __ to __ 지정된 범위 내의 머무름 시간을 가진 피크만 표시합니다.

Occurrence

Peaks in __ or more
results files

지정된 수의 결과 파일에 나타나는 피크만 표시합니다.
참고: 최대값은 상관 관계를 위해 선택한 파일 수에 따라 달라집
니다. 예를 들어 상관 관계를 지정할 결과 파일을 5개 지정한 경
우 최대 5개의 피크 발생을 선택할 수 있습니다.
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보고서 10
소프트웨어로 보고서를 생성하려면 컴퓨터에 Microsoft Word 2010 이상이 설치되어 있어야
합니다.

사용자는 Adobe PDF, Microsoft Word 및 HTML로 보고서를 생성할 수 있습니다. 보고서를 프
린터로 직접 보낼 수도 있습니다.

다음 보고서 템플릿은 소프트웨어와 함께 C:\ProgramData\SCIEX\Molecule Profiler\Report
Templates 폴더에 설치됩니다.

• Correlation 폴더

• Correlation Detailed Report

• Correlation Summary Report

• Correlation Group Report

• ResultsAndInterpret 폴더

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_ADC 폴더

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_Peptides 폴더

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_Oligo 폴더

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

보고서
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각 보고서에는 많은 정보가 포함될 수 있지만 보고서 생성 당시 보고되는 결과 파일의 내용만
표시됩니다. 결과 파일에 동위 원소 농축과 같은 특정 정보가 없으면 생성된 보고서에 해당 내
용이 포함되지 않으며 대부분의 경우 해당 내용에 대한 필드 레이블 또는 머리글이 포함되지
않습니다. Potential Metabolites 테이블 또는 Fragments 테이블에 적용된 필터는 보고서에 반
영됩니다. 예를 들어 Potential Metabolites 테이블이 23개 피크 중 상위 5개만 표시하도록 필
터링된 경우 해당하는 5개의 피크만 보고서에 포함됩니다.

보고서에 포함된 모든 그래프 또는 스펙트럼은 사용자 인터페이스에서 선택한 확대/축소 수준
에 관계없이 기본 확대/축소 수준으로 표시됩니다. 모든 상관 관계 그래프는 정규화되지 않은
데이터로 보고됩니다.

참고: 그룹화된 데이터에 사용할 사용자 지정 상관 관계 보고서 템플릿을 생성할 때 파일 이름
에 "grouped"를 포함해야 합니다.

Results 작업 영역에서 보고서 생성
소분자, 펩타이드 및 ADC 결과에 대한 보고서를 각각 생성할 수 있습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다.

5. Report 열에서 보고서에 포함할 각 대사물에 해당하는 확인란을 선택합니다.
선택되지 않은 대사물은 생성된 보고서에 포함되지 않습니다.

6. Workflow 패널에서 Create Report를 클릭합니다.
Create Report 대화 상자가 열립니다.

7. Available templates 필드에서 보고서 템플릿을 선택합니다.

템플릿 목록은 보고서 섹션을 참조하십시오.

8. 적절한 Formats 확인란을 선택하여 필요한 버전의 보고서 파일을 생성하거나 보고서를
인쇄합니다.

참고: 여러 형식을 선택할 수 있습니다.

9. 선택한 각 형식 버전에 대해 Browse를 클릭한 후 Browse For Folder 대화 상자에서 보고
서 파일의 특정 저장 위치를 찾아 선택합니다.

10. OK를 클릭합니다.
Browse For Folder 대화 상자가 닫힙니다.

11. 선택한 각 형식 버전에 대해 제공된 필드에 보고서 이름을 입력합니다.

12. (올리고뉴클레오타이드 워크플로) 필요에 따라 Report grouping table for Results 확인
란을 선택하거나 선택을 취소합니다.

13. Generate Report를 클릭합니다.
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14. Print report 옵션을 선택한 경우 Print 대화 상자에서 필요한 인쇄 옵션을 선택하고 OK를
클릭합니다.
소프트웨어에서 보고서가 생성됩니다.

Correlation 작업 영역에서 보고서 생성
소분자, 펩타이드 및 ADC 결과에 대한 상관 관계 보고서를 각각 생성할 수 있습니다.

1. Workspace 패널에서 Correlation을 클릭합니다.
Correlation 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Correlation 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

4. Open을 클릭합니다.
Correlation Results 보기가 표시됩니다.

5. 관심 대사물에 대한 상관 관계 세부 정보를 보고서에 포함하려면 Plot 확인란을 선택합니
다.

6. Workflow 패널에서 Create Report를 클릭합니다.
Create Report 대화 상자가 열립니다.

7. Available templates 필드에서 보고서 템플릿을 선택합니다.

템플릿 목록은 보고서 섹션을 참조하십시오.

참고: 상관 관계 파일에 그룹화된 데이터가 없으면 그룹화되지 않은 보고서 템플릿만 사
용할 수 있습니다. 상관 관계 파일에 그룹화된 데이터가 있으면 파일 이름에 "grouped"가
포함된 보고서 템플릿만 표시됩니다.

8. 적절한 Formats 확인란을 선택하여 필요한 버전의 보고서 파일을 생성하거나 보고서를
인쇄합니다.

참고: 여러 형식을 선택할 수 있습니다.

9. 선택한 각 형식 버전에 대해 Browse를 클릭한 후 Browse For Folder 대화 상자에서 보고
서 파일의 특정 저장 위치를 찾아 선택합니다.

10. OK를 클릭합니다.
Browse For Folder 대화 상자가 닫힙니다.

11. 선택한 각 형식 버전에 대해 제공된 필드에 보고서 이름을 입력합니다.

12. Generate Report를 클릭합니다.

13. Print report 옵션을 선택한 경우 Print 대화 상자에서 필요한 인쇄 옵션을 선택하고 OK를
클릭합니다.
소프트웨어에서 보고서가 생성됩니다.
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그래프 복사 및 붙여넣기
Results 작업 영역과 Compound Library 및 Processing Parameters 대화 상자에서 그래프를
복사할 수 있습니다.

1. 복사할 그래프를 마우스 오른쪽 버튼으로 클릭한 후 Copy Selected Graph를 클릭합니
다.
그래프가 클립보드에 복사됩니다.

2. 그래프를 Microsoft Word와 같은 다른 어플리케이션에 붙여 넣습니다.

잠재적 대사물 테이블 복사 및 붙여넣기
1. 테이블을 마우스 오른쪽 버튼으로 클릭한 후 Results 작업 영역에서 Copy Table을 클릭

합니다.
테이블이 클립보드에 복사됩니다.

2. 테이블을 Excel에 붙여 넣습니다.
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아날로그 통합 11
아날로그 데이터는 질량 분석계를 사용하여 발견된 대사물이 가양성이 아닌 실제 대사물임을
확인하는 데 사용됩니다. 질량 분석계와 함께 아날로그 인라인을 사용하는 사용자는 이 기능
을 통해 아날로그 면적 통합을 최적화하고 MS 피크와 아날로그 피크의 연관성을 더 잘 시각화
할 수 있습니다.

아날로그 데이터가 포함된 결과 파일을 열면 Potential Metabolites 테이블의 Analog
Integration 버튼이 활성화됩니다.

Analog Integration을 클릭하면 Analog Integration 대화 상자가 열립니다.

다음 예외 사항을 제외하고 Results 작업 영역의 원래 Potential Metabolites 테이블이 표시됩
니다.

• 연관된 질량 피크가 없는 아날로그 피크가 표시되지만 MS 관련 열이 비어 있습니다.

• 아날로그 대조군 데이터가 있으면 Analog - R.T. (min) 열 바로 뒤에 추가 열 Analog
Signal in Control이 표시됩니다. 아날로그 대조군 데이터가 없으면 이 열이 표시되지 않습
니다.

Analog Signal in Control 열은 다음 정보를 제공합니다.

• 아날로그 피크의 샘플/대조군 비율이 처리 매개 변수에 지정된 값보다 크면 x가 열에 표시
됩니다.

• 아날로그 피크의 샘플/대조군 비율이 처리 매개 변수에 지정된 값보다 작으면 확인 표시가
열에 표시됩니다.

아날로그 데이터 수동 통합
선행 조건:

• 아날로그 데이터로 결과가 처리되었습니다.

1. Workspace 패널에서 Results를 클릭합니다.
Results 작업 영역이 열립니다.

2. Open을 클릭합니다.
Open Results 대화 상자가 열립니다.

3. 적절한 파일을 찾아 선택합니다.

참고: 결과 파일에는 아날로그 크로마토그램이 포함되어야 합니다.

4. OK를 클릭합니다.
Results 보기가 표시됩니다. 결과 파일에 아날로그 데이터가 포함되어 있으면 Potential
Metabolites 테이블의 Analog Integration 버튼이 활성화됩니다. 결과 파일에 아날로그
데이터가 포함되어 있지 않으면 이 버튼을 사용할 수 없습니다.
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5. Analog Integration을 클릭합니다.

Analog Integration 대화 상자가 열립니다.

Potential Metabolites 테이블 외에 두 개의 크로마토그램이 표시됩니다. 첫 번째 크로마토
그램인 Analog Sample 크로마토그램은 일반 처리 매개 변수의 Chromatographic Data 탭
에 지정된 머무름 시간 범위 내의 모든 아날로그 피크를 표시합니다. 자세한 정보는
Chromatographic Data 탭 섹션을 참조하십시오. 두 번째 크로마토그램인 MS Sample의
XIC(추출 이온 크로마토그램)는 선택한 행의 모든 피크를 표시합니다. XIC는 Potential
Metabolites 테이블에서 다른 행이 선택될 때마다 업데이트됩니다.

6. Analog Sample 크로마토그램을 선택하고 필요한 경우 다음 작업을 완료하여 데이터를 통
합합니다.

• 수동으로 피크 통합

• 기존 피크 통합 수정

• 피크 제거

변경되면 소프트웨어가 자동으로 Analog Sample 크로마토그램을 업데이트합니다.

7. (선택 사항) Show Controls 확인란을 선택합니다.
최대 5개의 대조 샘플이 Analog Sample 크로마토그램 제목 아래에 표시됩니다. 자세한
정보는 대조군 표시 섹션을 참조하십시오.

8. (선택 사항) Baseline Subtract를 클릭합니다.
기준선 감산은 아날로그 샘플과 대조 샘플에 모두 적용됩니다. "baseline
subtracted"라는 문구가 대조 샘플 및 Analog Sample 크로마토그램의 제목에 추가됩
니다. 자세한 정보는 기준선 감산 수행 섹션을 참조하십시오.

9. (선택 사항) R.T. Offset을 변경합니다. 자세한 정보는 머무름 시간 오프셋 변경 섹션을 참
조하십시오.
머무름 시간 오프셋은 아날로그 샘플과 대조군 트레이스에 모두 적용됩니다.

10. (선택 사항) 아날로그 통합 Options를 적용합니다. 자세한 정보는 아날로그 통합 옵션 설
정 섹션을 참조하십시오.

11. 다음 중 하나를 수행합니다.

• Update Table을 클릭합니다. 자세한 정보는 테이블 업데이트 섹션을 참조하십시오.

• Update Results and Close를 클릭합니다. 자세한 정보는 결과 업데이트 후 닫기 섹션
을 참조하십시오.

12. 다음 중 하나를 수행합니다.

• Save를 클릭하여 현재 열려 있는 결과 파일을 저장하고 기존 버전을 덮어씁니다.

• Save As를 클릭하여 현재 열려 있는 결과 파일을 새 이름으로 저장합니다. 기존 결과
파일은 업데이트되지 않습니다.

대조군 표시
1. Analog Integration 대화 상자의 Chromatograms 창에서 Show controls 확인란을 선택합

니다.
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해당하는 경우 최대 5개의 대조군이 Chromatograms 창의 Analog Sample 제목 아래에 표
시됩니다. 해당하는 경우 최대 5개의 대조군이 XIC 창의 MS Sample 제목 아래에 표시됩
니다.

2.  아이콘을 클릭하여 목록을 확장하고 아날로그 샘플과 아날로그 대조군 또는 MS 샘플
과 MS 대조군을 모두 표시합니다.

3.  아이콘을 클릭하여 목록을 축소하고 아날로그 샘플 또는 MS 샘플만 표시합니다.

4. Show controls 확인란을 다시 선택하여 보기에서 대조군을 제거합니다.

기준선 감산 수행
1. Analog Integration 대화 상자의 Chromatograms 창에서 Baseline Subtract를 클릭합니

다.
Analog Sample 크로마토그램에서 기준선이 감산됩니다. 기준선 감산은 아날로그 샘플과
대조군 트레이스에 모두 적용됩니다. "baseline subtracted"라는 문구가 Analog
Sample 크로마토그램 이름에 추가됩니다.

2. Baseline Subtract를 다시 클릭하여 기준선 감산을 제거합니다.
"baseline subtracted"라는 문구가 Analog Sample 크로마토그램 이름에서 제거됩니
다.

머무름 시간 오프셋 변경
Analog Integration 대화 상자의 Chromatograms 창에서 R.T. Offset 필드의 위쪽/아래쪽 화살
표를 사용하여 머무름 시간 오프셋을 변경할 수 있습니다.
Analog Sample 크로마토그램의 피크는 지정된 머무름 시간 오프셋만큼 이동합니다. Potential
Metabolites 테이블 또는 결과가 업데이트되면 Analog R.T. (min) 열의 값이 업데이트되어 지
정된 머무름 시간 오프셋의 변화를 반영합니다. 오프셋은 아날로그 샘플과 대조 샘플에 모두
적용됩니다.

아날로그 통합 옵션 설정
1. Analog Integration 대화 상자의 Chromatograms 창에서 Options를 클릭합니다.

Analog Integration Options 대화 상자가 열립니다.

2. 적용할 각 옵션의 확인란을 선택합니다.

옵션 설명

Overlay XIC for
peaks at the
same analog
retention time

아날로그 머무름 시간이 동일한 트레이스에 대해 MS 샘플 XIC를 중첩합
니다.

Link x-axis Analog Sample 크로마토그램과 XIC 크로마토그램의 X축을 연결합니다.

3. OK를 클릭합니다.

아날로그 통합
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테이블 업데이트
Analog Integration 대화 상자에서 변경이 수행되면 Update Table 옵션이 활성화됩니다.

Update Table을 클릭합니다.

Potential Metabolites 테이블에서 다음 열의 정보가 업데이트되어 아날로그 피크 통합, 아날로
그 머무름 시간 및 기준선 감산에 대한 변경 사항을 반영합니다.

• Analog Sample 크로마토그램의 할당된 Peak ID가 수동 통합을 반영하도록 업데이트될 수
있습니다. 아날로그 피크의 머무름 시간이 지정된 허용 오차 내에서 MS 피크의 머무름 시
간과 일치하는 경우 아날로그 피크가 MS 피크와 일치하는 것으로 간주됩니다.

• Analog - Peak Area가 새 통합 면적을 반영하도록 업데이트됩니다.

• Analog - % Area가 알고리즘의 변경 사항을 반영하도록 업데이트됩니다. Analog - %
Area는 처리 매개 변수에 지정된 시간 범위 내에서 모든 아날로그 피크(MS 피크와 연관된
피크 및 MS 피크와 연관되지 않은 피크 둘 다)를 기반으로 계산됩니다. 아날로그 피크가 둘
이상의 MS 피크와 연관된 경우 특정 M#에 대해 나열된 아날로그 피크 면적은 연관된 모든
MS 피크의 피크 면적을 총계로 사용하여 해당 M#의 XIC MS 면적에 따라 비례적으로 계산
됩니다.

• Analog - R.T. (min)가 머무름 시간 오프셋의 변경 사항을 반영하도록 업데이트됩니다.

참고: 이러한 변경 사항은 결과 파일에 저장되지 않으며 Cancel을 클릭하여 되돌릴 수 있습니
다.

결과 업데이트 후 닫기
Analog Integration 대화 상자에서 변경이 수행되면 Update Results and Close 옵션이 활성
화됩니다.

1. Update Results and Close를 클릭합니다.
변경 내용에 따라 아날로그 정보를 업데이트할지 확인을 요청하는 메시지가 표시됩니다.

2. Yes를 클릭합니다.
Analog Integration 대화 상자가 닫힙니다. Potential Metabolites 테이블에서 다음 열의 정
보가 업데이트되어 아날로그 피크 통합, 아날로그 머무름 시간 및 기준선 감산에 대한 변
경 사항을 반영합니다.

• Analog Sample 크로마토그램의 할당된 Peak ID가 수동 통합을 반영하도록 업데이트
될 수 있습니다. 아날로그 피크의 머무름 시간이 지정된 허용 오차 내에서 MS 피크의
머무름 시간과 일치하는 경우 아날로그 피크가 MS 피크와 일치하는 것으로 간주됩니
다.

• Analog - Peak Area가 새 통합 면적을 반영하도록 업데이트됩니다.

• Analog - % Area가 알고리즘의 변경 사항을 반영하도록 업데이트됩니다. Analog - %
Area는 처리 매개 변수에 지정된 시간 범위 내에서 모든 아날로그 피크(MS 피크와 연
관된 피크 및 MS 피크와 연관되지 않은 피크 둘 다)를 기반으로 계산됩니다. 아날로그
피크가 둘 이상의 MS 피크와 연관된 경우 특정 M#에 대해 나열된 아날로그 피크 면적
은 해당 M#의 XIC MS 면적에 따라 비례적으로 계산됩니다(연관된 모든 MS 피크의 피
크 면적을 총계로 사용).

아날로그 통합

소프트웨어 사용자 안내서
RUO-IDV-05-12707-KR-A

Molecule Profiler 소프트웨어
131/141



• Analog - R.T. (min)가 머무름 시간 오프셋의 변경 사항을 반영하도록 업데이트됩니다.
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문제 해결 12
특정 문제에 대한 도움말을 보려면 해당 링크를 선택하십시오.

• 구조 파일을 열 수 없음

• 사용자 권한 변경

• 잠재적 대사물을 찾을 수 없음

• 잠재적 대사물이 너무 많음

• 긴 처리 시간

• ProgramData 폴더 표시

• 알려진 문제 및 제한 사항

구조 파일을 열 수 없음
구조 파일이 다음 규칙을 따르는지 확인하십시오.

• 형식: mol

• 버전: v2000 또는 v3000

• 내용: 텍스트를 포함하지 않음

사용자 권한 변경
Molecule Profiler 소프트웨어가 설치되면 모든 사용자에게 설치된 사용자 데이터 폴더의 파일
에 대한 읽기, 쓰기 및 삭제 권한이 부여됩니다. 권한이 변경되면 소프트웨어가 제대로 작동하
지 않을 수 있습니다.

참고: 설치된 사용자 폴더의 기본 위치는
C:\ProgramData\SCIEX\Molecule Profiler Data입니다.

잠재적 대사물을 찾을 수 없음
관심 샘플에서 대사물을 더 찾으려면 다음을 수행합니다.

• 다른 피크 찾기 전략을 선택합니다. 자세한 정보는 피크 찾기 전략 정보 섹션을 참조하십시
오.

• Chromatographic Data 탭에서 최소 크로마토그래픽 강도를 줄입니다. 자세한 정보는
Chromatographic Data 탭 섹션을 참조하십시오.

• MS Parameters 탭의 m/z Tolerance 그룹에서 MS m/z tolerance를 높입니다. 자세한 정보
는 MS Parameters 탭 섹션을 참조하십시오.

• MS Parameters 탭의 m/z Tolerance 그룹에서 Minimum MS peak intensity를 줄입니다.
자세한 정보는 MS Parameters 탭 섹션을 참조하십시오.

문제 해결
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• (올리고뉴클레오타이드 워크플로) MS Parameters 탭의 Isotope Pattern Tolerances 그룹에
서 Intensity tolerance를 높입니다.

잠재적 대사물이 너무 많음
발견되는 잠재적 대사물의 수를 줄이려면 다음을 수행합니다.

• 다른 피크 찾기 전략을 선택합니다. 자세한 정보는 피크 찾기 전략 정보 섹션을 참조하십시
오.

• Chromatographic Data 탭에서 최소 크로마토그래픽 강도를 높입니다. 자세한 정보는
Chromatographic Data 탭 섹션을 참조하십시오.

• Chromatographic Data 탭에서 머무름 시간 범위를 줄입니다. 자세한 정보는
Chromatographic Data 탭 섹션을 참조하십시오.

• MS Parameters 탭에서 질량 범위를 줄입니다. 자세한 정보는 MS Parameters 탭 섹션을 참
조하십시오.

• MS Parameters 탭의 Isotope Pattern Tolerances 그룹에서 Minimum MS peak intensity
를 높입니다. 자세한 정보는 MS Parameters 탭 섹션을 참조하십시오.

긴 처리 시간
처리 시간은 데이터 복잡성, 처리 매개 변수, 워크스테이션 및 운영 체제를 포함한 많은 요인의
영향을 받습니다.

처리에 필요한 시간을 줄이려면 다음을 수행합니다.

1. 워크스테이션에서 실행 중인 다른 어플리케이션을 닫습니다.

2. 처리 매개 변수 값을 변경합니다. 예를 들면 다음과 같습니다.

• 선택한 알고리즘의 수를 줄입니다.

• Chromatographic Data 탭에서 최소 크로마토그래픽 강도를 높입니다.

• Chromatographic Data 탭에서 머무름 시간 범위를 줄입니다.

• MS Parameters 탭에서 최소 MS 피크 강도를 높입니다.

• MS Parameters 탭에서 질량 범위를 줄입니다.

• 선택한 질량 결손 필터의 수를 줄입니다(소분자에만 해당).

• 생체 내 변화 수를 줄입니다.

• (펩타이드, 올리고뉴클레오타이드 및 ADC 워크플로) 화합물별 매개 변수를 조정하여
생성되는 분해대사물의 수를 줄입니다.

ProgramData 폴더 표시
Microsoft Windows 운영 체제는 C:\ProgramData 폴더를 숨길 수 있습니다. Molecule
Profiler 소프트웨어를 설치한 후 모든 사용자가
C:\ProgramData\SCIEX\Molecule Profiler Data 폴더를 볼 수 있는지 확인하십시
오. 폴더가 표시되지 않으면 다음 절차를 수행합니다.
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1. 파일 탐색기에서 View > Options를 클릭합니다.
Folder Options 대화 상자가 열립니다.

2. View 탭을 선택합니다.

3. Hidden files and folder > Show hidden files, folders, or drives를 클릭합니다.

4. Apply를 클릭합니다.

5. OK를 클릭합니다.

알려진 문제 및 제한 사항
결과 데이터

• 이제 MS 피크 면적을 결정할 때 시간 변환 계수 60이 계산에 적용됩니다.

해석

• 구조 할당을 준비할 때 Interpret Data 대화 상자를 변경한 후 항상 Find를 클릭하십시오. 소
프트웨어는 선택한 설정을 기반으로 사용 가능한 수식 목록을 다시 계산합니다.

상관 관계

• 특정 대사물의 RRF(상대적 감응 인자)가 변경되면 MS 면적에 RRF 값을 곱합니다. 선택한
대사물의 업데이트된 MS 면적이 Correlation Details 창의 각 선형 그래프, 막대 그래프 및
테이블에 표시됩니다.

보고

• 보고서를 생성할 때 Microsoft Word 보고서 템플릿과 충돌이 발생하면 모든 Microsoft
Office 어플리케이션을 닫고 다시 시도하십시오.

문제 해결
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사용자 지정 올리고뉴클레오타이드의
예 A
5′-티오-인산염 말단에 연결된 벤질 펜테인 링커와 결합된 티오-포스포라미데이트 올리고뉴클
레오타이드입니다.

시퀀스 화학 구조, 수식 및 단일 동위 원소 질량

5′-
ATCGATCGTTTAAA-
3′

그림 A-1 C149H203N65O57P 14S14 ( 4695.7400)

기타 말단 생성
5' 링커 성분을 구성하는 하위 구조를 식별하기 위한 일반적인 체계를 따르십시오.

사용자 지정 올리고뉴클레오타이드의 예
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그림 A-2 기타 말단

1. Edit > Custom Elements를 클릭합니다.

2. Oligo List 탭에서 New를 클릭합니다.
New Oligo Residue or Terminus 대화 상자가 열립니다.

3. Name 필드에 이름을 입력합니다(예: 5' benzyl-pentane terminus).

4. Symbol 필드에 기호를 입력합니다(예: /CustomBP/).

5. Composition Type 필드에서 Other Terminus를 선택합니다.

6. 기타 말단의 필드를 완성합니다.

표 A-1 Other Terminus 필드

필드 값

Terminus Moiety C11H15
Terminus Linker O
Phosphate Core HOPS

7. OK를 클릭합니다.
Warning 대화 상자가 열리고 The "Terminus Moiety" field is usually odd
electron. Do you want to continue?라는 메시지가 표시됩니다.

8. OK를 클릭합니다.

사용자 지정 올리고뉴클레오타이드의 예
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내부 잔기를 기타 잔기로 생성
사용자 지정 염기를 구성하는 하위 구조를 식별하기 위한 일반적인 체계를 따르십시오.

그림 A-3 기타 잔기

1. Edit > Custom Elements를 클릭합니다.

2. Oligo List 탭에서 New를 클릭합니다.

팁! 사용자 지정 잔기를 생성할 때 네 개의 뉴클레오타이드를 모두 정의합니다. 단일 뉴클
레오타이드를 생성한 후 New From을 클릭하여 나머지 세 개의 뉴클레오타이드를 생성
하는 것이 좋습니다.

New Oligo Residue or Terminus 대화 상자가 열립니다.

3. 아데닌 뉴클레오타이드의 경우 다음 단계를 수행합니다.

a. Name 필드에 Custom dA를 입력합니다.

b. Symbol 필드에 /CustomdA/를 입력합니다.

c. Composition Type 필드에서 Other Residue를 선택합니다.

d. 기타 잔기의 필드를 완성합니다.

사용자 지정 올리고뉴클레오타이드의 예
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표 A-2 Other Residue 필드

필드 값

Base C5H4N5
5' Linker O
Sugar Core C5H70
3' Linker NH
Phosphate Core HPOS

e. OK를 클릭합니다.
Warning 대화 상자가 열리고 The "Sugar Core" field is usually odd
electron. Do you want to continue?라는 메시지가 표시됩니다.

f. OK를 클릭합니다.

4. 나머지 세 개의 뉴클레오타이드에 대해 각각 다음을 수행합니다.

a. /CustomdA/를 선택한 후 New From을 클릭합니다.
New Oligo Residue or Terminus 대화 상자가 열립니다.

b. Name, Symbol 및 Base를 입력합니다. 염기 수식은 다음 표를 참조하십시오.

표 A-3 염기 수식

뉴클레오타이드 이름 기호 염기

티민 Custom dT /CustomdT/ C5H5N2O2

구아닌 Custom dG /CustomdG/ C5H4N5O

사이토신 Custom dC /CustomdC/ C4H4N3O

c. OK를 클릭합니다.

사용자 지정 시퀀스 작성
1. New > Oligonucleotide를 클릭합니다.

2. Sequence 창에서 다음을 입력합니다.
/CustomBP/ /CustomdA//CustomdT//CustomdC/ /CustomdG//CustomdA//CustomdT/ /
CustomdC//CustomdG//CustomdT/ /CustomdT//CustomdT//CustomdA/ /CustomdA//
CustomdA/

3. Chemical formula 필드를 클릭합니다.
C149H203N65O57P14S14가 필드에 표시됩니다.

사용자 지정 올리고뉴클레오타이드의 예
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용어 정리 B
소프트웨어에서 대사물 이름이 지정되는 방법
두 가지 방법으로 잠재적 대사물에 이름이 할당됩니다. 피크가 예측 대사물인 경우 이름은 일
치하는 생체 내 변화, 분열 대사물 또는 이 둘의 조합을 기반으로 합니다. 피크가 예기치 않은
대사물인 경우 이름은 Loss of 또는 Gain of로 지정됩니다.

소프트웨어는 각 대사물에 잠재적 수식도 할당합니다. 사용자는 소프트웨어에 의해 제안된 수
식 목록에서 다른 수식을 선택하거나 수식을 수동으로 입력하여 수식을 변경할 수 있습니다.

IDA
IDA 방법은 획득 중 전체 스캔 스펙트럼에서 이온을 찾은 후 MS/MS로 분석할 이온을 실시간
으로 결정합니다.

피크 ID
소프트웨어는 머무름 시간과 m/z 값을 기반으로 M1, M2, M3 등을 사용하여 잠재적 대사물에
레이블을 지정합니다.

상대적 감응 인자
RRF(상대적 감응 인자)는 피크 면적을 인위적으로 늘리거나 줄이기 위해 피크 면적을 곱한 값
입니다. Correlation Details 그래프에서 해당 피크 면적의 플롯을 변경할 수 있습니다.

기준 스펙트럼
잠재적 대사물을 식별할 때 사용되는 특정 화합물의 MS/MS 스펙트럼입니다.

용어 정리
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문의하기

고객 교육
• 북아메리카: NA.CustomerTraining@sciex.com

• 유럽: Europe.CustomerTraining@sciex.com

• 유럽 및 북미 이외 지역의 연락처 정보는 sciex.com/education

온라인 학습 센터
• SCIEX Now Learning Hub

SCIEX 지원
SCIEX 및 전 세계 대리점은 충분히 교육을 받은 서비스 및 기술 전문가를 보유하고 있습니다.
이들은 시스템에 대한 질문 또는 발생할 수 있는 모든 기술적 문제에 대한 도움을 제공합니다.
자세한 내용은 SCIEX 웹 사이트(sciex.com)를 참조하거나, 다음 방법 중 하나를 사용하여 당
사로 문의하십시오.

• sciex.com/contact-us

• sciex.com/request-support

사이버 보안
SCIEX 제품의 사이버 보안에 대한 최신 지침은 sciex.com/productsecurity에서 확인할 수 있
습니다.

문서
이 문서가 이전 버전의 모든 문서를 대체합니다.

이 문서를 컴퓨터로 보려면 Adobe Acrobat Reader가 필요합니다. 최신 버전을 다운로드하려
면 https://get.adobe.com/reader로 이동하십시오.

SCIEX 웹 사이트(sciex.com/customer-documents)에서 최신 버전의 문서를 확인할 수 있습니
다.

참고: 이 문서의 무료 인쇄 버전을 요청하려면 sciex.com/contact-us에 문의하십시오.

문의하기
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